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1 Getting Started  
 

1.1  VenioOne OnDemand Overview  

VenioOne OnDemand (VOD) is a browser-based, self-service add-on to the unified VenioOne 

eDiscovery platform. VOD may be used in all phases of the eDiscovery process - upload, process, early case 

assessment, analysis, review, and production.  

This User Guide helps you understand VOD and provides you with the easiest and best ways to work 

with VOD. If you still have questions, don’t worry! We are always here to assist you. Contact our technical 

support team.  

1.2  VOD Features  

The features that display in VOD depend on the level of rights you have been granted. You will only 

see those options which you have rights to use and may need to request additional rights as needed.  

• CASE LAUNCHPAD – Overview of your Cases and/or Review Set Batches • UPLOAD 

DASHBOARD – Area for uploading data in the following formats:  

• Structured – Output from other eDiscovery platforms  

• Unstructured – Unprocessed raw data in over 500 formats  

• Transcripts – Hearing or deposition transcripts  
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• Social Media – Facebook, Twitter, Bloomberg, Cellebrite mobile data, Slack, or MS Teams  

• ANALYSIS DASHBOARD - Customizable, interactive widgets that show graphical views of the 

case data and emails; includes:  

• Custodian/Media Selection dialog for filtering data shown  

• Simple Search and Advanced Query Builder options  

• Timeline that can be used to filter data and get an overview of items  

• Social Network Diagram widget that shows clusters of communications used to visualize 

email communication patterns and then hone in on important items  

• Customizable Layouts for specific tasks and workflows  

• Bulk Tagging and Filtering  

• Send to Review and Send to Productions options  

• REVIEW DASHBOARD – Conduct ad hoc, linear, tiered, or technology assisted (CAL) reviews of 

documents in batches. The administrator establishes review permissions for different sets of 

documents to be reviewed by specific users. The dashboard features panels that can be 

grouped and arranged into multiple customizable layouts including:  

• Document Table – List of documents and file information; includes basic and advanced Search 

functions, as well as numerous Other Options to take actions on selected files such as 

printing, sharing, sorting, foldering imaging, OCRing, etc. 

• Tagging Panel – Area where Tags are applied to/removed from files  

• Document Viewer – Depending on the file type selected and case settings, it displays Native, 

Fulltext, HTML, Meta Detail, Tiff, and PDF Viewer tabs, including Redaction Tools; may also 

include the Transcript panel  

• Notes Panel – Useful for back and forth communication with others working on the Case  

• Coding Panel – For adding case-specific coding to files  

• Metadata, Parent/Child, Email Thread, Duplicates Panel  

• Side Panel – Depending on your specific rights, you will see tabs showing Search History Log, 

Saved Searches, Dynamic Folders, Folders, and Distributed Search Status  

• PRODUCTION DASHBOARD – Generate production in a variety of formats based on Media, 

Tags, Folders, or Saved Searches using Production Templates and Production Field Templates 

created by administrators; utilize Advanced Options for adjusting Exclusions, Slipsheet 

settings, Export Format, and Endorsement Options  

• REPORTS – Generate numerous types of reports under two categories: User Reports and 

Admin Reports; many reports may be run at the Case, Custodian, or Media level. 

 

1.3  Login Management in VOD   

1.3.1  AD Login Setting  
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To manage the Active Directory (AD) settings, follow the below steps:  

1. Navigate to Admin > System Admin > Login Management > AD Login Setting.  

   

2. "Organizational Unit" and "Load Active Directory Groups" should be enabled when any of the AD 

groups is used.  

  

3. All AD group options should be available in the dropdown. When the user selects the dropdown 

in AD Group all available options should be displayed  
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4. Duplicate Mapping of AD group to Venio group: When user selects the same AD group for any 

two Venio Group then the error message is shown.  

  

5. Validating AD info: When User does not provide any of the mandatory fields, a message is 

displayed:  

• Domain Server Name*  

• Domain Name*  

• Domain Password*  

• Domain Username*  
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1.3.2  Login Setting  

1. Navigate to the Login Settings under System Admin section and Set maximum failed login 

attempts before locked to 2.  

  

2. If you enter wrong password for 2 times and the correct password for the 3rd time, a message 

User locked. Please Contact Administrator” message is displayed.   

3. User is unlocked automatically when the lock time duration set in Login Setting is completed.  
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4. The rules of Password Complexity. The password must have at least:   

• 1 uppercase character  

• 1 lowercase character  

• 1 numeric character  

• 1 special (non-alphanumeric) character  

  

5. Goto Admin Settings and select Login Settings under System Admin section. Select the checkbox 

of Expire the Password. Select Password expiration period (In days)2. The same Notification is 

displayed to the User upon logging in.   

  

1.4  Accessing VOD  

1.4.1  Login  
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You can login into the platform if either of these types of login is enabled:  

• Normal VenioOne Login  

• Active Directory Support  

1.4.1.1  Normal VenioOne Login  

To access and login to VOD:  

1. Open your browser and enter the URL for the application.  

NOTE: The URL is in this format: http://<HostName>/VenioWeb/ondemand  

The Login dialog will be displayed.  

2. Enter your Username and Password. If you have 2FA enabled, a verification code will be sent to your 

email id, enter the code. 

  

3. Click the Login button to login to the system.  
User will be directed to the Two Factor Authentication page if it is enabled. If not, the user will be directed 

to the Case Launchpad. On initial login, the user will be directed to the End User License Agreement screen.  

When an invalid Username/Password are provided, you will receive a Login Failed notice.  
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If you want to reset the password, click on Reset Password.  

 

You need to enter the username, old password, new password, and the same new password in 

confirm new password text box. If the entered information is correct, on clicking the Reset 

button, the password will be changed. The criteria for new password is that it must be atleast 

8 characters long, include an uppercase letter, lowercase letter, a number, and a special 

character (for example – 1234@yaJa). 

You can also click on Forgot Password to reset the password. On clicking Forgot Password, 

enter your email id and click on Submit button.  

 

This will send an email with reset link. Click on Reset link, enter the new password, and the 

same password in confirm new password text box, and click on Change Password.  
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If your password is expired, you will be prompted to enter the old password, new password, 

and confirm new password to reset the password. 

1.4.1.2  EULA Acceptance Screen and Open Source Software (OSS) License  

When a new user clicks the Log in button, the End User License Agreement (EULA) acceptance 

dialog is displayed (as shown below). The Accept button is enabled only after the “I have read and accept 

terms in the License Agreement” option is checked.  

Additionally, a link for the Open Source Software license is available for every user on initial 

login at  

the end of the EULA dialog. Click the link to find the list of free and open source third party 

SDKs/libraries/tools used in the VenioOne platform.  
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After the Accept button is clicked, the user will have access to VOD and the screen will not be shown 

during the next login.  

  

1.4.1.3  Two-Factor Authentication (2FA)  

2FA is used for security purposes. If 2FA is enabled, after entering your login credentials, 

you will receive an email containing an authentication code, which will be required to complete a 

secured login to VOD.  

Within the 2FA dialog, you will have the option to have the code remembered for 30 days by 

selecting Do not ask on this computer for the next 30 days.   
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After entering the verification code, click the Verify button to login.   

NOTE: If issues are encountered, click the here button to resend the verification code or you 

may want to try clearing the browser’s cache.  

1.4.1.4  Active Directory Support Enabled  

If Active Directory Support is enabled in your VenioOne system, then the Windows Security dialog 

will be displayed for login, and you may use your company login credentials.  

  

1. Enter your company Username and Password.  

2. Click the OK button.   

3. Click Continue to access the application.  

NOTE: If your rights are limited to specific review sets, you will be presented with available review sets 

upon login. Otherwise, the Case Launchpad page will be displayed, and you can select the required case.   

1.4.2  Changing Your Password  

You must be signed in to change the password.   

1. Click the arrow next to your username in the top right.  

2. Click User Settings.   
The User Settings dialog will be displayed.  

  

3. Click the Change Password tab.  

4. Enter the old password and new password in the indicated fields 5. Click the Change Password 

button.  
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A message will display to indicate a successful password change.  

1.5  Set User Preferences  

In the top right corner, click the arrow next to your Username and select User Settings.  

  
The User Settings dialog appears.  

1.5.1  Notifications  

On the User Preference tab in the User Settings dialog, check the desired notifications you 

wish to receive and click the Apply button. You will receive notifications according to the options 

enabled.  

• If Email options are enabled, you will receive notifications via Email.  

• If Online options are enabled, then you will receive notifications within VOD.   
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New notifications will be shown using the notification bell in the top right corner of VOD as 

shown below.  

 
We also provide notifications for the exception types, so that the user knows that there was partially extracted 

metadata as well. 

 

1.5.2  Review Settings  
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At the bottom of the User Preference tab in the User Settings dialog are two Review 

Settings:  

• The Show tag/coding saved confirmation checkbox controls whether you see a confirmation 

when tag(s) or coding changes are saved.  

• The Search Result Page Size field controls how many items will be displayed on each page of the 

Search Results.  

• The Email Thread View Page Size field helps you choose the page size from 5,10,15 and 20 from 

the drop down menu.  

  

2 Creating and Opening a Case  
 

After logging into the application, if no cases have been created, you will see the message No cases 

found. Please add new case. Otherwise, you will see the list of cases created previously.  

2.1  Two Types of Cases in VenioOne  

VenioOne has two options for creating cases in VenioOne OnDemand: TOA (Text only analysis) and 

Extract Native. The two case types are handled very differently, so be sure to familiarize yourself with the 

specifics of the two case types detailed this section.  

• Extract Native projects do what most people expect when ingesting and processing data for an 

eDiscovery project. The Native files are extracted and processed to create Full Text files in the project 

location and both files are available for review.  
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• TOA projects are designed for in-house TOA before a project is sent to outside counsel or a service 

provider. With TOA projects, after ingestion and post-processing completes, the Native data is deleted 

from the project location after the Task Synchronizer Task Scheduler runs. This means that only the Full 

Text files are available for review. This saves on the storage space required for the project.  

While applying License, there are 3 Project creation options available depending on the 

License Type selected: Venio TOA, Full Feature and When both Venio TOA and Full Feature is enabled.  

  
The Case Creation Page reflects the difference of license applied:   

• Only TOA is enabled: If license has only TOA option selected, then while creating case they will have all 

the TOA features. Those projects will only have Text in viewer and the Image and Near native viewer will 

be in disabled state. Advanced settings options will also be disabled.  

• Full Feature is enabled: If license has only Full feature option is selected, the project created will be 

normal i.e., visibility of option in case creation page, Analyze page, Review page and Export page.  

• TOA and Full Feature is enabled: If both TOA and Full Feature option is selected while applying license, 

then the user will have availability of options for project creation.  

  

The ingestion engine for the TOA project will set to “FALLBACK” by force even if the ingestion 

engine in control setting table is “LEGACY”.  

2.2  TOA Case Specifics  

The following are important differences with TOA cases:  

• Within the VOD Review Dashboard, only the Full Text Viewer is available. Because of the limited 

processing with TOA cases, there will be no Native or Image File Viewer.  
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• During review of the files in an TOA project, if a child file is tagged, only the parent file is actually 

tagged when the tags are saved. This is done so that when exporting, parent and child 

documents are exported, but only the parent files are tagged.  

• With TOA projects, only Native files are included in exports.  

• The TOA option is only available in case creation if a Native Indexing License is installed in the 

Venio License Manager. The Native Indexing will either show 0 or 1 licenses versus other Venio 

licenses, which may be issued in multiples.  

2.3  Where TOA Case Changes Appear in VenioOne:  

• License Manager - Native Indexing license shows 1 license  

• Create Project  

○ Create TOA option selected  

○ Removes image conversion options   

• Review Dashboard  

○ Only Text Viewer shows (no image, full text, etc.)  

○ Other Options - Several options are grayed out  

○ Tagging - When tagging child documents, only the Parent document is actually updated when 

the tag is saved  

• Export  

○ All Advanced Options related to imaging are grayed out  

○ Option to export files with the original folder structure and file name is available  

○ Will see message about FullText and Images not being produced - this is expected, because only Native 

files are exported  

○ Will show items on the Export Status tab, but not they will not be present in the Export file location  

2.4  Cases  

You can create a case, search for cases, sort the cases in order and search for clients from the Cases 

page. On login, the case launchpad displays total cases count, total custodian count, total review set count. From 

this page, you can create new case, search for your case, mark any case as favourite, navigate to Review, 

navigate to Production, navigate to Analyze, navigate to Upload, and view the case summary. You can add filter 

to Client and select specific clients.  

 

Total Cases, Total Custodians, and Total Review Set are dynamic and the value changes as per cases selected. 
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The Action icons corresponding to each case helps you to take the actions. 

 

The first icon allows you to mark any case favourite. All your favourite marked cases are listed in  

 

The second icon navigates to Review Dashboard. For the Old UI, navigate to section 7, for new UI, refer Venio 

Review document. 

 

The third icon navigates to Section 5 Analyze Dashboard. 

 

The fourth icon navigates to section 9 Production screen. On clicking the icon, two dropdown options are 

available – New button will navigate you to Production screen, and Status button will move to Status screen 

directly. 

 

The fifth icon navigates to section 3 Uploading and Processing Data screen. On clicking the icon, three dropdown 

options are available – Invite to Upload, New Upload, and Reprocess. On clicking appropriate button, you will be 

navigated to respective screens. 

 

 

The Total Review Set widget provides the status of total number of review set completed, in progress, or not 

started.  

 
 



© Venio Systems, Inc.   11.7.0.0  Page | 22  

The Shared Document tab list out the shared documents. The page will lost total documents which are shared, 

total users with whom the documents are shared, and if there are any documents explicitly shared with you. 

 
 

You can use the All Shared Document dropdown to view the details and left side widgets will update accordingly. 

 
The user who shared can either Edit the Shared Document or View the detail of the Shared Document using the 

icons in Actions column. 

On clicking the edit icon, the following page is displayed: 

 
You can change the date to view the shared documents upto that particular date. If you want the copy of the 

shared documents, check Send a copy to me checkbox. If you update any detail, you can reshare the updated 
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changes by clicking on RESHARE button. If you want to unshare the document with a particular user, check that 

user and click on UNSHARE button. Permission for external users will be disabled. 

 

The external users will be redirected to Review Page. 

 

2.4.1 Searching a Case 

You can search for a particular case by entering the name and click on the search icon. 

 

 

2.4.2 Login Report History 

The Login Report History displays four reports – Login/Logout Report, Locked Users Report, 

Unlocked Users Report, Creation & Deactivation Report. 

 

2.4.2.1 Login/Logout Report 

On the home page, click on  icon and click on Login/Logout Report. 
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This will open the Login/Logout Report page where you can generate the reports based on all users or specific 

users, filter the date range, and export in different formats. 

 
 

If you want to generate the report for multiple users, click on dropdown and select the users. You can also 

change the date range or you can also select the current week, last week, current month, last month and then 

click on Generate to get the report. 

 
 

You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 
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2.4.2.2 Locked Users Report 

On the home page, click on  icon and click on Locked Users Report. 

This will open the Locked Users Report page where you can generate the reports based on all users or specific 

users, filter the date range, and export in different formats. You can view the users locked within your 

organization. 

 

 
 

You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.2.3 Creation and Deactivation Report 

On the home page, click on  icon and click on Creation & Deactivation Report. 

 

This will open the Creation & Deactivation Report page where you can generate the reports based on all account 

creation, deactivation, and activation, filter the date range, and export in different formats. You can also view the 

users whose accounts are created, deactivated, or activated and by whom. 
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You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.2.4 Data Export and Download Report 

On the home page, click on  icon and click on Data Export & Download Report. 

 

This will open the Data Export & Download Report page where you can generate the reports based on all projects 

or specific projects, filter the date range, and export in different formats. You can view the users who exported or 

downloaded specific data, when was the data exported or downloaded, and path of the exported or downloaded 

data. 



© Venio Systems, Inc.   11.7.0.0  Page | 27  

 
 

You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.2.5 Role Change Report 

On the home page, click on  icon and click on Role Change Report. 

 

This will open the Role Change Report page where you can generate the reports based on all users or specific 

users, filter the date range, and export in different formats. You can view the users who changed the role, user 

whose role is changed, and changes in the role. 
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You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.2.6 Deleted Export Report 

On the home page, click on  icon and click on Deleted Export Report. 

 

This will open the Deleted Export Report page where you can generate the reports based on all users or specific 

users, filter the date range, and export in different formats. You can view the users who deleted the export, the 

mode of deletion, and the export name. By default, Admin user is able to view this report. You can provide any 

user with appropriate permission from Admin Settings. 

 

 

 
 

You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

 

https://xd.adobe.com/view/a9203885-3e0b-4db0-819a-41d3c383905b-fc73/
https://xd.adobe.com/view/a9203885-3e0b-4db0-819a-41d3c383905b-fc73/
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2.4.2.7 Project Access Report 

On the home page, click on  icon and click on Project Access Report. 

 

This will open the Project Access Report page where you can generate the reports based on all users or specific 

users, filter the date range, and export in different formats. You can view the project names, the usernames, and 

the Last Action Date & Time of the respective user and project. 

 
You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.2.8 Activity Report 

On the home page, click on  icon and click on Activity Report. 

 

This will open the Activity Report page where you can generate the reports based on all users or specific users, 

filter the date range, and export in different formats. You can view the usernames, Activity performed, Date & 

Time of the respective user and project. This report includes activities like Login and logout, tagging, bulk tagging, 

untagging, view document, creating folder, move to folder, send to folder. 
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You can export the report in PDF, CSV, and Excel. Once exported and downloaded, you can view it in downloaded 

format. 

 
 

2.4.3  Client Search  

Using this option, you can filter the cases by clients and navigate the cases faster. While 

searching, you can also search for multiple clients at a time. This option is visible only for Internal client users.  

 

2.4.4 Creating a Case  

You may create a case by providing only the Case Name. You may also choose to enter 

additional information using Advanced Options.   

 

1. Click the Create Case button. 

2. Enter the Case Name  
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3. Select a Case Template from the drop-down menu to determine how your data is processed and 

project options are handled.  

4. OPTIONAL: Click the Advanced Options link and set additional options (detailed in the next section).  

5. Click the Create Case button to create new case/project. The Case Details section appears:  

  

• Client Matter Number  

• Time Zone – Sets the time zone for processing  

• Search Duplicate Option – Sets how deduplication will be handled when searching  

 

2.4.5  State Error  

When there is state error in the systems, there is link for the state error in the case 

launchpad, and when you click on it, the corresponding detail for the case is displayed.    
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2.4.6 More Options  

The More Options section displays the following additional options. You may choose to 

provide the following information: File Filters  

• Filter System Type – Helps you to filter files based on the file types or NIST.  

  
• Filter Duplicate Files – Select one of the radio buttons to use the hashing algorithm for ingested 

documents. You can select the check box if you want to compute and store secondary hash 

value in database.   

  

• Advanced Hash Setting - You can select advance hash setting where there is meta of the emails 

to be selected for calculation of the hash value.  
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• File Extension filter - There are two options in file extension filter, namely Include and exclude. 

The extensions that need to be included should be selected as Include and enter the list of the 

extension. The extensions that need to be excluded should be selected as Exclude and enter the 

list of the extension.  

  

• Advanced Options - In the advance option, the filter can be applied to first, parent level files. The 

extension can be applied on files in any level.  

 o 

Apply filter on first level files only - Applicable at first level file(s).  

o Apply filter on parent level files only - Applicable at parent level 

file(s) o Apply extension on files in any level - Applicable at first level file(s).   
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Note: (Container file(s) will not be filtered) DO NOT apply filters on container file option is available for 
files in any level only. (container files will be processed as a folder when checked)  

• File Type Filter – Use this option to filter by file type either including these files or excluding 

these files.  

  

• Date Filter Settings – Set the date filter using the settings in this window. The Document Type 

can be Email, EDoc or Both. The entry made by Edoc, Email and both should be visible in the 

Process files with panel. You can select Group Date from the Date Type drop down menu, and 

the Operator as Before, After, Equals to, or Between from the drop-down menu. Select the Start 

Date and End Date from the calendar.   
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• Embedded Item Setting – This option is used to filter embedded items in Email, Edoc and 

Powerpoint.  
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Image Settings  

• Image Conversion Options – Auto-generate images for ingested files   

  
From the image conversion option, you can either enable or disable “Enable Image” option. You can 

also choose the Image type as “Tiff” and “PDF”, and set the page limits to 100, 200, 500 or 1000.  You can 

also change the “Default color conversion option” and “default timeout period”. • Advanced Image 

Option –   
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• Image Conversion Options with TOA license – For TOA, the Tiff image type is not available, hence 

it is unchecked and disabled.  

• Image File Type Settings - The option is used for settings which engine to use while imaging the 

document. To view the list the engines to be used, right-click on the filetype group.   

  
You can select from the available options for the imaging engine. When you click on the arrow on 

the filetype, it lists all the related filetypes. The drop-down towards the right displays a dropdown displaying 

the imaging engines which can be used individually.   

    



© Venio Systems, Inc.   11.7.0.0  Page | 38  

  

When you select the native engine (Outlook, PDF, MS Word, MS Excel, and MS PowerPoint), 

the Advance Native Imaging option is enabled.  

The Advance native Imaging option has tab for Native Excel Imaging, Native outlook Imaging, Native  

PowerPoint Imaging, Native word imaging. The user can select different options from the 

tabs   

  

• File Type Filter - Select File Filter Type to filter files by identified file type.   

• Include: Process documents which match listed file type.  

• Exclude: Process documents except listed file type.  
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• Image File Extension Setting – This section is used to provide/specify File Extension and Imaging 

Engine details. The details are reflected in the below panel.   

  
OCR Settings  

Select the file types which are needed to be OCRed. You can also choose to auto queue the 

files to OCR while ingestion is in progress.   
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• Advanced OCR Option -   o PDF - You can select the PDF document with fewer text. You can 

select from the following two options:  

▪ OCR PDF documents with average character per page less than 20 or can select max 

value.  

▪ OCR PDF documents if at least one page has character less than 10.  

  

If one option is selected, the other option gets disabled.  
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Note: Only PDF page matching set threshold will be OCR'ed and merged with extracted text and 
these settings are only applicable for Nuance OCR Engine.  

o Language - To OCR documents for selected languages, select the required language 

checkbox(es).  

 o Others - The 

number of times to retry when Nuance OCR engine fails is two. You can either discard all 

OCR'ed text and mark document as OCR Failed if one or more pages failed to OCR or Index 

OCR'ed text (based on fulltext priority if required) and mark document as having text if one or 

more pages failed to OCR as shown in the screenshot.  
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• Slipsheet - In the SlipSheet window, you can generate a slipsheet for specific file types. The 

slipsheets are generated when the files are TIFFed.    

  
For more details on Slipsheet, go to the section Creating Slipsheets from Console and Creating 

Slipsheets from Web.  

Processing  

• Ingestion Settings  o  Date Time Setting - You can set the date time and the format in the Date 

Time Setting. In Group Date Priority, ye can set the meeting dates. Also, it's advisable not to 

include Crash Document during ingestion setting. The Default Timeout setting is 2- minutes. You 

can extract the internet message header by selecting the checkbox for  
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Extract internet message header. You can autocompute and populate 

custodian dedupe field, file path and relative path during ingestion from the Post 

Processing Setting. Enable the extraction of all views from NSF by selecting the 

checkbox for NSF viewing extraction setting.  

  

• Ingestion File type timeout– The ingestion timeout setting is for timeout required for processing 

the document.   
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Users can click on the Ingestion File type timeout link which will list individual filetype 

groups.  

  
Right click on the individual filetype, user will have the option to set the timeout value.  
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 o  Post Processing - Select the post processing settings for a smoother ingestion  

  

• Indexing – Select one of the radio buttons to enable indexing for ingested files. Enabling Index fulltext 

enables Index Email Headers with Fulltext too. You can also enable Index MetaData.  

  
While hovering on the i button in Index Email Headers with Fulltext, the following options 

are displayed:  
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o 

EmailFrom o EmailTo o 

EmailCC o EmailBCC o 

EmailSubject o 

EmailAttachments  

  

• Customize metadata for indexing - This field is used when running searches with attributes or  

‘full text and attributes’ option in search. The selected metadata are indexed into the 

‘Attributes’ field.  

  
• Transcribe Settings – Transcribing uses a different transcribing engine to transcribe/record different file 

type. Deep Speech is the default engine. Amazon Transcribe and Azure Transcribe engine are services 

provided by Amazon & Azure. To transcribe audio files during ingestion, select the transcription engine 
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(DeepSpeech, Amazon, or Azure) and file type(s). If you wish to have files transcribed as they are 

ingested, use the check box to Automatically queue document for transcribing. Supported audio files will 

have text extracted and displayed in the Fulltext Viewer.  

DeepSpeech supports: Riffwave files.  

Amazon Transcribe supports: ISOBASEMEDIAFILE, MP3_ID32, QuickTime, MPEG4 and 

MP3 and Riffwave.   

Azure Transcribe supports: MP3_ID32 and Riffwave.  

  
The Deep Search uses Riffwave File type.  

Amazon Transcribe uses RIFFWAVE,  ISOBASEMEDIAFILE, MP3_ID32, MPEG4 and 

MP3, QUICKTIME  File Formats.  

Azure Transcribe engine uses RIFFWAVE and MP3_ID32 file formats.  

We can automatically queue documents for transcribing by selecting the checkbox 

below.  

 o 

 Advance Ingestion Setting – You can configure settings for Duplicate Computing  

Options, Auto Queued Job Setting and Filter Copy Option  
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o Duplicate Computing Options:  You can select this based on the custodian priority, or sequence of 

media added, or media processed or the order of document ingestion.  

  

o Auto Queued Job Setting - This can be done at project level or custodian level. Can 

select the list of job names which we don't want to queue.  
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o File Copy Option - You can create the second copy of all scanned files in project location.  

  

• Social Media Setting – This tab is visible when the ingestion engine Legacy check 

box is unchecked while creating a case. Users can select the options as per the 

requirement.  
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• API Priority Setting - This tab is visible when the ingestion engine Legacy check 

box is unchecked while creating a case. Users can select the options as per the 

requirement. The API Priority Setting link opens the Filetype Processing Engine 

Settings dialog, which then opens the File Type Identification Priority dialog.  
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• Language Identification, Email Analysis and Email Threading – Select language 

identification checkbox for enabling language identification of the document 

ingested. You can also choose the option for computing the language for 

spreadsheet   

Select Enable Email Analytic to compute the email analysis of the emails ingested.   

Select compute Email identification during ingestion option to identify the emails. You can 

also compute the inclusive email and generate the missing emails during ingestion.  

  

• Ingestion Engine - The project must have a Fallback Ingestion engine for social 

media viewing, but this depends on the DB value of Ingestion engine. For this, 

the user can select the option to create the project using Legacy or Fallback. 
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Depending on the Legacy option is selected or not during project creation, the 

project with Legacy Engine or Fallback is created.  

  

• Legacy  

• Near Duplicates Settings – These settings help you to automatically queue 

documents for computing signatures by selecting the checkbox, mention the 

minimum threshold % by which the documents could be similar and specify the 

minimum characters in fulltext for computing signatures. You can also select if 

you would like to include metadata when computing near duplicate hashes or 

not through a checkbox.   

  
We can either include or exclude disclaimer using the Filter Disclaimers check box. If you 

have added the disclaimer, it will be visible in the disclaimer text panel as shown below:  
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• Transcribe Settings – To transcribe audio files during ingestion, select the transcription engine 

(DeepSpeech, Amazon, or Azure) and file type(s). If you wish to have files transcribed as they are 

ingested, use the check box to Automatically queue document for transcribing. Supported audio 

files will have text extracted and displayed in the Fulltext Viewer.  

DeepSpeech supports: Riffwave files.  

Amazon Transcribe supports: ISOBASEMEDIAFILE, MP3_ID32, QuickTime, and Riffwave.  Azure 

Transcribe supports: MP3_ID32 and Riffwave.  

  
 

• Stop Words 
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You can add stop words by adding the words and clicking on Add button. You can also search all the 

added stop words. 

 

General  

• FullText Options - The Default Full Text Preference for (Indexing, Near 

Duplicates, Fulltext Viewer and Export) is Image OCR Text, Extracted Text, and 

Redacted OCR Text. You can drag and drop the following Full Text options:   

o Automatically Image and OCR files without text. (Applicable for Non- image files only) 

o  Extract Text from master view for Microsoft Office PowerPoint.  

  

• Native File Options - Select the options for to convert the native file to different formats 

html/mht, rtf etc. There are options to automatically queue the documents for generating 

HTML/MHT or RTF based on the selection.  
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If Extract Native is selected, the native files will be present in the Native folder in the Project 

Location and all workflows will be normal.  

If TOA is selected, then after post-processing, the files will be deleted from the Native 
folder. However, the full text files will still load in the Document Viewer and may be exported and 
searched successfully. Also, the Image Conversion Options (described below) will not be visible. See 

Section 2.1 above for more information on creating TOA cases.  

For information on how to Install Task Synchronizer, refer to the Page no 12, Section 

no. 3.1 from the Installation/Upgrade Guide  

For TOA Projects  

Select TOA from the Native file options:  

  

• Discovery Exception Handling - Specify how to handle the processing for failed files. If you 

selected to repair the file, when any file fails to process, an email notification will be sent to 

repair the file by replacing the file or providing a valid password.  
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• HTML Conversion Settings - HTML Conversion setting is divided into Hidden objects and 

spreadsheet. By default, Show hidden rows/column/sheet and Show hidden text and Show 

spreadsheet grid lines should be checked.  

  

• Search Terms – Enter search term(s) on a separate line. Documents will be auto tagged with 

the search terms, and the terms will be listed in the tag list.   

  

• Password – Enter passwords to decrypt any password protected files being uploaded  

  

• Entity Extraction Option - Select this option if you want to auto- queued the files for the 

entity extraction process.  

  
  

Advance Settings   

Some of the very essential settings such as default System Tag settings, Media Settings,  
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Redaction Setting, Export Settings and other Settings (Web printer settings, Create custom 

fields, Create folder, Term Highlighting etc.) can be configured through Advanced Settings while creating a 

case.  

  

• Tag Settings – You can generate the default system tags by selecting Auto populate default 

system tags checkbox.   

  
• Customize Default System Tags - Click on Customize Default System Tags option to apply 

exclusive rule. You can Add the Tag Name to add custom tags and Add Tag Group to add a 

tag group. You can add both exclusive/inclusive tag rules.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 58  

 
 

Add Tag: 

You can now create and manage tags directly while creating the case. 

 

To add a new Tag, click on Add new Tag: 

1. Enter a Name for the tag.  

2. Select the Tag Group using the drop-down list.  

 

3. You can click the Manage Tag Group link to create one or Advanced option.  
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On clicking Manage Tag Group: 

1. In the Tag Group dialog, enter a Name for the tag group. 

2. Check the Apply exclusive tag check box if you intend to create an exclusive tag group. You can also 
edit or delete the tag groups. 

3. Click on Save button. 

 

On clicking Advanced option: 

1. Select the parent tag from the Parent Tag drop-down list.  

NOTE: If the tag being created is a top level tag, then the Parent Tag drop-down will be left to display 
Select Parent Tag.  

2. Enter the Description. 

3. Select option from Reviewer Comment dropdown. The options are None, Recommended, Optional, 
Required. 

4. Enter the Label.  

5. Select the Color for the tag.  
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6. Select the appropriate permissions to the roles by clicking on dropdown. 

 

You can also use the three icons to read/write permissions for all the roles, read only permission for all 

the roles, and apply None permission to all the roles. You can edit or delete the tags. You can also edit 

or delete the User tags, and System tags. 

Add Tag Group: 

On clicking Add Tag Group, you can add a custom tag group and enter the Group Name. You may also check 

the Apply Exclusive Rule checkbox to make the tag mutually exclusive. Click Add. The newly created tag group 

appears in the Tags list.  
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You can edit or delete the custom tag group. You can also edit or delete the Custom tags, User tags, 

and System tags. 

 

 

 

  

  

You may also apply the tag propagation rule as required. Similarly, you may also choose to apply 

the Tag Propagation Options using the radio buttons and checkboxes. Click the Save button to save your 

settings.  

• Hide Media Settings – By checking this option, the newly ingested media gets hidden for all 

the non-admin groups. Access to this media can be provided to non-admin groups from 

Venio Web. All the media listing modules show only those media which are restricted to a 

particular set of users. Restricted media-related information is displayed in Project Details, 

figures, and charts.  

  

These VenioOne Modules list only Restricted Media:  

• Export  

• Dashboard  

• Move Media /Documents  

• Tiff QC Wizard  

• Spam Tag  

• Manual Indexing  
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• View Duplicate->Project Scope  

• View Similar Documents   

When Document Restriction mode is on, all sources such as Tags, Folders, Saved Searches 

are controlled (or disabled), i.e., these sources are under the restricted media scope and counts shown 

are in accordance with the restricted scope. For example, export by tag source does not export 

documents outside the restricted scope even if those meet the tag source criteria.  

• Redaction Settings - Select Create default redaction sets option to create default redaction 

sets in the project. This includes Highlight, Black, and Whiteout Redaction.  

  

• Export Settings - Set to show warning while performing export if there are files with 

ingestion error which were not reprocessed.  

  
Other Settings  

• Web Printer Settings – Using these settings, you can set the maximum number of documents 

that can be printed and the maximum number of pages per document that can be printed. 

Enter the number and click Ok to save the printer setting.  

  

• Create Custom Field:  You can choose to create a Custom Field by clicking on “Create Custom 

Field”. The create custom field window then appears where you can create fields. The 

created field should be applicable for create/edit cases as well as create/edit case templates. 

If a case is created using the template all the fields should also be created correctly in the 

newly created case.  
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• Create Empty Folders - You can choose to create an empty folder by clicking on the Create 

Empty Folder option. The create folder dialogue appears where you can create a folder in a 

different folder hierarchy or delete the created folders.  
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• Term Highlight Management - While creating a case, you can establish highlights for specific 

privilege terms that will make it easier to see the terms while you are reviewing your 

documents.  You may use different colors for each individual term. Expand Advance Settings 

and click on ( )to  navigate to Term Highlighting dialogue.  

  

Enable Privilege Term Highlight   

1. Click on Enable Privilege Term Highlight checkbox to enable the settings for privilege term highlighting.  

  

1. Enter Privilege Term individually, select the term color and add term. Similarly, you may also 

load a text file with all the terms.  

2. Click on Browse, select load file and click Load to load the privilege term.   
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Note: Create a text file with each term on a separate line and use the load function to upload the 
term list.  

Then select the colour and click Load.  

3. Select the color for each term and click Add.   

Or  

4. By default, the highlight color is yellow.  Use the drop-down list to choose the color you want.   

5. You can also apply the same Default Color to all the privilege terms by clicking Apply Default 

Color to All. Once the terms are loaded, they will appear in the list.  
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6. You can make changes to each term color by clicking in the Color column.   

7. Click Save when you have all your terms and colors established. You can also use the Delete 

button to Delete Privilege Term tab to make changes to the terms.  

Note: Privilege term can be configured from the Admin Section for the case as well. You may navigate to: 
Administration >> Case Admin >> Highlight >> Manage select project and edit the privilege term to be highlighted 
as necessary.  

8. Once the case is created enabling the term highlight and data is processed, In search and  

review page review can use highlight tool to see the privilege term.  

  

• Enable Search Term Highlight - Enabling Search Term highlight will highlight the term search in the 

Search and Review page. This setting is the default and can be disabled as required.  
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Enabling this setting highlights the term searched in search and review page.  

• IDP Group Mappings:  

1. Enable SAML-IDP Server Based Authentication and Use IDP groups to control VenioOne 

project level access in SAML-IDP Server Settings from Console  

2. Directory Services - Group Mappings should be available below image settings in "Case 

creation" page and group mappings should be same as in Console  
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3. Disable "Use IDP groups to control VenioOne project level access from Console  

4. "Directory Services - Group Mappings" should not be available in "Case creation" page  

 

5. Goto Admin Settings and in Case Admin Section, click on Manage under Case dropdown and 

click Edit.  

6. Click on "Directory Services-Group Mapping" Edit the Group Mapping and click on "Update 

Case"  

7. Edited AD Group mapping should be updated and saved successfully  
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8. Select the same IDP Group for two Venio Group's. And click Update Case.   

9. "This IDP Group has been already mapped. Cannot map IDP group to IDP Mappings- (Venio 

Group name) should be displayed  

  
After you click the Create Case button, you will be taken to the screen where you can 

upload files.  

• Image conversion options – Auto-generate images for ingested files will be disabled for TOA  
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• Sending to Production – For TOA Project, the Sending to Production option is grayed our or 

disabled in the Analyze page  

  

• Full Text Viewer: For TOA project, only full text viewer will be available and other tabs are grayed 

out or disabled in the Review Page. Also, the user will not be able to send document to analyze 

and to production pages from Review page in TOA project.  

  

• Image options in Menu – All the options related to images are disabled in the menu options.  
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• Show Advanced Options - For TOA projects, the Show Advanced Options buttons will be disabled 

in the Production page. There will also be change in Folder Path and File Name Options label 

option name.  
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• Active Directory Group Mapping - In Active Directory Settings, when the checkbox of “Use AD 

groups to control VenioOne project level access” is checked, the active directories are displayed 

in the table below as shown below:  

  
The default values of Active Directory Group Mappings are displayed in Case Creation page in More 

Options.  

 

Once you have made all the selections in More Options, click on the Create Case button.  

Note:  

When selecting a location of the new project from the New Project Location field. The 

available options are Remote Repository and Local.   

1. Enter the location where you wish to store the replicated project in the field.   
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2. Click Next.  

Venio creates a folder under this directory named after the case name  

\\server\sharedfolder\<CaseName>  

Within that casename folder, Venio will create a folder structure as seen below  

 

  

2.4.6  Opening a Case  

As soon as you login to VOD, available cases will be displayed in the Case Launchpad.  

NOTE: Those with limited Reviewer rights will only see the Review Set batches assigned to 

them.  

Click the desired Case Name to open a case to the Review Dashboard or use the Search bar 

to search for a case by name. Return to the Case Launchpad at any time by clicking the logo in the upper 

left corner of the VOD screen.  

    

  

  

about:blank
about:blank
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Action Buttons in the right side of each case are used to:  

 

• Favourite 

• Review 

• Analyze  

• Produce 

• Upload  

 

2.5  Opening a Review Set  

Those with limited reviewer rights will see assigned batches upon login to VenioOne 

OnDemand.   

NOTE: For the reviewer role, if no review set is assigned, then a warning will display.  

  

There are two review statuses:  

• Not Started: Review set has not been checked out for review.  

• In-Progress: Review set has already been checked out for review and is in process.  

If there are cases assigned to you, then you will need to click the Review Set tab to navigate 

to a Review Set.   

Click the Review button on a review set’s card to open a batch to the Review Dashboard and begin 

tagging and reviewing documents or use the Search bar to search for a review set by name. Return to the 

Launchpad at any time by clicking the logo in the upper left corner of the VOD screen.  

  

When creating a Continuous Active Learning (CAL) Review set, the reviewer can view the review sets 

by noticing CAL flag displayed with review set name in the case launchpad. 
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Also, reviewers can have a count on how many documents are reviewed so far for the review set 

and pending number of documents to be reviewed for the entire review set. 

The prediction score for each document is also displayed in Review page grid view which indicates 

the confidence level predicted by the CAL process. It is represented as PS_<Reviewsetname>. 

 

 

2.6  Reviewing Assigned Batches  

As soon as you click the Review button a batch gets checked out to you, and you will be taken to the 

Review Dashboard where you can tag and review documents. The layout of the panels, tags, and highlighting 

options available are configured by the admin when creating the review set, but you may also have rights to save 

your own customized layouts.  

NOTE: The documents manually reviewed are not queued for prediction. 

Documents are initially sorted in the order determined by the admin but can be re-sorted 

using the Other Options button in the upper right corner of the Table panel and selecting Sort Results.  



© Venio Systems, Inc.   11.7.0.0  Page | 76  

  

2.6.1  Viewing and Tagging Documents  

Select documents within the Table panel (center) and use the Document Viewer (right) to 

view the document contents. You have the option of viewing the document in various formats (FullText, 

Native, HTML, Meta Detail, Tiff, PDF).  

Apply tags using the check boxes in the Tags panel (upper left). Click the Save  button to save 

the tags without moving to another document. You must also mark files as reviewed in order to check in a 

batch. To save time, click the Review, Move to Next  button next to the Save button (upper right corner of 

the Tags panel). If not using the Review, Move to Next button, use the Other Options button in the Table 

panel and select Mark as Reviewed. If you have rights to do so, you may copy tags from the previous 

document using the Copy  button.  

  
Additional panels (if enabled by the admin) such as Metadata, Duplicates, and Coding are 

also available within the Review Dashboard. Use the Notes panel to communicate with others on the 

review team.  

2.6.2  Bulk Tagging  
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You may apply tags and mark as reviewed in bulk by selecting multiple documents from the 

current page or the whole batch using the Select All button in the upper right corner of the Table panel. You 

may use the Previous/Next buttons to review individual document   

  

2.6.3  Checking In Assigned Batches  

After you have marked all document as reviewed, a pop-up message appears asking 

whether you want to check-in the current batch as shown below.  

  
When you click Yes, the current batch gets checked in and another batch gets checked out. 

If you click No, you will be asked again when you come back to the same review set.  

NOTE: You cannot check out a new batch until all documents in the previous batch have been 

marked as reviewed and the batch has been checked in.  

2.6.4  Reviewing Documents for Continuous Active Learning (CAL)  

To create documents that will be used by VOD’s CAL engine for creating control and training sets, 

reviewers will tag the documents using respective “Manual” tags which are created when creating the CAL 

profile. This is done in the same was as any other batched review.  

NOTE: You will only see the panels, tags, and fields that you were given permissions to see when the 

review set was created.  

Using the tags specifically created for CAL, review the documents to categorize them. These tags are 

named Manual_CALProfile_Category.  
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DO NOT use the “Auto” tags. Those are used by VOD’s CAL engine to categorize documents, so 

it is recommended that they not be displayed to reviewers.  

  
  

2.7  Removing Documents from Review Batches  

Review sets are a static set of documents where you can analyze, query, view, tag, and export 

data in a case. When you no more need the documents, you can delete the same from the review batches. 

The Remove documents from Review batches removes all documents within a saved search of each batch set 

you specify.  

To remove documents from review batches:   

1. Navigate to Review Batches Administration > Case Admin > Review Set > Manage.  

2. Click on View for the Review set from which you would like to remove the documents.   

3. You can Search By Tags or Query. Depending on whether you have selected Tag or Query, the 

corresponding options are displayed in the drop-down menu.  

Search by tag  

Select Tags from the Search By drop down menu, The corresponding tags appear in the 

Search By Tags drop down menu. Click on search icon. 
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Select a batch which is “Not Checked Out” status from the list and search by Tag. Select the 

documents you wish to remove.  
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Click on the Delete icon to delete the selected documents. A message confirming if you 

want to delete appears. Click Yes to delete.  

 

A message confirming the deletion of the batch appears:  

  

Search by Query  

Select Query from the Search By drop down menu. Enter the query in the Search by Query field. 

Click on search icon.  
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Select a batch which is “Not Checked Out” status from the list. Select the documents you wish 

to remove.  

 

Click on the Delete icon to delete the selected documents. A message confirming if you 

want to delete appears. Click Yes to delete.  
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A message confirming the deletion of the batch appears:  

  

2.8  Direct Export Service 

If you want to upload the processed data and produce it using the selected case settings and production 

template, you can now click on . You can add data to the existing case using VOD Export Service. 

 

On clicking the icon, you can now select the case. PDF Service is used for Case creation, while on selecting Add 

Data to an existing case, select the case from Select your Case dropdown. 

 
After selecting the case, the fields are disabled. To enable the fields for updating, click Override Service Request 

Settings checkbox. 
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You can now update the data as per your requirement and click on Next button. The summary of all the changes 

is displayed and click on Upload button to upload the data. 

 

Once the upload is complete, notification is sent to the users who uploaded the data and Admin via email. You 

will receive password protected files as well as failed natives (if any), and it would be easier for you to reprocess 

the filles. In the email, click here to send manual notification link is provided only to the Admin, and not the user 

who uploaded. The user who requested will get the email to download the production. 
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3 Uploading and Processing Data  
 

Data can be uploaded immediately after you create a case, or you can click the Upload 

button anytime files need to be uploaded.  

3.1  Data Types Supported  

• Data can either be Unstructured raw data in a variety of different formats or Structured, such as 

third-party production. VenioOne supports virtually all of the structured data export formats 

used by common eDiscovery platforms.  

• Data can also be a Transcript file (.pcf or.ptf format). However, the Transcript option is only 

displayed when permission is given to the user to upload transcripts.  

• Data can also be an export from the following Social Media platforms: Facebook, Twitter, 
Cellebrite, Slack, and Bloomberg. Social media content can either be individual files or container 

files.  

NOTE: If the Social Media option is not available, please contact your VenioOne 
Administrator. After enabling the Fallback engine (Ingestion_Engine_Type = “Fallback” in the control 
setting table), then the option to upload social media should appear.  
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3.2  Uploading Data from the Local Computer  

1. Click the Upload button.  

  

2. Select one of four broad data type options: Unstructured, Structured, Transcript, or one of the 

Social Media icons.  
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The source selection screen displays.  

3. Either click the folder and select the file location on the Local Computer OR  

Click the Repository button (upper right corner) and follow the instructions below.  

 



© Venio Systems, Inc.   11.7.0.0  Page | 87  

NOTE: Unless you are using Internet Explorer with an add-on installed (see ActiveX Uploader 

section below), VOD only allows certain container file types for upload. Click the  
button to view the file types supported.  

 
 

Once the upload process starts, you can click on filter and check the files which are in specific status. 

 
 

To Upload Data from a File Repository: 

1. Select a Repository and click the Load button to display the Repository Hierarchy. 

2. Hover over a folder in the Repository Hierarchy section and click the Expand All button. 

3. Click to select the folders. 

4. Click the Add button to list the files to be processed. 

5. Click the Process button. 
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6. The selected file details will be listed as shown below. Provide the Custodian Name for each file.  

Note: The filename is used as the default custodian and media name.  

7. If needed, remove files from the list by clicking on the Delete button ( ).  

8. Click the Upload & Process button to upload the files and queue for processing.  

  
The Upload and Process Status will display.  

9. Track the Upload and Processing status.  

User will receive an email on start and completion of processing.  

IMPORTANT: For Structured Data that is being imported into VOD, you will receive an email and 

inapp notification indicating that the file is uploaded and ready to be processed. You must click the link to 

start processing the data. See Section 0 below for details.  

3.3  Uploading Data from a Data Repository  

If a data repository has been associated with the client, it will be available to select from 

within the Upload process.  

1. Click the Upload button.   

2. Select one of four broad data type options: Unstructured, Structured, Transcript, or one of the 

Social Media icons.  

The upload screen displays.  

3. Click the Repository button in the upper right corner.  
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The repository selection screen displays.  

 

Note: If a user has a Venio admin role then they can see all repository details in the Repository section.  

4. All the files and folders inside the Upload location will be displayed in the Repository Hierarchy 

section. Users no need to click the load button to load the files additionally, it will be displayed by 

default.  

5. Select a Repository(ies) from the list, and then click the Load button (bottom left).  

A list of folders and/or files within the repository will be displayed in the Repository Hierarchy section.  

    



© Venio Systems, Inc.   11.7.0.0  Page | 90  

    

  
NOTE: When you hover over the root folder, three buttons will display:  

• Add   - Adds the files for processing  

• Expand   - Expands the folder hierarchy  

• Collapse   - Collapses the folder hierarchy  

If the files are already expanded, then there will only be 2 buttons displayed – Add and 

Collapse.  

6. Either click the Add + button next to a folder OR  

Place a check mark next to the items to be uploaded and then click the Add button (bottom 

right).  

The items to be uploaded will be listed with a space for the Custodian Name to be entered.  
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7. Either select a Custodian Name from the drop-down list or enter a name.  

NOTE: If no custodian name is provided, the file/folder name will be used as default 
custodian name. When multiple file/folder(s) are assigned to a single custodian, selecting the 
custodian name will be mandatory.  

 

8. Add the Media name. 

9. Click the Process button to upload the files and queue for processing.  

The Upload and Process Status will display as shown below.  

10. Track the Upload and Processing status.  

User will receive an email on start and completion of processing.  
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IMPORTANT: For Structured Data that is being imported into VOD, you will receive an email and 

inapp notification indicating that the file is uploaded and ready to be processed. You must click the link to 

start processing the data. See Section 0 below for details.  

3.4  Add Batch Media using load file  

VenioOne gives you the option of using a batch load file to add new media.  This allows you 

to add multiple files at a time.   

To add new media using the batch process, follow the steps given below.  

1. Navigate to the Add Batch Media button.  

  
Once the repository is loaded, move your mouse around the repository grid to see the Load 

button.   

2. Click Load button to validate and populate load-file media information in the grid. Select the 

batch file that you wish to upload. The media will be added in the list with a check mark on the 

right for each valid file.  
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3. Click +Add.  The added files are displayed in the screen.   

  
4. Click the Process button to upload the files and queue for processing. Upon completion, the 

following confirmation appears:  
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Once the Processing is completed, a notification is sent confirming the processing. You can also 

view the processed documents through the link provided in the notification message.  

  

3.5  Processing Social Media, Chat, and Mobile Data  

VenioOne will process the data from a variety of social media and team chat platforms, as well as 

Cellebrite mobile data. Most of the data is processed into.eml files, so it can be viewed using Venio’s Social 

Network Diagram and other Email Analytics tools.  

Specifics on what export formats are needed and how the data will be presented for each 

different type of data is detailed in the subsections below.  

NOTE: Some of these settings are available only when the ingestion engine is set to the 

FALLBACK Ingestion engine, so check with your VenioOne administrator, if you do not see them.  

 

3.5.1  Viewing Social Media, Chat, and Mobile Data  

The individual.eml files generated by VenioOne can not only be loaded into VenioOne, but also 

opened with Outlook, Outlook Express, Thunderbird, etc. You could also open the.eml files with a text viewer, 

but it is not very readable due to the coding that is displayed.  
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There are other tools that convert XML to PST, but it’s really horrible e.g., each email file 

may have hundreds or thousands of recipients if sent to the whole company. We parse the data such 

that different chats are placed into folders containing the.eml files by date.  

The files ingested include any emojis, GIFs, videos, and other attached files and links. Some 

of the social media and chat data can be filtered by person and date as well. All of these can be searched 

and reviewed using VenioOne’s full suite of review tools.  

3.5.2  Cellebrite Data  

You should have an image from a mobile device created in Cellebrite, which the person doing 

the collection has licensed. Cellebrite allows you to export in XML. Venio uses the Cellebrite XML output to 

parse the data into a format that is then loaded into VenioOne for search and review. It will even display the 

communications data in our Social Network Diagram (spider web view of communications).  

Caveat: Garbage In. Garbage Out. We can only use the data that Cellebrite has created in their 

image.  

3.5.2.1  Processing Cellebrite Data  

The processing of Cellebrite data creates one folder per item type. The contents of each 

folder are:  

• SMS, MMS, Chat will be ingested as.EML files  

• Contacts will be ingested as.VCF files  

• Calendar will be ingested as ICS files  

The rest will be ingested as CSV files as follows:  

• Calls - One CSV file listing the type, start time, duration, and who started the call  

• Location – Single CSV file listing the date, time, and coordinates  

• Installed Apps - Single CSV file listing the app name, version, and description  

• Password - One CSV file listing the account, data, and label  

The time for processing depends on the size of the Cellebrite data and your environment 

but is generally 1.5-2 GB/hr. on average.  

3.5.2.2  Viewing Cellebrite Data  

After the Cellebrite data is ingested into VenioOne, you may use any of the usual functions for 

processing data. For example, our Email Analytics tools will show the breakdown of communication and 

connections within the text messages from the Cellebrite data.  

3.5.3  Slack Data  
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To use Venio’s Slack ingestion, the Slack admin must download the data from Slack, which is in 

JSON format. VenioOne processes the data and creates.eml files that are then loaded into VenioOne for 

search and review.  

3.5.3.1  Processing Slack Data  

VenioOne creates one.eml file per day that includes all of the Slack Channels. Each channel 

gets a separate folder. Any embedded images in the Slack discussion are included in the.eml files. Any 

attachments are downloaded as well. If there are private chats, those are included as.eml files in folders 

for each chat.  

There are other tools out there that convert XML to PST, but it’s really horrible e.g., each email 

file may have hundreds or thousands of recipients if sent to the whole company. We parse the data such 

that different chats are placed into a folder containing the.eml files by date.  

3.5.4  Bloomberg Data  

Bloomberg has a communication platform that is similar to Slack, which includes chat, email, etc. 

An XML export can be done within the Bloomberg environment that VenioOne processes to extract the data in 

a useable format for discovery.  

There are other tools out there that convert XML to PST, but it’s really horrible e.g., each email 

file may have hundreds or thousands of recipients if sent to the whole company. We parse the data such 

that different chats are placed into a folder containing the.eml files by date.  

3.5.5  Facebook Messenger Data  

VenioOne processes the JSON export from Facebook Messenger into.eml files that are presented in 

VenioOne for search and review using all of our available tools.  

3.5.5.1  Exporting from Facebook  

The steps below will walk you through the process of exporting the Facebook Messenger JSON data 

from Facebook. These steps may change from time-to-time, but this should at least get you started.  

1. Login to the Facebook account.  

2. Go to Settings and Privacy > Settings > Your Facebook information.  

3. Click download your information.  

4. On the Request copy tab, select the Date Range, Format and Media Quality. NOTE: The format 

selected should be JSON.  

5. In the Your Information section, select the Messages checkbox only.  

6. Click the Create File button.  

7. The download request will be sent to Facebook.  

8. Check the Available copies tab.  
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9. After Facebook sends the Your Facebook information file is ready to download notification, then 

click the notification and click Download button.  

10. The download archive is what you will upload to VenioOne.  

3.5.5.2  Processing FB data  

Email(.eml) messages are generated in VenioOne based on the file splits selected in the Social Media 

Settings used in the Ingestion Settings step of the Project Setup Wizard in the Desktop Console. For example, in 

the screenshot below, each 500 messages generate 1.eml file. Whereas, if the entire conversation option is 

selected, there will only be a single.eml file generated.  

  
The back end uses the folder structure provided by Facebook, i.e. the archive file which is 

downloaded and ingested in VenioOne.  

NOTE: These settings are available only when the ingestion engine is set to the FALLBACK Ingestion 

engine, so check with your VenioOne administrator, if you do not see them.  

3.5.6  Twitter Data  

3.5.6.1  Exporting from Twitter  

Go to: https://help.twitter.com/en/managing-your-account/how-to-download-your-twitter-archive and 
follow the steps there.  It generally takes about one day from the request time to get the file. The file will 
include messages, tweets, and retweets. You will then upload the zip file you receive into VenioOne.  

3.5.6.2  Processing Twitter data  

Email(.eml) messages are generated in VenioOne based on the file splits selected in the Social Media 

Settings used in the Ingestion Settings step of the Project Setup Wizard in the Desktop Console. For example, in 

the screenshot below, each 500 messages generate 1.eml file. Whereas, if the entire conversation option is 

selected, there will only be a single.eml file generated.  

    

https://help.twitter.com/en/managing-your-account/how-to-download-your-twitter-archive
https://help.twitter.com/en/managing-your-account/how-to-download-your-twitter-archive
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The back end uses the folder structure provided by Twitter i.e., the archive file which is 

downloaded and ingested in VenioOne.  

NOTE: These settings are available only when the ingestion engine is set to the FALLBACK Ingestion 

engine, so check with your VenioOne administrator, if you do not see them.  

3.5.7  Microsoft Teams Data  

For a successful login into the MS Team chat, preconfigure a few basic settings:   

• For configuring Hosted URL: Hosted URL must have “https” otherwise the user may cannot see the 

login screen through which the user can upload MS Team Chat data. For the process to update URL, 

refer admin user change guide.  

• Create a new application in Microsoft Azure and then proceed with generating the application Id or 

client Id. This id needs to be updated in the Auth client id in the control setting. For the process to 

update URL refer to the admin user change guide.  

• For you to access MS Team chat, you must have an account for MS Team.  

  

Add new user in existing domain  

1. Open https://www.office.com/ and login with admin account  

2. Click on Admin on left panel, it opens new admin page.  

3. In User Management section, click on add user.  

    

https://www.office.com/
https://www.office.com/
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4. Enter the basic information.  

5. Assign product license to a user.  
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6. In Optional settings, select Admin Centre Access for admin account (Recommended) and choose 

User for normal account.  

  

Once user is created, the user can login to MS Team chat data upload.   

7. Login to VOD and click the MS Team Chat icon to upload MS Team Chat data.  

8. For project using Fallback ingestion engine, MS Team Chat data upload and processing options 

are available.  

 

9. Click on the icon, you are directed to MS Team Chat login on the fly. Upon successful login, list of 

the Team and channel is listed.  
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NOTE: Clear the cache if the Login page does not open.  
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10. Expand the Team by clicking the corresponding icon to the left. The channel of the team is 

displayed.  

  

11. Select the channel and click Add.  

  

12. It will be listed in the list for processing. Click Upload & Process.  

The file will is uploaded and processed in the provided project location.  

13. In review page, the MS Team Chat content is displayed as shown:  
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14. Help literals is displayed in the data upload which explains the media, custodian, and other basics 

for MS Team chat processing.  

15. The conversation of the data processed with MS Team chat is stored in the Team and Channel 

column. These columns are searchable/indexable.  

  

3.5.8 RSMF File (Relativity Short File Format)   
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On clicking  icon, you can upload rsmf format files only. If you upload other formats and start 

the process, only supported file format is processed. 

 

3.6  Processing AWS S3 Documents  

Media from the AWS S3 (Bucket/ Folder/ File) maybe loaded and processed by VenioOne:  

The Amazon S3 Bucket Browser dialog will open after selecting Add AWS S3 Data  

 

Before adding the AWS S3 Data, we can save the S3 Bucket Credentials from the AWS S3 

Storage page in System Admin as shown below:  

 

The AWS S3 Storage Hierarchy appears where you can select load and select the desired 

files:  
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After adding the values, you can Click on Create to create the AWS S3 Storage.  

You can also add ‘custodian’ name and ‘Media’ name. 

 

If incorrect values are added in the case admin, that will not expand in the upload page. For example: 
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3.7 Processing Structured Data 

As soon as structured data has been uploaded, you will receive an in-app notification and 

email indicating that the file is uploaded and ready to be processed. You must click the link in the 

notification/email to start processing the data.  

  
The Select Load File dialog displays.   
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1. Choose a template from the Load from template drop-down list for field mappings. The 

DefaultImportTemplate is selected by default.  

2. Change the Load File Path, Date Format, and the Time Zone as needed.  

3. Change the Image Load File Path as needed.  

4. Click the Next button to navigate to the Map File Path page.  

NOTE: In this step, you may preview the default template to review the field mapping 

information.  

 
5. Check the Load file has extracted text in field checkbox. You can now select files from Full-Text 

Mapping Field dropdown, if you select multiple files, the files are appended as per the order of 

the files selected. 
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For TIFF cases, Process section is not enabled when PDF images are uploaded as PDF is not supported, similarly, 

for PDF cases, tiff images are not supported. You can also import pdf images in opticon format. 

 

6. Click the Load File Preview button.  

The Load File Preview dialog displays with field details.  

  

7. Select the field type from the drop-down list on the right and view the preview on the left side of 

the dialog.   

8. Click the Close button when you’re done to return to the Map File Path page.  

9. In the Map File Path page, you may:  

• Toggle which items are processed - Full text, Native, or Image  

• Select/update the Mapping Fields (Full text, Native, or Image)  

• Update the Folder Paths (Full text, Native, or Image)  

• View the Number of Files (Full text, Native, or Image) in each folder at the bottom of the table.  

10. When the settings are complete, click the Validate Paths button to validate the mapping.   
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A message displays to confirm that the paths are valid. If the information is not accurate, it will display an error 

message. Click the Previous/Next buttons as required. 



© Venio Systems, Inc.   11.7.0.0  Page | 110  

  

11. Click the Close button.  

The Field Mapping page displays.  

   

12. In the Field Mapping page, you may:  

• Switch between the Load File Field and Venio Field  

• Filter and configure by Mapped /Unmapped/All fields using the drop-down.  
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• Use the search field to search for specific fields.  

  

• Click the Create custom field button to create custom field names. Enter the name(s) and click the 

Create button.  
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• Click the Save as Template button to save your settings as an Import Template to reuse these 

settings. Enter a Template Name and Description. Click the Save button to complete the process.  

  

13. Once all of the fields are mapped, click the Validate button.  

14. After validation is successful, click the Start Import button to start importing the data.  

The Import Progress dialog will update as the import progresses.  
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15. When the import status reaches 100%, click the Case Launchpad button to navigate to the imported 

case   

  

3.8  Tracking Upload and Processing Status  

  
The Upload Status section (on the left above) shows the status of the files being uploaded. The 

Processing Status section (on the right above) shows the media being processed. The status of each file 

being uploaded or processed is displayed as a progress bar.  

Click the Detail Status link (on the left above) to view processing details.  

• Dark blue represents files whose processing has completed  

• Light blue are the files being processed  

• Gray are the files whose processing has not yet started  

Click the View Job Status Detail link (on the right below) to view the details of the Ingestion, 

Indexing, Language Identification, Email Analysis, and TIFF jobs as a percentage.   
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When processing completed, the Notification button will update. Click the bell icon to review 

the new notifications. 

  
You can also see a list of notifications such as processing started, processing completed, case 

added, etc. with details and the time processing started. The details include:  

• Custodian name  

• Media added date  

• Total scanned file size  

• Total document count  

Clicking the Click here link (shown above) will take you to the:  

• Analyze page if documents are processed  

• Upload page with processing status if documents have started processing  

• Upload page if case is being added  

There is a chance that a file or data may not be successfully uploaded to a case. In such a scenario, the 

system will notify you via in-app notification, email about the failed upload, and will also prompt out the 

possible error of the unsuccessful upload. 

The failed email notification will consist of details such as Upload Filename, Projects, Custodian, Media, 

Client, Uploaded by, Size, Upload Started Timestamp, and Error Details. 

The different types of errors which you could face are: 
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• Export service not running 

• Database operation failure 

• I/O operation failure 

• Network failure 

• Insufficient storage 

3.9  View Project Settings Report  

The View Project Setting link on the Upload screen displays the Project Settings Report for the 

project.  

Note: The Project Settings Report is available only if permission has been granted from the 

VenioOne Desktop Console and within the VenioOne database, so if you do not see it, ask your admin to 

enable it.  

3.10 ActiveX Uploader  

In the Internet Explorer browser only, you may upload files using the ActiveX Uploader after 

installing the Venio Addons. With the ActiveX Uploader, you may upload files individually and are not 

restricted to uploading only container files. Before using the ActiveX Uploader, the VOD URL should be 

added as a Trusted Site in the Security tab under Internet Options. If not, the following message will be 

displayed:  

  
After installing ActiveX, the following screen is displayed.  
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3.11 Quick links  

Once ingestion is completed and there is data loaded into your project, you will have access to 

many functions in VenioOne. The more commonly used ones can be accessed through the Quick Links list in 

the left panel.  These are the functions that are commonly used after new data is added.  

 

 
 

3.11.1  Manual Email Analysis  
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Venio OnDemand allows you to carry out Email Analysis manually if the option was selected 

when creating the project. You can also run Manual Email Analysis if there is an error during ingestion to 

ensure the file is an eroded file.   

To manage manual email analysis, follow the steps given below.  

1. From the Side Menu click on Quick Link and select Manual Email Analysis from the dropdown.  

The Manual Email Analysis dialog will be displayed.  

  

2. Select the media that you wish to start the email analysis manually by selecting the corresponding 

checkbox in the row of the media.  

3. Click Start.  

The email analysis job will be created.  

Toast message, informing that manual email analysis jobs are queued successfully is displayed.  

  

4. Navigate to Project Job Status from Admin Setting >> Job >> Status page, select project and select the 

status.   

The Project Job Status page will be displayed.  
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3.11.2  Manual Language Identification  

VenioOnDemand allows you to carry out Language Identification manually if the option was 

selected when creating the project. You can also run Manual Language Identification if there is an error 

during ingestion to ensure the file is actually an eroded file.   

To manage manual language identification, follow the steps given below.  

1. From the Side Menu click on Quick Link and select Manual Language Identification from drop down 

menu  

The Manual Language Identification dialog will be displayed.  
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2. Select the media that you wish in the row of the media by selecting the checkbox.  

3. Click Start.  

The Language Identification Job will be created.  

Toast message, informing that manual language identification job will be queued successfully 

will be displayed.  

  

4. Navigate to Project Job Status from Admin Setting >> Job >> Status page, select project and select the 

status.   

The Project Job Status page will be displayed.  
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3.11.3  Manual Indexing  

Venio On demand allows you to re-index already indexed media or index only those files that 

were not indexed during ingestion.    

To manually index on a project level, follow the steps given below.  

1. From the Side Menu click on Quick Link and select Manual Indexing from the drop down  

The Indexing Status dialog will be displayed.  
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2. Select actions from the Default Action drop-down list. The available options are Resume and ReIndex.  

Note: To index specific Custodians you can select the loaded media and select Reindex from the 

dropdown menu  

  

5. Click Start.  

The message box asking the confirmation to start the manual indexing process will be displayed.  
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The progress of manual indexing can be viewed in the Status field.  

  

You can see that the indexing is in progress in the Status field.  

After reindex is completed, you can view the status as Complete in the Status field.  
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3.11.4  Compute Near Duplicate  

Under the quick links, there is an option to compute near duplicate option, which enables you 

to compute near duplicate files.   

  
To start computing near duplicate of a case:  

1. Navigate to the quick links and select Compute Near Duplicate. If Email Threading is not populated it 

will alert you compute Email Threading first.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 124  

  
2. After clicking on it will queue the Compute Inclusive Email job. The status of Compute Inclusive Email 

can be viewed in the job status as shown below:  

  

3. Upon successful completion, a message is displayed.  

  

4. By clicking on the Details option, you can view the Job Id, No. of documents, the requester for the 
near duplicate documents, Start Time, End Time, Total time spent and the status of the process.  
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3.11.5  Generate Missing Emails  

VenioOne can generate missing email threads, but email threading must be prepared before 

you may generate the missing emails.  

To generate missing emails, do the following:  

1. In the Quick Links pane, click the Generate Missing Emails. If the email threading is done, then the 

following message will be displayed.  
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2. Click the Start button to queue the documents to generate missing email threads.  

3. Check the Requeue documents checkbox to queue the documents which were already queued to 

generate missing email threads.  

4. You can view the details by clicking the Details drop-down.  

If the email threading is not prepared, the following message appears:  

  

3.11.6  Prepare Email Threading  

VenioOne can show email threads, but the database must be created before you can use the 

Email Analytics to view the threads. You will be able to see the frequency and quantity of communications 

between senders and recipients.   

To prepare email threading, follow the steps given below.  

1. In the Quick Links pane, click the Prepare Email Threading tab.  
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2. The Email Thread prompting to start preparing data for email threading is displayed. Click Start. A 

notification informing that the Email threading queued is displayed.  

  

3. Click Close.  

3.11.7 Populate Duplicate File Path  
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The main objective of Populate Duplicate file path is to populate the file path of the parent 

document and child files. Select Populate Duplicate File Path from the Quick Links:  

  
Duplicate File path is right-driven- "Allow to launch Near Duplicates". Click Populate Duplicate 

File Path from the Quick Links. Select source type By Media:  

  
Selecting to populate By Media, you can opt to choose populating only for selected media. With 

the By Tag option, only populating items with the chosen tag.   
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Select source type By Tag.:  

  

3.11.8 Compute Inclusive Email  

Computing inclusive emails helps to identify emails within Venio system such that those emails 

which are already fully contained inside other emails can be identified and potentially excluded from review 

as an additional option for creating review sets.  

  

Leaf Node:  

The last message of an email thread is the leaf node. In above example File1111 and File121 are 

the leaf nodes of an email thread.  

Inclusive:  
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An email message that includes all the content of the email thread is the Inclusive message.  A 

Leaf  

Node message is always inclusive.  In the above example, all contents for File1 are in File12 and 

File12 is in File121.  Since all the contents of File1 and File12 are in File121, File121 is the Inclusive message.   

Similarly, File1111 is an inclusive email message, if it contains all the contents in the email thread.  

Non Inclusive:  

Email messages that are not inclusive messages are Non-Inclusive. In the above example File1 

and File12, FIile11, and File111 are Non-Inclusive.  

Note: Before computing inclusive emails, ensure that you have completed the process of prepared email 

threading  

Compute Inclusive Email tab is available in the Quick Links pane.  

 

To Compute Inclusive Emails, follow the steps given below.  

1. Navigate to the quick links and select Compute Inclusive Email.   
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2. Click Start. Upon successful completion, a message is displayed.  

  

3. By clicking on the Details option, you can view the Job Id, No. of documents, the requester for the 
near duplicate documents, Start Time, End Time, Total time spent and the status of the process.  

  
3.11.9  Populate Custodian Dedupe  

VenioOne can populate a field that reflects a duplicate file.    
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Note: Make sure you have set the Custodian Priority correctly before using this feature.  

Populate Custodian Dedupe tab is available in the Quick Links pane.  

 

To populate custodian dedupe, follow the steps given below.  

1. Navigate to the quick links and select Populate Custodian Dedupe.   

 
2. Click Start. The Populate Custodian De-duplication will be completed and a message is displayed.  
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3. By clicking on the Details option, you can view the Job Id, No. of documents, the requester for the 
near duplicate documents, Start Time, End Time, Total time spent and the status of the process.  

 

3:12 Invite to Upload 

You can also send invitations to other users to allow them to upload files using the Invite to Upload option.  

1. Click the drop-down arrow on the Upload button and then click the Invite to Upload option as shown 

below.  

  
The Invite Users to Upload dialog displays.  
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2. Check to select internal users to be invited.  

3. If needed, check the Invite External users to upload link and enter the email address(es) of the external 

user(s) to be invited.  

NOTE: This feature must be enabled within your VenioOne database for this option to display. By default, 

external invites are not enabled.  

4. Enter instruction notes to the user in the Instruction field.  

5. The default Link Expired in time is 7 days. Change as needed.  

6. Click the Send Invitation button to send the invitation.  

  

   3.12.1 Structure Upload to external user 

  Once the invite to upload for an external user is sent, External user receives the email. When 

external user clicks on    the link from the email, the external users are routed to the upload page. 

 

The external user should be able to see the structure upload. After clicking on Structured, click 

on Repository from where you can select the folder. The external user should be able to upload the folder 

from the repository into the structure upload. 
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After the folder is uploaded, the csv Load File Path from the folder is automatically detected and opticon Image Load File Path is 
also automatically detected by the system. 

The external user gets an email about the import analysis completion and link to complete the import. 

External user can select the import template and perform the mapping of the paths and fields. 
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3.13 Accessing Cases and Media  

A panel on the upper right side of the screen can be expanded and used to view Custodians and 

Media in the case at any time. After expanding the Custodian/Media list, select the Custodian and Media and 

then use the green buttons to push that data to Analyze, Review, or Production.  

Custodians may be sorted in ascending or descending order using the adjacent button.  

 
The Search bar may be used to locate Custodians/Media. File Replacement   

3.14 Unprocessed File Replacement  

When a file cannot be processed, a notification is sent to the user. Files with issues affecting 

their processing can be replaced with another file using the Repair File page in VOD, which can only be 

accessed by using an in-app notification link or email link.  
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NOTE: Additional error handling options are available within the VenioOne Desktop Console, so 

you may need to contact your VenioOne Administrator, if replacing the problematic file with a repaired file is 

not an option.  

  
 In-Application Notification       Email Notification  

When you click the link in the email or in-app notification, the Repair File dialog will be displayed.  

  
You have two options for dealing with files that have not been processed:  

• Reprocess with a repaired file – Click the Browse button to select the repaired file from your local 

drive. Select file(s) and then click the Repair button to replace the file(s).  

• Do not repair  

NOTE: To use these options, the user must have permission given within the Desktop Console to 

use this feature.  

3.14.1  Unprocessed NSF  

As you process a protected NSF file you will receive a notification like as you process any other 

password protected file. In such case you might want to reprocess password protected NSF files. To 

reprocess password protected NSF files, follow the steps given below.  
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1. Navigate to Reprocess/Replace dialog from in-app notification that appears in bell icon on top right 

corner    

  

2. Click on the link containing status Processing Failed from the notification List. The bell icon notification is 

sent to the user. If one user creates a case and another user uploads the data in that case, the bell icon 

notification is sent to both the users. 

3. Upon Processing failure, you receive an email notification, and you can navigate to file repair UI from the 

link sent in the email as well.   

  

4. Select the option Reprocess with new user id and password from the Repair Method drop-down menu.  

  

5. Click Browse to load user id and enter password in password field.  

6. Click Repair.  
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NOTE: Admin can view the processing status from Job UI in Admin setting. Navigate to Project Job Status 
> Replacement /Reprocessing.  

When you load a NSF file, the system will automatically decrypt the password provided and apply to the NSF 
file while uploading. If there are other passwords added in Admin Settings → Case Admin →Password 

Bank→Password List for the same NSF file, those passwords will also be considered by the system. 

3.15 Upload History  

Navigate to Upload History using: Upload Page>Open Panel>Upload File(s) History.  

  

  

3.16 Media Job Overview  

Under the Action column of the listed Media Name(s) click on the eye icon (Media Job 

Overview) to view the Processing and Post Processing Status.  
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Note: The jobs can be further drilled down by expanding the respective jobs.  
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4 Intro to Entity Extraction and Entity Fields  
 

Entity extraction, also known as entity identification, entity chunking, and named entity 

recognition (NER), is the act of locating and classifying mentions of an entity in a piece of text. This is done 

using a system of predefined categories, which may include anything from people or organizations to dates, 

times, and monetary values.  

The entity extraction process adds structure and additional metadata information to previously 

unstructured text. It allows machine-learning algorithms, such as VAR/CAL, to identify mentions of certain 

entities within text alongside the other metadata for the files.  

Entity Fields are used by the entity extraction process to identify patterns and personal 

information that people normally do not share with other people, such as Social Security number, personal 

ID provided by an employer or government agency, birth date, etc. The identified PII is then extracted to an 

Entity Field (or fields) and grouped together, so it can be used to easily analyze, search, redact, and filter for 

review.  
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The extracted entity data can be output in a single field with a separator for multiple pieces of 

different types of data e.g., Name/Title or Date/ Time, or divided into individual fields for each piece of data 

e.g., Name, Title, Date, Time.  

4.1  Working with Entity Fields  

The list of default Entity Fields added in VenioOne projects is listed in Section 4.3 below  

Admin users may add custom entity fields in the same way other Custom Fields are created. 

Users can view and create a report of the PII information being extracted and the total document counts. 

The entity field data can also be used for easily tagging or foldering documents as required.  

Additional Entity Field functionality will be added in future releases of the VenioOne platform.  

4.2  Entity Extraction Process  

When uploading documents from VenioOne OnDemand, one of the Advanced Options will 

automatically queue the files for entity extraction using VenioOne’s built-in Entity Fields or Custom Entity 

Fields in the project. If this process is not run during ingestion, it can be run from the Other Options within 

the Document List in the Review Dashboard of VenioOne OnDemand.  

4.3  List of VenioOne’s Default Entity Fields  

The following entity fields are created within VenioOne projects by default to be used with the 

entity extraction process:  

Entity_Person  Entity_SSN  



© Venio Systems, Inc.   11.7.0.0  Page | 143  

Has_Entity_Person      

Entity_Location      

Has_Entity_Location      

Entity_Organization  

Has_Entity_Organization      

Entity_Date  

Has_Entity_Date      

Entity_Time  

Has_Entity_Time      

Entity_Money  

Has_Entity_Money      

Entity_Percentage  

Has_Entity_Percentage  

Entity_Debit_Credit_Card_Number  

Entity_EIN  

Entity_ITIN  

Entity_Phone_Number  

Entity_US_Passport_Number  

Has_Entity_SSN  

Has_Entity_Debit_Credit_Card_Number  

Has_Entity_EIN  

Has_Entity_ITIN  

Has_Entity_Phone_Number  

Has_Entity_US_Passport_Number  

  

5 Analyze  
 

The Analyze Dashboard provides information about the data in your project/case including 

document counts, file types, metadata, and other information. The page is made up of interactive widgets 

that may be used to review the data that has been uploaded, create searches, or do culling or tagging. 

Additionally, the layout may be customized, and multiple layouts may be saved for use across projects.  
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5.1  Analyze Dashboard Options  

Buttons at the upper right of the Analyze Dashboard may be used to:  

Tag and Untag items selected within the widgets  

  

Add a Widget to the Analyze Dashboard   

Send data to the Review Dashboard or Production  

  

After selecting data within the widgets, Apply Inclusive or Exclusive Filters  

   

5.1.1  Send to Review  

At any time, you may send documents for review. Click the Send to Review button ( ) on the 

control bar to send all the documents for review. Refer to section below for more information on the Review 

module.  

5.1.2  Send to Production  
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At any time, you may also send documents for production. Click the Send to Production button (

) on the control bar to send all the documents for production. For more information on the 

production/export process, refer to section below, which covers the Production module.  

5.1.3  Save and Load Analyze Layouts  

You may save different layouts of Widgets within the Analyze Dashboard. For example, you may 

wish to save an Email Analysis Layout with tools for analyzing emails. Simply arrange the widgets to your 

liking and then use the Save Analyze Layout button (shown below).  

Load Analyze Layout / Save Analyze Layout  
   

When saving a layout, you will be asked to name it. To load a saved layout, click the Load 

Analyze Layout button, pick your layout from the drop-down list, and click the Load button.  

  
While loading the layout, set and save the current layout as default layout. But when you 

navigate away from the analyze page or logout and come back again, the last selected layout is loaded. Even 

when the screen is refreshed and reloaded, the same layout is loaded. You will not be able to modify/update 

the default layout. You can only modify the current layout(except default layout).  

5.1.4  Search Duplicate Option 

Search duplicate options filter search results according to the selected duplicate option. It is 

chosen before you execute a search. For more information, please refer Section 8.5  Search Duplicate 

Options  
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5.2  Widgets  

5.2.1  Using Widgets  

IMPORTANT: Updating one widget updates the entire Analyze Dashboard.  

• Resize a widget by clicking and dragging the edges.  

• Maximize a widget using the Maximize button ( ) in the upper right corner of the widget.  

• Widgets with the Edit option button ( ) in the top right corner may be set to show the Top 10, 20, 

50 or 100 items or All items, and displayed in a Bar, Pie, or Table view.  

• Within widgets, items may be selected to filter the scope of the entire Analyze Dashboard.  

After selecting an item within the widget, use the inclusive and exclusive filter buttons (

) in the upper right corner to filter the data.  

• Use the Export button ( ) to save the information contained within the widget. Depending on the 

widget, you will have options to either save it as either an image or Excel/CSV file.  

• Remove a widget by clicking the Close button ( ).  

5.2.2  Add/Remove Widgets  

1. Click the Add Widget button ( ) to add a new widget to the Analyze Dashboard.  

The Add Widget dialog displays. The Add Widget dialog lists various common widgets, such as the Timeline, 

Processing Summary, Summary, Social Network, FileType, E-mail Attachments, EDOC, Tag, and Exception Files.  

2. Click to select the widget you want to add and its options.  

The widget will be added to the dashboard. If the selected widget is already displayed, a message displays 

indicating the widget is already in the dashboard.  
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3. To add additional widgets that are not listed, click the Add More Widgets button.  

4. Choose the Chart Type, View Type, and the Field to add a corresponding widget.  

  
To remove a widget, simply click the Delete button ( ) to remove it from the dashboard.  

5.  To add additional widgets that are not listed, click the Add More Widgets button. 
Type in the Fieldname, matching field names will be searched and listed.  
Choose the Field, Chart Type, and View Type to add a corresponding widget.
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5.2.3  TimeLine Widget  

The Timeline widget shows the number of documents per Year, Month, Week, or Day.  

  
The filters in the top right allow you to set the date range. The date range is set using the drop-

down calendar in the Start Range and End Range fields.  

  

5.2.4  Breadcrumb Funnel Widget  

The Breadcrumb Funnel widget shows the total document count.  
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5.2.5  Summary and Processing Summary Widgets  

The Summary and Processing Summary widgets give you the breakdown of processed files, 

duplicate files, and exception files.  

  

5.2.6  File Type Widget  

The File Type widget shows the document counts for each file type. This will give you an idea of 

what kinds of files exist within your data.  

  

5.2.7  Exception Files Widget  

During processing, if there are files that can neither be accessed nor processed, they will be 

shown in the Exception Files widget with the file size and count listed.  

  
5.2.8  EDOC Widget  

    

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 150  

The EDOC widget shows the statistics related to documents only. You will also be able to see the 

number of duplicates, if they exist, within the project.   

  

5.2.9  Tag Widget  

The Tag widget shows the document counts for the top 10, 20, 50, or 100 tags in your project.  

Use the Edit option button ( ) to change the number of items displayed.  

  

5.3  Analyze Dashboard Searching  

At the top of the Analyze Dashboard is a search bar.   

  
The following options are available (from left to right):  

Custodian/Media Selection  Displays a list of Media and Custodians from which you may select  

Search Field  Enter your search terms in this field  

Clear Search Input  Clicking this button will clear the Search Field  

Include Family checkbox  Determines whether family documents will be included in the results  

Execute Search  Clicking this button will execute your search  

Document Count  Displays the number of documents within the search results  

  

5.3.1  Multiple Term Searches  
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You can do single term or multiple term searches in VOD. For multiple term searches, type the 

term(s) on separate lines in the search field. When you click the Search button ( ), the search results are 

updated within the Analyze Dashboard.  

Also, an interactive breadcrumb trail is added below the Search field and the results of the 

search are displayed in a Multi Search Term Status widget as shown below.  

To filter the display, select the search term checkbox(es) and click the 

Inclusive 

Filter button ( ) to apply filtering changes within the widgets of the Analyze Dashboard  

  

5.3.2  Search Term Hit Report  

Click the Report button ( ) at the top right corner of the Multi Search Term Status widget to 

view the Search Term Hit Count Report (shown below).  
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5.4  Filtering  

You can apply Inclusive or Exclusive Filters in a single widget or multiple widgets.  

5.4.1  Filtering a Single Widget  

To filter a single widget, use the Inclusive/Exclusive Filter buttons in the top right corner of the 

widget.  

1. Click to select the item(s) within the widget that you wish to filter.  

2. Either click the Inclusive Filter button ( ) for inclusive filtering or the Exclusive Filter button ( ) to 

apply an exclusive filter.  

     

 With content selected for filtering  After filtering is applied  

   The filter is applied. The breadcrumb list is updated and the widgets within the Analyze Dashboard are 

immediately updated.  

5.4.2  Filtering Multiple Widgets  

To filter multiple widgets at one time, select the items within the widgets and then use the 

Inclusive Filter ( ) and Exclusive Filter ( ) buttons on the control bar at the top of the Analyze Dashboard.  

Inclusive Filter  

Use the Inclusive Filter button ( ) for inclusive filtering. For example, select the Microsoft 

Word bar from the FILE TYPE widget and Attachment from the EMAIL/ATTACHMENTS widget. Then, apply 

the inclusive filter using the Inclusive Filter button.  

  
When hovering over the breadcrumb list, both filters are displayed.  

Exclusive Filter  
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Use the Exclusive Filter  button for exclusive filtering. For example, select the Microsoft Word 

bar from the FILE TYPE widget and Attachment from the E-MAIL/ATTACHMENTS widget. Then, apply the 

exclusive filter using the Exclusive Filter button.  

  
When hovering over the breadcrumb list, both NOT filters are displayed.  

6 Tagging  
 

Tagging may be done from either the Analyze Dashboard or the Review Dashboard of VOD. 

Tagging may be administered from those locations or the Case Admin Settings if you have rights to do so. 

6.1  Bulk Tag/Untag  

Bulk tagging is done from the Analyze Dashboard. 

 

1. Click the Bulk Tag button ( ) on the control bar of the Analyze Dashboard. 

The Tag Documents dialog will display a list of tags.  

  

2. Select tag(s) to apply to all the documents.  

3. Scroll to the bottom of the Tag Documents dialog and click the Tag button.  
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NOTE: Use the Bulk Untag button ( ) in the same way to untag all of the documents.  

6.1.1  Hide System Tags for User  

You can show/hide tag/s to be displayed in the Tag Panel. Click on  icon to open the pop up 

to select the tags to be displayed in the Tag Panel.  

6.2  New Tag  

6.2.1  Create New Tag from Analyze Dashboard  

1. Click the Bulk Tag button on the Control bar of the Analyze Dashboard.  

The Tag Documents dialog displays.  

2. Scroll to the bottom of the dialog and click the Create Tag button.  

The Create New Tag dialog displays.  

  

3. Enter a Name for the tag.  

4. Select the Tag Group using the drop-down list or click the Manage Tag Group link to create one.  

5. Select the parent tag from the Parent Tag drop-down list.  

NOTE: If the tag being created is a top level tag, then the Parent Tag drop-down will be 

left to display Select Parent Tag.  

6. Enter a Description if you would like to have one.  

7. Select a Color for the tag.  

8. To secure the tag for specific groups, click the Advanced Options link.  

9. Click the Create button.  
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6.2.2  Create New Tag from the Review Dashboard  

Click the New Tag button in the Tags panel of the Review Dashboard.  

The Create New Tag dialog displays.  

  

Enter a Name for the tag.  

Select the Tag Group using the drop-down list or click the Manage Tag Group link to create one.  

Select the parent tag from the Parent Tag drop-down list.  

NOTE: If the tag being created is a top level tag, then the Parent Tag drop-down will be left to display 

Select Parent Tag.  

Enter a Description if you would like to have one.  

Select a Color for the tag.  

To secure the tag for specific groups, click the Advanced Options link.  

Click the Create button.  

When documents are tagged or Untagged then the “Tagged Document Summary” pop up should be shown with 

all the details of Propagation. 
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When clicked on “Show Detail Count” all the propagation counts should be displayed as below: 

“Propagate to duplicates #, Email Thread Propagation #, PC Propagation #, NDD Propagation #” 

Also the Applied tag rules and the Current Search results Options should be displayed as below: 

“Applied Tag Rules”: 

1. Do not propagate tags to duplicates 

2. Do not propagate tags to parent/child. 

3. Do not propagate tags to emails of the email thread 

4. Do no propagate to near duplicates 

“Current Search Results Options”: 

1. Exclude parent/child 

2. Show only one instance in the selected scope (DynamicDeDupe™) 
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6.3  Create a Tag Group  

You can create two types of Tag Groups: Non-Exclusive and Exclusive. In a Non-Exclusive tag 

group, multiple tags from the same tag group can be applied to the same file - for example, a list of issue 

tags. However, in an Exclusive tag group, only one of the tags in the tag group can be applied to a file - for 

example, Responsive or Non-Responsive tags.  

1. From within the Create New Tag dialog, click the Manage Tag Group link.  

The Tag Group dialog displays.  
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2. In the Tag Group dialog, enter a Name for the tag group.  

3. Check the Apply exclusive tag check box if you intend to create an exclusive tag group.  

4. Click the Add button.  

5. Close the dialog(s).  

6.4  Tag Propagation  

If you have rights to do so, you may set additional tagging options for Tag Propagation within 

the Case Admin settings.  

1. Click the drop-down arrow next to your name in the upper right corner and select Admin Settings.  

2. Click the Case Admin link to expand the Case Admin settings.  

3. Click the Tag link to expand the Tag settings.  

4. Click the Propagation Settings link to display the propagation options.  

The Tag Propagation Settings are shown.  

5. Set the Tag Propagation Settings using the radio buttons and check boxes.  

NOTE: Details on the options are in the sections below.  

6. Click the Save button to save your settings.  
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“Advanced Tag Settings” tab added in the “Tag Configuration” pop up it should be same as in Admin “ 
Propagation Settings”  

  

6.4.1  Duplicate Tagging Options  

Select one of the three options for how to handle duplicate tagging. The options are:  

• Propagate tags to all duplicates in the case: Tag all duplicate documents within the case.  

• Propagate tags to all duplicates in the selected scope: Tag duplicate documents within the selected 

scope.  

• Do not propagate tags to duplicates: Do not tag duplicate documents.  
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6.4.2 Parent/Child Set Tagging Options  

Choose whether to propagate tags within families of documents. Checking Propagate tags to 

parent/child in the case will tag both parent and child documents.  

6.4.3 Email Thread Tagging Options  

Choose whether to propagate tags within email threads. Checking Propagate tags to all emails 

of email thread in the case will tag all emails within a thread.  

6.4.4 Near Duplicate Tagging Options  

Choose how to propagate tags to near duplicate documents. The options are:  

• Propagate tags to near duplicate group in whole case: Tag all near duplicate documents within the 

case.  

• Propagate tags to near duplicate group in the selected scope: Tag near duplicate documents within 

the selected scope.  

• Do not propagate tags to near duplicate groups: Do not tag near duplicate documents.  

7 Review Dashboard  
 

The Review Dashboard is where search results or documents to be reviewed are displayed. It is 

divided into three sections containing various panels, as well as a Search Bar at the top of the screen and a 

pop-up panel on the right side of the screen that displays Saved Searches, the Search History, and Dynamic 

Folders.   

• Each panel can be resized or dragged to move the panel.  

• Column displays and sort order may be adjusted within some of the panels.  

• Use the Open in New Window button ( ) to place a panel in another window that can be moved to 

another monitor for ease of reviewing documents. Use the Pop In button ( ) to move the panel 

back into the Review Dashboard.  

• After adjusting the display, you may wish to save the layout. You may save multiple Review 

Dashboard layouts according to your needs.  
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NOTE: In the Review Dashboard for TOA projects, only the Text View will be available. As shown 

below, the other view tabs will be grayed out. Also, some options on the Search Bar, such as Send to Analyze 

and Send to Production will be grayed out as well.  

  

7.1  Restricted Access  

A project administrator may restrict your access to certain Custodian(s)/Media or Folders within 

the case. If so, you will not see files related to those items within VOD. Additionally, you will see one of the 

following pop-up dialogs when accessing the Review Dashboard. To keep from seeing it every time, the Do 

not display in future checkbox can be selected.  

7.1.1  Restricted Access by Folder  

If you are restricted from viewing certain Folders within the case, you will see the following 

dialog when accessing the Review Dashboard. To keep from seeing it every time, the Do not display in future 

checkbox can be selected.  
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7.1.2  Restricted Access by Custodian(s)/Media  

If you are restricted from viewing certain Custodian(s)/Media  within the case, you will see the 

following dialog when accessing the Review Dashboard. To keep from seeing it every time, the Do not 

display in future checkbox can be selected.  

When the Media is expanded all the documents related to that Custodian should be displayed as below: 

 

When the Custodian is expanded, only that particular Custodian should be expanded as below: 
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7.2  Search Bar  

  
There is a Search Bar displayed at the top of the Review Dashboard. The Search field shows the 

query for which the results are displayed (fileid>0 means all files in the case). Enter either individual search 

terms or complex search conditions using multiple lines.  

• After adding your search terms, click the Search  button to run the search.  

• Clear the contents of the search by clicking the Clear button ( ).  

• Use the Include Family check box to include parent/child documents in the search results.  

• For details about proper search syntax, click the Other Options button ( ) at the right end of the 

Search Bar and select Search Query Help.  
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As shown above, you may run combined term, field, and other types of searches using the 

Advanced Query Builder, which is accessed by clicking into the search field on the Search Bar. For detailed 

information on searching, refer to Section 8 below   

7.2.1  Search Bar Options  

At the far right end of the Search Bar are navigation buttons and several option buttons.  

  

• Send to Analyze – Sends documents to the Analyze Dashboard  

• Share Documents – Displays Document Share dialog to send a secure link to the documents to either 

external or internal parties  

• Send to Production – Sends documents to the Produce Dashboard  

• More Options – Displays other available options described in the sections below  

NOTE: For TOA cases, some options may be grayed out, because they are unavailable.  

7.2.2  Send to Analyze  

On the Search bar, click the Send to Analyze button to send the search results for analysis within 

the Analyze Dashboard.  

7.2.3  Share Documents  

VOD allows you to share documents with internal or external parties. You may control the level 

of access they have and set an expiration date for the shared link. For security purposes, all activities are 

tracked in the VenioOne database.  

1. In the Document Table, select the documents you wish to share.  

2. On the Search Bar, click the Share Documents button.  
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3. Enter the Share Name and Link Expired in (Days) duration.   

4. In the Internal Users section, select the internal recipients with whom you want to share.   

5. For external sharing, select the Share to External User check box and then choose or add the email 

addresses of the external recipients.  

NOTE: External sharing will only be available, if enabled in your VenioOne database.  

6. In the Permission for external users section, select the checkbox to provide any of the following 

permissions to user:   

• Allow tagging/untagging  

• Allow to create document notes visible to all users  

• View Analyze Page  

• Allow Redaction   

7. If you wish to enter any instructions or notes to be shared when sharing documents, enter them in the 

Instruction section. You can also format the text using the formatting options available.   

8. Choose either Full Rights or Read Only for the permission level.  

NOTE: Admin and Expert level users will always have Read/Write permissions.  

9. Check the option to Allow to add document notes if the recipients should be allowed to add document 

notes.  

    

The Document Share dialog displays.   

  



© Venio Systems, Inc.   11.7.0.0  Page | 166  

10. Click the Send Invitation button to complete the process.  

Parties will receive an email with a link to access the documents shared with them.  

7.2.4 Send to Production  

On the Search bar, click the Send to Production button to send the search results for 

production. The Create Production dialog will open for you to create a new production for the selected 

documents. For more details, please refer to Section 9 below, which covers the Production module.  

7.2.5 More Options  

At the end of the Search Bar is a More Options button which opens a large menu of options 

when viewing search results (shown below left). When viewing a Review Set, the options are more limited 

(shown below right).  
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NOTE: For TOA projects, some of the Other Options will 

not be displayed in the Review Dashboard as they are not available in 

TOA projects.  

Below is a summary of the items on the More Options menu. Additional details are in the 

sections below.  

Mark as Reviewed  Marks the selected file(s) as Reviewed. All files must be marked as reviewed in 

order to check in a batch.  

Load Layout  Displays the Load Layout dialog for you to switch to a different layout  

Create/Edit Layout  Displays the Save Layout dialog for you to create or update a layout  

Save Search  Displays the Save Search dialog for you to name and save the search. Saved 

searches, as well as the Search History, are accessible in the hidden side panel on 

the right side of the Review Dashboard.  

Save as Dynamic Folder  Displays the Dynamic Folder dialog for you to name and save the Dynamic  

Folder. Advanced Options allow control over which groups may access the Dynamic 
Folder. Dynamic Folders are accessible in the hidden side panel on the right side of 
the Review Dashboard.  

  

Auto Folder When you search for a term in the Review page's search bar and auto folder the 

searched term, the results will only auto folder the documents that match the 

search term. For more information on Auto Folder, please refer section 12.16.3 

Auto Folder of VenioOne OnDemand Admin Guide. 

Switch to Email Thread 

View  

Switches the Normal View to Email Thread View.  

Send to Folder  Opens the Folders dialog to add selected files to a folder.  
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Remove from Folder  Opens the Folders dialog to remove selected files from a folder.  

Send Image/PDF Image 

Files to OCR  

Sends selected files to have text extracted by the OCR engine.  

Send Generated Images 

to OCR  

Sends selected files to have text extracted by the OCR engine.  

Send Redacted Images 

to OCR  

Sends selected files to have text extracted by the OCR engine.  

Print Documents  Opens the Print dialog for you to send the selected documents to print. Images in 

the exports that could be printed from the console are also available.  

 

  
Print Status  Displays the Print Job Status dialog  

Slipsheet Documents  Displays the Create Slipsheet dialog. For more information, refer to Section  

7.2.8.17 below  

Queue Entity Extraction  Queues entity extraction from the VOD search grid  

7.2.6 Overlay Custom Fields  

To navigate, click on the 3 vertical dots in the top right corner of the Document Table and click 

on Overlay Custom Fields.  
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7.2.6.1  By Coding Value  

Select Field from the drop-down list all the custom fields created from the custom fields should 

be listed.   

The value entered in ‘Specify Value’ will replace the value of the fields selected. The changed 

value will only be displayed in new search result.  

  

Following cases should be implied when overlaying custom fields by coding value   

● Select Field: The drop-down should list all the custom field to code and Specify value will overwrite 

the value of selected field in search result, which will be reflected in new search. If the selected field 

is   

● Integer custom field: It allows user to type and validate for integer value while starting the coding  
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● Datetime custom field:  Date picker should be displayed in Specify Value option, specifying sequential 

value should be disabled when date time is selected.  

● Numeric field: Prefix and Padding should be disabled.  

● Coding field with configuration to allow only predefined value: It should allow user to choose the 

predefined values.   

● Coding field with configuration to multiple value: Specifying multiple values should be allowed with 

delimiter defined and user specify to append the field value, the predefined delimiter should be 

selected and drop-down should be disabled to restrict delimiter change. It should select correct 

delimiter and be disabled.  

● Append/Replace: It should work correctly for incremental coding.  

7.2.6.2  By Merge Field Value  

A field overlay enables you to modify the field's database properties.  

1. Select Field from the drop-down list all the custom fields created from the custom fields should be 

listed.  

2. Choose any Delimiter from the drop-down list.  

3. Select the source fields from the Available Source Fields. The selected fields are displayed in the 

Selected Source Fields.   

  
4. Click Apply. A success message appears:  
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7.2.6.3  By Find and Replace  

1. In the Overlay Custom Fields, select By Find and Replace.   

2. Select the required custom field, enter the text to be replaced in the Find text box and text to 

replace it with in the Replace text box.  

  
3. Click Apply. The old value of the selected field is overlaid by the new value  

7.2.6.4  By Field Value in Priority Order  

1. In the Overlay Custom Fields, select By Field Value in Priority Order.  

2. Select the required custom field. Select the Available Source Field required and drag it to 

Selected Source Field.   

3. Click Apply.  

4. The value of selected field is overlaid by the value of Selected Source Field according to the 

priority of the fields. If the field with higher priority doesn't have any value, then the value of 

the next field is selected.  
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7.2.6.5  By Field Value  

Right-click the search results and choose Overlay Custom Fields.  Depending on the 

requirement, choose either Selected, Unselected or All from the sub menu to copy field values to a custom 

field.  

In the Overlay Custom Fields dialog, the left side has Venio fields and custom fields that are 

used as "source fields." The right side has custom fields used as "destination fields".  The objective of this 

function is to copy field values of "source fields" to "destination fields".  
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Move to the field of your choice from source field list and map it to the required destination 

field.  

  

Click Apply once you have completed mapping the fields.  

If there are any problems or mismatch in mapping fields, a warning window is shown. Please 

follow the instructions as indicated in the warning window.  
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7.2.7  Responsive PST Creation  

Before creating a responsive PST, ensure that Outlook is installed in machine where export 

service is installed.  

Select the document(s) from the review page and from the menu, user can select Create 

Responsive PST/View status  

  
The selected documents are queued for creating the responsive pst, the list of documents are 

shown in the UI, when user selects create the responsive pst is created, the status can be shown in the Pst 

status tab.  
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Once the responsive pst is created, the user have options to download the pst, view the logs 

and delete the responsive pst form the Action column in the above UI.  

7.2.8  Folder Panel  

If there is any document present within a folder, the corresponding folder contains a check 

mark in the Folder Panel in the left. Also, if there is a sub-folder present in a folder in the Folder panel, the 

complete tree structure is visible for the folder. If the folder does not contain any folder/document, there is 

no checkmark for the Folder in the panel.   

    



© Venio Systems, Inc.   11.7.0.0  Page | 176  

  

7.2.8.1  Saving and Using Layouts  

If you have customized your screen layout, you may wish to save it. You can save and load 

multiple screen layouts for use across your matters. When a user creates/edits layout from a review page, 

that layout is listed while editing the user information associated with the layout from the user 

management.  

1. On the Search Bar, click the More Options > Create/Edit Layout option  

The Save Layout dialog displays  

         

2. To save the layout, select the New Layout radio button.  

3. Enter the Layout Name  

4. Click the Save button to save the new layout   
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NOTE: To update the layout (other than DefaultReviewLayout and Layouts associated with a 

client that are non-editable), load the layout to be updated as the current layout first, then go to create/Edit 

Layout, select the Update Layout radio button and click the Save button.  

   
To switch layouts, click the More Options > Load Layout button. Select the Layout from the 

dropdown menu and click the Load button.  

When an admin/internal user is editing the user information from system admin, all the layout 

created/edited from review (or) layout created from layout management associated to the user must be 

listed.  

 

7.2.8.2  Set the created/edited layout as default  

When a user loads the layout or create/update the layout from the review page, that layout 

should be made the default layout for the user. The layout should be the current layout in the review page 

i.e., when a user is logging out and logging in, then set that layout in load layout option. All the settings from 

the layout should be reflected/loaded in the review page.  

User can reorder the fields, close the layout panels, sort the fields, check/uncheck the fields to 

display in table panel. Save the layout.  
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The Review page must load with the current layout and same must reflect in load layout option 

with all the settings done by user.  
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Default Layout  

While editing the layouts, the Default layouts cannot be edited. If the layout being updated is a 

default layout, the editing is restricted and the Save button is disabled and the following message is 

displayed:  

  
Client Layout  

Also, you cannot edit the Client layouts. If the layout being updated is a client layout, the editing 

is restricted and the Save button is disabled and the following message is displayed:  
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7.2.8.3  Preserve selected fields and order  

Change field order and by clicking on next pages fields should be preserved and the fields 

shown/hide are preserved as well.  

Select a layout and reorder the fields.   

 

After reordering the fields try navigating to different pages, the order of the fields changed by 

the user should be preserved.  
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7.2.8.4  Change Priority  

The Change Priority option in the custodian management page when clicked provides you an 

option to move the move the custodians up/down to set/save the priority.   

Navigate to Administration > Case Admin > Custodian > Manage. Click on Change Priority.   

  
Once the priority deduplication is changed, the files based on changed custodian priority and 

media summary will be changed. Also, the exact same changes will be replicated in the console and vice 

versa. When the media is being processed, a message is displayed mentioning the restriction in saving the 

priority of the media.  

7.2.8.5  Save Search items to Custom Fields  

VenioOne gives you the ability to save a search with a search name so that the search 

can be shared with another user.  You also can start a new search after the search has been 

executed.   

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 182  

Save search terms in a custom field updates custom fields with responsive search terms.  

The search name is used as custom field name.  

  

To save a search result:  

1. Click on the Save Search button.  

2. Provide the Search Name and click the Save search terms in a custom field checkbox. Also select 

Create a new custom field radio button.   

  

3. Click Save. A message confirming the search saved successfully appears.  

  

4. Now go to the Search History to see the results saved with the Search Name provided. It will be listed 

on the top of the grid.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 183  

  

7.2.8.6  Tag search terms during saved search  

To tag search items during a saved search:  

1. Click on the Save Search button.  

2. Provide the Search Name and click the Create and apply tags using search terms as tag name 

checkbox.   
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3. Click Save. A message confirming the search was saved successfully appears.  

   

4. You can Save search by applying tags using search terms as tag name and click on Use existing tag 

structure from search. Select from the available drop-down list and click Save.  

5. You can manage the tags from the Tag Management (Administration > Case Admin > Tag > Manage) 

page.   
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7.2.8.7  Save Search items to Existing Custom Fields  

To save a search result to an existing custom field:  

1. Click on the Save Search button.  

2. Provide the Search Name and click the Save search terms in a custom field checkbox. Also select Use 

existing custom field radio button. Select from the available drop-down.  

  

3. Click Save. A message confirming the search saved successfully appears.  

All the search documents will be appended with the new custom field.  

7.2.8.8  Accessing Saved Searches  

Expand the side panel on the right of the Review Dashboard to access the Saved Search tab. 

Click the magnifying glass Search button adjacent to the search to rerun it.   

Added delete option in search history and in saved search grid. Delete the record/search from search log history and 

it will be removed from the table.  
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Similarly, deleting search from search saved by tag or custom field from saved search tab should be deleting the 

associated auto tags from tag panel. And custom field search should delete search and field form the project.  

 

 

7.2.8.9  Hide Custom Fields  

When the admin layout is loaded (may it be default to the user or user load the layout from 

review)in the review page, by default hide all the custom fields. However, the permitted custom fields are 

available in the show/hide columns list for users to select and display the desired custom field in the grid.  

Note: User group must be selected before moving fields  

1. Create a layout from admin settings  

  

2. Load the layout in the review page. Click on show/hide option from document table, permitted 

custom fields should be available.  
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7.2.8.10  Custom field handling in layout  

If none of the custom fields are selected in the document table and save the layout, it 

saves all the permitted custom fields in the layout and when you next load the layout, it displays all 

the custom fields unnecessarily.  

Currently, if none of the custom fields are selected, the custom fields do not get saved in 

layout. Also, while loading the layout, and if the layout is created from review, only the configured 

custom field/s in the layout are listed.  

  

7.2.8.11  Search Log History  

To view all past searches, expand the side panel on the right of the Review Dashboard and click 

the Search Log History tab. Click the adjacent magnifying glass Search button to rerun a search.  
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You will have an option to either run the search in the same scope as the original search or the 

current scope. Make your selection and then click the OK button.  

  

The filter searches that are performed from tally, save search and analyze, such searches are able to save in 

the review page under search log history.  

Performing tally search will be logged in search log history. Also, tally search can be combined and search 

with other search will also be saved in search log history. Performing search or filtering in analyze and 

sending to review will be logged in search history. Saving the same filtered search in review will be captured 

under saved search history. The search executing from history will appear in the search field and the search 

count will be cumulative in the search log history. 

 

7.2.8.12  Email Thread View  
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You can view email message threads only in Email Thread View.  

Different types of email files are denoted by different color icons.   

You can view email message threads only in Email Thread View.  Generated emails are missing emails 

within a thread that the system creates which are extrapolated from the email bodies of valid emails in 

the thread. These are only visible in the email threading view and are display only. Missing and 

generated emails are same but for the generated ones, Venio is able to rebuild the missing email and 

populate limited metadata. So, a generated email is a missing email that it is able to generate from the 

body of other emails in the thread. Whereas, Missing emails cannot be generated due to lack of 

something needed to generate a view of it. For more information, click here. 

Different types of email files are denoted by different color icons.   

• Inclusive Email – Green Message icon( ) 

• Email Document – Gray Message icon( ) 

• Generated Email – Yellow Message Icon( ) 

• Missing Email – Red Message Icon ( ) 

 

7.2.8.13  Send to Image  

Documents can be sent to Image from search results. After running a search, select the 

document(s) and then click Other Options (right end of the Search Bar). Select Send to Image from the 

menu.  

A summary of the items for Send to Image is displayed. Page Limit, Engine and Color Conversion 

can be selected as desired in the Document Detail table. Advanced Options include items related to the 

Bates Numbering and page limit. You can select the resolution and DPI settings. The Details section can be 

expanded to view previous image queue details. At the bottom left are check boxes to Launch and Relaunch. 

Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Start button to start the 

imaging process.  

https://support.veniosystems.com/hc/en-us/articles/26111824478995-Generated-and-Misssing-Emails
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The Tiff and Tiff Pre- QC jobs will be queued and can be monitored from System Admin > Job > 

Status (shown below) or from the Details section in the same Send to Image dialog.  
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7.2.8.14  Queue Entity Extraction  

Within the Document Table, click More Options > Queue Entity Extraction to queue the entity 

extraction of VOD search results. Then, a message will display asking whether to queue the job. Click Yes to 

queue the job.  

  

7.2.8.15  Convert to HTML  

Documents can be converted into HTML from search results. After running a search, select a 

document (or multiple documents) and then click Other Options (3 vertical dots in the top right corner of the 

Document Table). Select Convert to HTML from the menu.  

A summary of the items for HTML conversion is displayed. At the bottom left are check boxes to 

Launch and Relaunch. Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Start 

button to start the conversion.  
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The HTML Conversion jobs will be queued and can be monitored from System Admin > Job > 

Status.  

  

7.2.8.16  Convert to RTF  

Documents can be converted into RTF from search results. After running a search, select a 

document (or multiple documents) and then click Other Options (3 vertical dots in the top right corner of the 

Document Table). Select Convert to RTF from the menu.  
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A summary of the items for RTF conversion is displayed. At the bottom left are check boxes to 

Launch and Relaunch. Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Start 

button to start the conversion.  

  
The RTF Conversion jobs will be queued and can be monitored from System Admin > Job > 

Status.  

  

7.2.8.17  Creating Slipsheets from Console  

Within the Document Table, you may create slipsheets to replace the document images for 

either selected documents or all documents. You may either enter text and/or fields or use an image. You 

may also use a Slipsheet Template if one has been made available to you by your administrator.  

  

1.  Click the Other Options button and then click Slipsheet Documents.  

The Create Slipsheet dialog displays.  

Click either the Selected or All radio button to choose which images will be replaced with 

slipsheets.  

The Summary section will update with the number of documents for which slipsheets will be added.  

Choose from the following radio buttons:  

• Load from Template – Select template from drop-down list  
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• Slipsheet Text – Choose the location, text, and fields to be included  

• Select a slipsheet image file – Use the Browse button to go to the location of the file  

  
Use the Preview button to review your slipsheet(s) prior to creation.  

If using Slipsheet Text option, you may check the option to Replace fulltext with slipsheet 

text. If there are existing images of documents already, you may select the option to Replace images of 

already existing documents with slipsheet. Click the Create button to generate the slipsheets.  

7.2.8.18  Creating Slipsheets from Web  

In the SlipSheet window, you can generate a slipsheet for specific file types. The slipsheets are 

generated when the files are TIFFed.    
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1. Check the Generate slipsheet for the following types of file check box to generate a slipsheet for the 

specified type files when the files are TIFFed by TIFF engine.  

2. Check the any File type checkbox to use a place holder.  

3. Select the Load from template radio button to display the placeholder text/TIFF placeholder from the 

template.  

4. Click the drop-down menu and select a slipsheet template.  

5. Select the Slipsheet text radio button to display the placeholder text in the slipsheet.  

6. Click the Font link to select font for fields or text to be printed in slipsheet. Click the Add Fields links 

to select a field from the drop-down and add to the place holder text.  

7. Click the Preview to view the slipsheet which would be created.  

8. Click the Select a Placeholder TIFF file radio button to browse for a placeholder TIFF file from the 

client desktop location to use as a slipsheet.  

9. Check If a document is slipsheet, create (replace if already exists) with slipsheet text check box to 

show the placeholder text in the viewer.  

10. Check Generate slipsheet at the first page when less than available pages of a document is TIFFed to 

generate the slipsheet on the first page.  

11. Check Generate slipsheet when TIFFing timed out to generate slipsheet for files for which TIFFing has 

timed out.  

12. Check Delete TIFF OCR’d and redacted Tiff OCR’d text when Tiff sheets are generated to delete OCR’d 

TIFFs.  

7.2.8.19  OCR Image/PDF Documents  

Documents can be sent to the OCR engine from the search results. After running a search, select 

document(s) and then click the Other Options button (right end of the Search Bar). Select Send Image/PDF 

Image Files to OCR from the menu.  

A summary of the items to be OCRed is displayed. At the bottom left are check boxes to Launch 

and Relaunch. Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Send to OCR 

button to send the files to the OCR engine.  
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The jobs will be queued and can be monitored from System Admin > Job > Status.  

  

7.2.8.20  OCR Tiff Documents  

Documents can be sent to the OCR engine from the search results. After running a search, select 

the document(s) and then click the Other Options button (right end of the Search Bar). Select Send 

Generated Images to OCR from the menu.  

A summary of the items to be OCRed is displayed. At the bottom left are check boxes to Launch 

and Relaunch. Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Send to OCR 

button to send the files to the OCR engine.  
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The jobs will be queued and can be monitored from System Admin > Job > Status.  

  

7.2.8.21  OCR Redacted Documents  

Documents can be sent to the OCR engine from the search results. After running a search, select 

the document(s) and then click the Other Options button (right end of the Search Bar). Select Send Redacted 

Images to OCR from the menu.  

A summary of the items to be OCRed is displayed. At the bottom left are check boxes to Launch 

and Relaunch. Select Launch if it is the first time; otherwise, select Relaunch. Then, click the Send to OCR 

button to send the files to the OCR engine.  
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The jobs will be queued and can be monitored from System Admin > Job > Status.  

  

7.2.8.22  Move Document  

After processing documents in different media, you have an option to move documents from 

one media to another. While choosing the document(s) to move, Source should be parent, but the 

destination can be a parent or child or nested child. After successfully moving the selected document, all the 

hierarchy will be moved making the source and destination a single family.  

1. Go to the Review page. Select parent document/s not within the same family and click on More 

Option context menu.  
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2. Click on Move Documents  

Pop up to enter field will be displayed.   

3. Enter valid field ID for the document to be moved under.   

If the provided Field ID is valid, a success message is displayed, and the moved 

document is moved within the hierarchy of the destination document.  
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4. If an invalid file id is entered (file id from the same family, selected file not being parent file, the 

moving file id itself, etc.), then a corresponding error message will be displayed.  

  

7.3  Review Module Left Section  

The left panel of the Review module consists of the Tags panel at the top and other metadata 

panels at the bottom.  

7.3.1 Tags Panel  
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The Tags panel shows all tags available and a few 

additional options for working with tags, as well as a tag search field.  

The arrow buttons may be used to Save Tags and move 

to the previous or next file, as well as mark the file as reviewed.  

The Save Tag(s) button simply saves the tags applied.  

Prior to saving changes, the tag color will be changed to 

green for tags being added and red for tags being removed.  

  

Use the following options to work with tags:  

• Navigate documents by clicking the Save Tag(s) and Move Next button ( ) or Save Tag(s) and  

Move Previous button. ( ).This will also mark documents as reviewed.  

• Search by Tag ID by typing in the tag search field.   

• Apply tags by selecting the document from the document table, checking the tag(s), and then clicking 

the Save Tag(s) button ().  

• Use the Create New Tag button () to create new tags. See the prior section on Tagging for more 

details.  

  

NOTE: There are the CAL-specific tags that appear when a CAL review set is created. The Auto 

tags are used by VOD’s CAL engine when predicting and should never be used by reviewers. Manual tags 

display only if you have permission to use them for tagging/untagging.  

7.3.2 Edit and Delete Tag  
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Edit and Delete icon links are available in the tag hierarchy in both review and analyze tag tree. 

The link is visible when the use hovers mouse on the tag  

Note: Saved Search and Review Tags are restricted for Edit and Delete Operation.  

  

Click Edit ( 

7.3.3  Metadata Panel  

The Metadata panel displays the metadata 

details of the emails and documents.  

Use the Show/Hide Columns button to 

adjust what is displayed within the panel.  

  

7.3.4  Parent/Child Panel  

The Parent/Child panel displays the 

documents that have a relationship with the selected 

document.  

Click the View button ( )to view 

either the parent or child.  

Use the Show/Hide Columns button to 

adjust what is displayed within the panel.  

  

7.3.5 Email Thread Panel  

    

  )  to edit   tags   and  Delete   ( )  to delete tags.     
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The Email Thread panel displays all 

documents within the Email Thread of the selected 

document, if any exist.  

Use the Show/Hide Columns button to 

adjust what is displayed within the panel.  

NOTE: In order for email threads to 

display, the email threading process must have been 

run within the Desktop Console.   

7.3.6  Duplicates  

Displays all the duplicates of a 

selected document.  

  

To view a duplicate, click on any document in the duplicate panel. A tag on duplicate and the 

primary document in the document table indicates that it is a duplicate and by clicking on View in the 

Duplicates panel you can view the details of the selected document.  

 

If the document is outside of the review set scope, an error message appears.   
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You can click Yes to see the details.  

You can also click on the check box “Do not show this message again” to skip the warning message.  

After performing a search operation, the logged in user can view similar documents of the 

selected document from the list view of search results. The user can use the feature ‘Similar’ (View Similar 

Documents) available in the review module to view the similar documents according to the frequency of 

texts contained in the fulltext of documents. Hence, any document with no fulltext will not be suitable for 

this feature. For this feature to work, the ‘Index Fulltext’ setting of the project should be enabled.  

Note: To enable “View Similar Documents”, the control setting key VIEW_SIMILAR_DOCUMENTS should be enabled 
(enabled by default) which is discussed in section 21.1 Control setting keys for Console and Web Application of the 
document ‘VenioOne Console Admin Guide’.  

7.3.6.1  View Similar Documents  

To view the similar documents, follow the steps given below:  

1. Navigate to Review Page.  

2. Perform Search in the search box to list search results.  

3. Click Similar on the left panel.  
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The user can view the similar documents results with default Similarity Score Percentage=50% 

and default Search Scope as All Documents in Project and can be changed from the settings icon.  

  
7.3.6.2  Document Handling in Duplicate Panels  
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The restricted documents are handled differently in the duplicate panels pane. The document 

which is not shared or having restricted access is not visible in PC, duplicate and email thread panel even 

though the document is available in family, duplicate and within the same email thread of the selected 

document. The unrestricted documents can only be accessed by the user with Super User rights.In the 

duplicate panels, documents are handled in the following ways:  

• Handling on document restriction - If only fileId 1 is restricted to the user, the user can view the 

unrestricted duplicate document through duplicate panel's view link.  

 

• Handling on document collaboration/share- If only fileId 1 is shared to internal/external user, the user 

can view the unshared duplicate document 2 through duplicate panel's view link  

 
• Handling for different action in review page - If the current search result contains only original 

document and user viewed the duplicate document 2 through the view link in the duplicate  
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panel, the actions such as send to tiff, send to OCR, send to tiff OCR etc. are not 

applicable since document 2 is not selected in the grid and those action are mainly for the selected 

document in the document table/grid.  

  
Venio OCR – The user cannot Launch, Relaunch or send to OCR.  

 
Send to Image - The user cannot Start Launch, or Relaunch.  

 
Generated Image OCR - The user cannot Send to OCR, Launch, or Relaunch.  

 
Redacted Image OCR -  
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7.4  Review Module Center Section  

The main part of the center section of the Review module is the Document Table panel, but 

there are several other tools available there as well, which are detailed in this section.  

7.4.1  Document Table  

The Document Table displays various fields for the search results or documents to be reviewed, 

as well as a document count and navigation tools at the bottom of the table. Check boxes on the left may be 

used to select documents.  

  

Document Types: 

Email are categorized as internal, inbound, and outbound based on the internal domain specified in the case setting 

and those email identifiers are shown in the document type field in the document table on the review page. 

Internal Email:  

Internal emails are those that are sent between individuals with email addresses that belong to the same 

organization or company. 
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Outbound Email:  

Outbound emails are those that are sent from an internal email address to an external email address, such 

as to a customer, vendor, or partner. 

Inbound Email:  

Inbound emails are those that are sent from an external email address to an internal email address, such as 

from a customer or partner to an employee. 

This is determined by the internal domains of the organization involved in the case in the Case Create Page and this 

field can take multiple domains as input. 

A TAG_COLOR field may be included in the Document Table layout. Different colors are displayed in this 

column if that color tag has been applied for the document.  

 

7.4.2  Sort Results  

To select how items are sorted in the Document Table, click the Sort Results  button in the 

upper right corner of the Document Table. Use the drop-down lists in the Sort Option dialog and then click 

the Sort button to re-sort the search results  

  

7.4.3  Show/Hide Columns  

To select which columns display in the Document Table, click the Show/Hide Columns  button 

in the upper right corner of the Document Table. Deselect any items you wish to remove and click the Save 

button.  

Fields will be displayed left to right in the same order as they are listed.  
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7.4.4  Save As CSV  

To save the search results displayed in the Document Table, click the Save as CSV  button in 

the upper right corner of the Document Table. The list of files is saved to your computer’s Download 

location.  

7.4.5  Image Set  

When the case has an image set created, only then the radio button appears with the 

dropdown box listing all the image sets for that case. You may toggle in the Image Set and select Image Set 

from the drop-down list to load the image set in Image viewer.  

  
7.4.6  Page Navigator  
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Use the Page Navigator to move through the pages of documents in the Document Table. Click 

the right and left arrows to navigate through the pages and the double arrows to navigate to the beginning 

or end of the documents.  

  

Enter a number in the search box to move to 

that page of documents.  

7.4.7  Document Tally  

Within the Document Table, you can do a document tally by clicking on any of the column 

headings. As soon as you click the column heading, the Tally dialog will display for that column. The 

individual items within that column will display with a count of how many there are. In the example below, 

we can see that there are 280 items with the original file name enron.xls. If needed, you may use the search 

field and Find button to locate items.  

Check to select items in the Tally list and then click the Apply Filter button to show only those 

items.  

You may also use the Export to CSV button to export the list of items and counts.  

  

7.4.8  Document Notes  

The Notes panel (below the Document Table) has a Notes tab that shows all of the documents 

notes in a threaded view and also has a tab for the Coding panel. You may add a new note to the document, 

expand or collapse the list, edit an existing note, or reply using the icons displayed to the right of a note in 

the list. 

 

7.4.8.1  Adding Notes  
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To add a note, click the Add Note button ( ) in the upper right corner of the panel. When 

adding a note, you may choose the visibility for your note using the radio buttons. After entering your note, 

click the Add button to save the note.  

By default, for normal review 'Show to all users' should be selected and whenever a user adds a note it 

should be visible to all users. 

 

 
 

7.4.9  Coding Panel  

The Coding panel displays all of the coding fields. Coding values may be single value, multi-

value, or predefined values, which are separated by the delimiter selected when the custom field was 

created.   

Coding is available only once a custom field is created in Field Management from the Desktop 

Console and the Allow Coding checkbox is selected.  

Then, the coding field must be added to the screen layout in VOD for it to be visible there.  

  
Depending on your rights, you may Reset, Add, and Update coding field values in bulk or for 

individual files. Be sure to click the Save button to save your changes.  
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Use the Show/Hide Columns button in the upper right corner of the panel to adjust what coding 
fields are displayed within the panel. After any changes, you will need to save your screen layout to keep the 

fields displaying on your next login.  

As shown below, a Help icon next to each Coding Field Name displays information about the field 
when hovering over it. For multi-value fields, the delimiter that must be used between items is also displayed 
next to the Coding Field Name.  

  

7.4.9.1  Add/ Update Single Coding Field  

You can perform single coding by entering a single value in the coding field. Be sure to click 

Save.  

NOTE: The coding field value will update only for the last checked file If multiple files are 

selected.  

In Coding ‘Save and Move Back’ & ‘Save and Move Next’ options are added. ‘Save and Move Back’ should 

save the current document coding values and move to the previous document. Whereas, ‘Save and Move 

Next’ should save the current document coding values and move to the next document in the table panel 

and load the coding values. Also a coding summary popup will be shown.  

 

7.4.9.2  Add/ Update Coding Fields in Bulk for Multiple Files  
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If you have rights to do so, you can perform bulk coding on multiple files at one time. You should 
first check  the check boxes to select the files to apply the coding changes to. The Bulk coding Add or append 
data button is only displayed on the right side of the custom field grid when more than one file is selected.  

  
After clicking the Add or append data button, a dialog displays to enter the coding information. 

Click the Save button to return to the Coding panel.  

  
After updating the value and clicking the Save button, the update success message is displayed 

in the top right corner of the screen and the bulk update values are updated after reloading the Review 

page.  

  

7.4.9.3  Allow Predefined Values and Multiple Values  

With settings to only allow predefined values, you may only select the values which are already 
defined for the coding. Multiple values can also be selected, but you are not allowed to type in the textbox. 
After you click on the browse button, a wizard to select the predefined values will be opened where you can 
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select single or multiple values. Any currently applied values will be displayed at the top of the wizard. You will 
be provided with three different options to apply coding:  

• Override existing values: Replaces previous values with current selected values.  

• Append to end: Appends the current selected values after the previous values.  

• Insert at beginning: Inserts the current selected values before the previous values.  

After the details are selected, you must click the OK button within the wizard. The bulk update 
values are updated after reloading the Review page. Finally, you need to click the Save button in the coding 

panel to ensure the new values are saved.  

  
7.4.9.4  Allow Predefined Values without Multiple Values  

When you are only allowed to select from predefined values, but are not allowed to enter 
multiple values, then you can select predefined values from a drop-down list of the available values. You have 

to select and then Save these values.  

 

 Values in coding fields are sorted alphabetically while loading in review page. 
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7.4.9.5  Multiple Values with No Predefined Values  

You are allowed to type multiple items in the coding field using the defined delimiter shown 

after the Coding Field Name. You need to click the Save button to save the values.  

  

 

7.4.9.6  Overlay Coding Field Values  
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You may also overlay the coding fields’ values using a load file in either.txt or.csv format.  

1.  Start by clicking the Overlay button on the bottom left of the Coding panel.  

  
The Overlay Coding page is displayed  

  
NOTE: Click the Help button in the upper right for information on formatting the load file.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 218  

  
Click the Browse button and browse to your overlay file.  

After browsing to the load file, all files are automatically loaded into the Overlay Coding dialog.   

  
Click the Apply button to save the new values.  

If the load file is valid, the update success message is displayed in the top right and the values are updated after 

reloading the Review page.  
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If the load file is invalid, the Validation Message column is displayed with error messages.  

  
If you click the Apply button, an additional error message appears. Any rows with errors will not 

be overlaid until the issue is corrected in the load file.  
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7.5  Document Viewer (Review Module Right Section)  

The Document Viewer makes up the right section of the Review Module and displays the 

email/document contents in multiple format tabs, including Text, Native, or Tiff view.  

NOTE: In Index only cases, the Document Viewer will only have Text view. Native, Tiff, and PDF 

views will be disabled.  

7.5.1  Text View  

Text View shows the text in 

the body of the Email/Document. If the 

project settings included headers in the 

email body, you will also see this 

information in the Text View.  

  

There are radio buttons at 

the top of the viewer for the following:  

• Extracted – Extracted text for 

documents.  

• Generated - Extracted text for image 

files.  

• Redacted - Extracted text for redacted 

image/image set files.  
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You can click the Search 

button and enter the search term in the 

search box that displays. If the search term 

you entered matches a term you specified 

in Term Highlighting, then the term should 

be highlighted with the specified color  

  

7.5.2  Near Native View  

If you open VOD in the 

Internet Explorer browser before 

installing the Venio Addons, it will display 

the Near Native View.  

After the installation of the 

Venio  

Addons, VOD will display the 

Native View. This view shows the 

metadata and text in the body of the 

email or document in its native format.  

  

Cache feature is available for the documents which are loaded in the first page of document 

table. Also, when last document on the current page is selected, documents on the next page and the 

previous page are not cached. This feature is available for the native files only.   
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In the Near Native View tab, you can view any documents that have been successfully 

converted to native. If a file has not been converted, clicking on this tab will perform a “HTML conversion on-

thefly” to display the near native file.  

The control settings HTML_CONVERSION_MAX_FILE_SIZE_FROM_VIEWER key controls the 

threshold file size that will be html converted on the fly.  

  

If the HTML file is already converted by DS(queued from console) then it will be loaded in the 

near native viewer.  

  

The control settings HTML_CONVERSION_TIMEOUT_IN_SECONDS key controls the threshold 

time under which the conversion succeeds.  

  

If it fails within this time, it shows error message and if user retries the previously timeout file, 

document will be re-queued for HTML conversion.  

  

While the document is queued and is in progress, retry button is invisible.  

  

In the situation when the file could not be found for HTML conversion, below message is 

displayed in the Native viewer.  

 

A log is entered in the tbl_ex_HTMLConversionFailedFiles table for the same fileid  

When the file conversion to HTML fails, an error message from database from the data base is 

displayed:  
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The following file types are not supported from queuing for HTML conversion:  

• AUTOCADDWG14  

• MSPROJECT2016  

• XLSM  

When such file is considered for conversion, a message appears as shown below:  

  

7.5.3  Viewing Supported Multimedia File Types  

Supported media files are displayed in the Near Native Viewer when selected from the 

document list. You can mark different points of time within the file and add Notes. The list of marked time 

and Notes will be available and when clicked, the media player will navigate to the respective point in the 

audio/video file.  

To create a time-stamped note: Click into the Note field, enter your note, click the Mark Current 

Time button, and then click the Save button.  
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7.5.4  Image View  

In the Image View tab, you 

can view any documents that have been 

successfully tiffed.  

If a file has not been tiffed, 

clicking on this tab will perform a “tiff-

on-thefly” to display the image. In this 

view, you may add annotations, 

redactions, and highlights, if you have 

been given rights to do so by the 

Administrator.  

 

  Below keyboard controls help to navigate pages in an image viewer. 

1. Page Up 

              Go to the previous page (Fn + ↑ on Mac) 

2. Page Down 

              Go to the next page (Fn + ↓ on Mac) 

3. Home 
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              Go to the first page (Fn + ← on Mac) 

4. End 

              Go to the last page (Fn + → on Mac) 

  

7.5.4.1  Redaction and Viewing Tools  

Tools for viewing the document, as well as any redactions, are found at the top of the Image 

View.  

There are options for changing the size of the document within the viewer, as well as navigating 

the pages of the document. Additionally, there are tools for working with the redactions, if any, in the 

document.  

  
The tools for viewing redactions offer the following options:  

• Redacted Pages Only - See only those pages within a document where annotations have been added. 

By using this feature, redactions can be quickly reviewed, or modified.   

• Hide Redactions - View tiff files without their redactions.  

• Redaction Mode – Displays redaction tools, which are covered in the next section.  

• Opacity - Make all redactions or highlights transparent without modifying them.  

7.5.5  Annotations and Redactions  

In the Image View, you may annotate or redact the image of the email/document, as needed.  

To do so, click the Redaction Mode button to display the redaction tools on the left side of the screen and 

enable redactions to be made.  
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7.5.5.1  Accessing Redaction Sets  

When there are redaction sets available for use within your project, 

you will see the Redaction Set button (as shown). Hovering over it will display the 

available redaction sets. It may be used to access or edit existing redaction sets.  

  

7.5.5.2  Applying Redactions  

1. In Redaction Mode, hover over the Type of Redaction button and select the redaction to be used.  

The cursor displays as a + symbol.  

2. Click-and-drag to select the area to be redacted.  

When the cursor is released, the selected area is redacted.  

3. If needed, click the Select button to select the redacted area and adjust.  

4. Click the Save Annotations button to save the redactions.  

A confirmation that annotations have been saved will display briefly.  

While applying Redaction for a document, the redaction is saved even when you move to the 

next document or switch between Text and Native Viewer. The redaction applied is saved while navigating 

through the documents.  

 

Before Redaction: 
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Redaction applied:  

 

Navigating After Redaction:  

As seen below, the redaction applied is saved while navigating through the documents.  
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7.5.5.3  Applying Highlights  

1. In Redaction Mode, hover over the Highlight button and click Highlight.  

The cursor displays as a highlighter.  

2. Click-and-drag to select the area to be highlighted.  

When the cursor is released, the selected area is highlighted.  

3. If needed, click the Select button to select the highlighted area and adjust.  

4. Click the Save Annotations button to save the highlights.  

A confirmation that annotations have been saved will display briefly.  

7.5.5.4  Redacting Entire Pages  

1. To redact an entire page or pages of a document, click the Redact Page button.  

2. Select the option for which pages to be redacted and click the Next button.  

3. Select the Redaction Set and click the Apply button.  

The selected redactions are applied to the designated page(s).  
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7.5.5.5  Copying Redactions  

IMPORTANT: Prior to using this function, ensure that your image size and orientation are the 

same.  

This is a bulk operation that, because of the way the redactions are applied, cannot be undone 

in bulk.  

1. In Redaction Mode, select a redaction.  

2. Click the Copy Redaction button.  

The Copy Redaction dialog displays.  

3. Select the options to use within the dialog.  

4. Click the OK button to add the copied redaction to the selected location(s).  

 
7.5.5.6  Create a New Redaction Set  
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1. To create a new redaction set, click the Create New Redaction Set button.  

2. Complete the information as follows:  

• Type: There are two types of redactions: Solid Rectangle and Highlight  

• Reason: There are three predefined reasons for redaction: Privileged, Confidential and PII.  

NOTE: You may use the Reasons link to add additional reasons for redaction.  

• Name: Name to identify the redaction set.  

• Background Color: Background color of the redaction set.  

• Text Color: Text color of the redaction set.  

• Caption Text: Text to be shown on the redactions, if needed.  

• Font Size: Font size of the caption text.  

3. Click the Add button to create the redaction set.  

7.5.5.7  PDF View  

When the Control setting key Enable_PDF_Imaging flag is enabled in the database, the PDF 

Viewer is loaded in the Image tab for PDF image files. In this view, you may add redactions and highlights.  

The following tools are available in this view:  

• Highlight  

• Redact Text  

• Save  

• Fit to Page  

• Zoom In/Zoom Out  

• Download (if you have rights to do so)  
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To delete any applied redactions or highlights, select the element and right-click for the Delete 

option.  

7.5.6  Social Media View  

Extracted social media files can be viewed from the Social Media Viewer.  

NOTE: The Social Media Viewer must be enabled for the Layout selected and the following 

permission must be enabled for the user: ALLOW_TO_VIEW_SOCIAL_MEDIA_VIEWER.  

If it is not displayed, click on the Document Viewer drop-down arrow and select Social Media to 

display the Social Media Viewer.  

  
In the top right corner of the Social Media Viewer, you have options to zoom in/out, refresh, 

and enter a page number to go to a particular page.  
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Similarly, you have buttons on the left to view conversation Metadata Information and also the 

Filter content. You also have an icon for the social media platform from which the data was extracted e.g., 

the Facebook icon.  

Filter will allow you to filter messages by participants in the conversation and also the date 

range.  

7.5.7  Transcript View  

Disabled/Uncheck the Enable Transcript option for the case from case management, the transcript viewer in review 

will be seen in the closed panel section and when hovering on it, a message as ‘transcript is not enabled for this case’ 

will be displayed. 

 

In the Transcript tab, you can view any transcript documents that have been successfully 

uploaded.  
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In this view, you may add notes and highlights, if you have been given rights to do so by the 

Administrator. The Font, Font Size, and Font Type can be changed from the drop-down options available at 

the top of the viewer.  

7.5.7.1  Making Transcript Annotations  

To display the side panel, click the hamburger Menu button  In the top left corner of the 

viewer. The following options are displayed:  

• Transcript: In this section of the panel, all the uploaded transcript files will be listed. Click the 

required file name to view it.  

  

• Highlight: All the applied highlights will be listed. They will be displayed in the format -  

PageNumber:LineNumber e.g., 12:20. When any of the listed numbers is clicked, it will 

navigate to the respective page. To delete the highlight, click the red Delete button beside the 

respective highlight.  
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• Notes: All the added notes will be listed. They will be displayed in the format -  

PageNumber:LineNumber e.g., 1:6. When any of the listed numbers is clicked, it will 

navigate to the respective page. If you want to delete the note, you can click on the red Delete 

button beside the respective note.  

  

To view 
the added note, click the  icon beside the note or click on the line where the note is added. The note 
is displayed as follows with the name of the person who created it and the creation date.  

  

• Word Wheel: A search field is available where you can enter the term you want to search or a series 

of terms in single quotations e.g., ‘Microsoft Corporation.’ Click the Search button to display all 

possible results and highlight the searched term. When you click to select a search term, the page 
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and section numbers will be displayed for all instances of the search term. When a number is clicked, 

VOD will navigate to the respective page and line.  

  

• Document Link: Documents within the project can be linked to the selected text/line of a transcript 

file. Document links will be displayed in the format PageNumber:LineNumber FileName, for example 

12:20 test.zip. When any of the Document Links are clicked, VOD will navigate to the respective page. 

If you want to delete the link, click the Delete button beside the respective Document Link.  

  

7.5.7.2  Adding Transcript Highlights  

To add a highlight, select text within the transcript and then right-click. Select one of the three 

highlight colors you wish to use. The text will be highlighted, and the page/line number reference added to 

the list of Highlights. Be sure to click the Save button to save your changes.  

7.5.7.3  Adding Transcript Notes  

To add a note, select text within the transcript and then right-click. Select Note and enter the 

text for the note. Click the Close button when finished. The page/line number reference is added to the list 

of Notes. Be sure to click the Save button to save your changes.  

7.5.7.4  Adding Document Links  

To add a document link, first select document(s) from the Document Table. Then, select text 

within the transcript and right-click. Select Link Selected Document. Click the Close button when finished. 

The page/line number and document reference are added to the list of Document Links.  
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7.5.7.5  Transcript Annotation Report  

In the upper right corner of the Transcript Viewer is a button  for reporting on transcript 

annotations. The following options are available in the Select Report drop-down: All, Notes, and Highlight. 

Select one of the options and click the Generate Report button. The report will generate in a new window. 

The report displays the notes, created by, created time, and the page/line references where the note is 

added. Similarly, for highlights, it shows the section of the transcript which are highlighted.   

  
The report is generated as follows:  

  

Click the Print button  to print the generated report.   

 

Note: Project setting template report can be enabled and fetch report from upload by setting control setting 
key[DISPLAY_PROJECT_SETTINGS_LINK_IN_UPLOAD_PAGE] to true.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 237  

 
Transcript option is added in the project settings & project settings template report. 
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8 Searching in VOD  
 

8.1  Search Overview   

In VenioOne, a search involves searching for a particular term or phrase in the specified media 

scope.  Depending upon the search query, VenioOne may search in the Lucene index or in the SQL project 

database.  VenioOne uses Lucene.Net Version 2.9.2 for fulltext indexing of documents and metadata. NOTE: 

Search terms are NOT case-sensitive.  

• A query is broken up into terms and operators. There are two types of terms: Single Terms and 

Phrases.  

• A Single Term is a single word such as "test" or "hello".  

• A Phrase is a group of words surrounded by double quotes such as "hello dolly".  

• Multiple terms can be combined together with Boolean operators to form a more complex query.  

8.2  Boolean Search Operators  

Boolean operators are AND, OR and NOT and must always be in UPPERCASE. Boolean operators 

are used to combine different search criteria to form the final compound search query.   

NOTE: The precedence of the Boolean operators is NOT →  AND → OR.  First NOT is processed, 

then AND, and finally OR. Use parentheses ( and ) to group search terms to reduce confusion.  

8.2.1  OR Operator  

The OR operator links two terms and finds a matching document if either of the terms exists in a 

document. The OR operator is the default conjunction operator.  This means that if there is no Boolean 

operator between two terms, then the OR operator is used by default.  

Example 1:  

To search for documents that contains either "signed contract" or "agreement" use query:  

"Signed contract" OR agreement  

NOTE: If you want to find only documents that contain the phrase “signed contract”, you must use 

the quotation marks.  Otherwise, you will get different results with false positives.  

Example 2:  

If you run a query without quotations using the following:  

Signed contract OR agreement.  
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The result will be all documents containing either the word “signed”, “contract” or “agreement” 

because the default OR operator will be used between the terms.  This will likely yield more results than 

Example 1.  

8.2.2  AND Operator   

The AND operator matches documents where both terms exist anywhere in the text of a single 

document. This is equivalent to an intersection using sets. The symbol && can also be used in place of the 

word AND.  

To search for documents that contain "signed contract" and "confidentiality agreement" use the 

query:   

"Signed contract" AND "confidentiality agreement"  

8.2.3  NOT Operator   

The NOT operator excludes documents that contain the term after NOT. This is equivalent to a 

difference using sets. The symbol ! can be used in place of the word NOT.  

To search for documents that contain "signed contract" but not "confidentiality agreement" use 

the query:   

"Signed contract" NOT "confidentiality agreement"  

Note:  The NOT operator cannot be used with just one term. For example, the following search 

will return no results:  

NOT "confidentiality agreement"  

8.3  Special Characters  

In VenioOne, as in many common indexers, some symbols or characters are treated as stop 

words and are skipped during indexing; therefore, they are not searchable.  

To escape these characters, you need to use the \ symbol before the character.   

For example, to search for (1+1):2 use the query:  \(1\+1\)\:2  

VenioOne supports escaping special characters that are part of the query syntax.  The current 

list of special characters is:  

 ?  [  {  ^  

 %  ]  }  ;  

+ > “ < - = ~ /  

 !  @  \  &  
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( _ *. ) ‘ : |  

8.4  Wildcard Characters  

Wildcard character searches are only supported in the following search types: Search By Term, 

Wildcard Search, Fuzzy Search, Proximity Search and Field Search.  Wildcard characters supported by 

VenioOne are *and ? and their use is described below.    

The * wildcard will match zero or more characters, except for spaces. For example, to search for 

test, tests or tester, you can use the search:   

test*  

You can also use wildcard characters in the middle of a term.  For example, to search for text, 

tent, or tenant, you can use the search:  

te*t  

The ? wildcard will match a single character, except for spaces. For example, to search for "text" 

or "test" you can use the search:  

te?t  

8.5  Search Duplicate Options  

Search duplicate options filter search results according to the selected duplicate option.  These 

options are available in both the Desktop and Web modules.  It is chosen before you execute a search.  

  
Below are detailed descriptions for each option.  Choose the one that best fits your search 

needs.  
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Note: Search duplicate options will be available to the user as per the rights provided by the 

Admin.  

1. Show only one instance in the selected scope  

This is the default selected search duplicate option when you open the Search module.  

The search result will only show one instance of a document within the selected scope.  The 

duplicates within the scope are identified dynamically during the search.  If a document matches the search 

criteria, at least one instance of that document will be shown in the search result.  This is true even when all 

instances of that document are identified as project level duplicates during ingestion.  

Consider a project with the following file hierarchy:  

Custodian1:  

  Media1:  File1o -->Original  (isduplicate=0, IsDuplicateCustodianLevel = 0)  

      File2o -->Original    (isduplicate=0, IsDuplicateCustodianLevel = 0)  

  Media2:  File1d1  -->Duplicate (of file1 from Media1) (isduplicate=1,      

                    IsDuplicateCustodianLevel = 1)  

      File2d1  -->Duplicate (of file2 from Media1) (isduplicate=1,     

                    IsDuplicateCustodianLevel = 1)  

      

Custodian2:  

File3 -->Original  (Isduplicate=0, IsDuplicateCustodianLevel = 0)  

  Media3:  File1d2 -->Duplicate (isduplicate=1,, IsDuplicateCustodianLevel = 0)  

      File2d2  -->Duplicate (isduplicate=1,, IsDuplicateCustodianLevel = 0)  

The searches are executed as follows:  

  

Example 1:  

  Selected scope:  Media1, Media2  

  Search term:   FileID>0  

  Search hit:    file1o, file2o, File3  

Here file1d1 and file2d1 of media2 are considered duplicates NOT BASED on their duplicate=1 

flag but because of repetition.  

Example 2:  
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  Selected scope:  Media2  

  Search term:   FileID>0  

  Search hit:    file1d1, file2d1, File3  

2. Show only one instance per custodian in the selected (DynamicDeDupe™)  

  

The search result will only show one instance of a document per custodian within the selected 

scope.  The duplicates within the scope are identified dynamically during the search.  If a document matches 

the search criteria, at least one instance of that document will be shown per custodian.  

Using the same data set as in the above example, the search is executed as follows:  

Example 3:  

  Selected scope:  Media1, Media2, Media3  

  Search term:   FileID>0  

  Search hit:    file1o, file2o, File3, File1d2, file2d2  

Here File1d2 and file2d2 of Media3 are shown in search results since these files are in a 

different custodian and are not repeated within that custodian.  

  

3. Show all duplicates in the selected scope  

  

The search result will show all documents that match search criteria, including duplicates in the 

scope.  

Example 4:  

  Selected scope:  Media1, Media2, Media3  

  Search term:   FileID>0  

  Search hit:    file1o, file2o, File3, File1d1, file2d1, File1d2, file2d2  

No filters are applied, so every file hit during search is shown.  

  

4. Hide project level duplicates (StaticDeDupe™)  
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The search result will exclude project level duplicates. These duplicates (Static Duplicates) are 

identified during ingestion based on ingestion order.  (NOTE: The Static DeDupe order can be modified by 

the VenioOne Admin using the Custodian Priority feature).  

Example 5:  

  Selected scope:  Media1, Media2, Media3  

  Search term:   FileID>0  

  Search hit:    file1o, file2o, File3  

Here file1o, file2o and file3 are shown in search result as they are project level original files and 

the rest are project level duplicate files.   

Example 6:  

  Selected scope:  Media2  

  Search term:   FileID>0  

  Search hit:    File3  

Here File3 is the only file which is project level original within selected Media2, hence, it is the 

only file shown in search result.  

  

5. Hide custodian level duplicates (StaticDeDupe™)  

  

The search result will exclude custodian level duplicates. These duplicates (Static Duplicates) are 

identified during ingestion based on ingestion order. (NOTE: The Static DeDupe order can be modified by the 

VenioOne Admin using the Custodian Priority feature).  

Example 7:  

  Selected scope:  Media1, Media2, Media3  

  Search term:   FileID>0  

  Search hit:    file1o, file2o, File3, file1d2, file2d2  

Here file1o, file2o, File3, file1d2, file2d2 are shown in the search result as those files are 

originals within their respective custodians.  

Example 8:  
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  Selected scope:  Media2  

  Search term:   FileID>0  

  Search hit:    File3  

Here file1d1 and file2d1 both are custodian level duplicates so these are NOT shown in search 

results.  

Example 9:  

  Selected scope:  Media3  

  Search term:   FileID>0  

  Search hit:    file1d2, file2d2  

Here even though file1d2 and file2d2 are static project level duplicates, they are originals within 

the selected custodian, so they are shown in the search result.  

8.6  Advance Query Builder  

When you click into the query portion of the Search Bar, an option to open the Advance Query 

Builder will be displayed above the Search Bar.  

  

Click the button to open the Advance Query Builder dialog. Expandable sections indicate the 

different types of searches available, which are described in the sections below. The search composed using 

one or more of the different search types will be displayed at the top of the Advanced Query Builder.  

  

The document count is displayed according to the selected media/folder scope in the 

Advanced Search section. In the below example, after applying the filter to 
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andrew_lewis folder, the document count will change according depending on the 

folder. 
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Using folder restriction, the document count in the folder search is validated and the 

same result is displayed in review while performing search from the advanced search. 

Term Search   

The Term Search section enables you to search in document contents, metadata, or both 

document contents and metadata by providing keyword(s) and/or phrase(s).  

Enter the terms in the desired field(s), select the context option, and then click the ADD(OR) 

button to create an OR search.  

To create an AND or NOT search, click the drop-down arrow on the ADD(OR) button and select 

the desired option.  

The query will be added to the Search Bar at the top of the screen.  

  

Term Search Options  

• To search only the document contents, select the FULLTEXT radio button. Search terms can be 

multiple terms combined using Boolean operators.  

  
Example: FULLTEXT(term1 OR term2)  

• To search only document metadata, select the ATTRIBUTES radio button. Search terms can be 

multiple terms combined using Boolean operators.  
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Example: ATTRIBUTES(term1 OR term2)  

• To search in both document contents and metadata, select the Both (Fulltext and Attributes) radio 

button. Search terms can be multiple terms combined using boolean operators.  

  
Example:  term1 OR term2  

NOTE:  If neither FULLTEXT nor ATTRIBUTES is specified, by default the term is searched 

in both attributes and fulltext.  

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

Load File Search  

Within the Term Search tab of the Advance Query Builder, you can use a Load File to run searches in VOD. 

This is particularly useful if you want to use the same searches again or across projects, or if you have a lot of 

search terms.   

In the Advance Query Builder, on the Term Search tab, select the Load from File radio button.  From the drop-down 

menu, select the type of load file you will be using.   

VOD accepts the following types of load files for searching:  

• Search Term: This is used to search for specified terms contained in the load file.  The Search Tterm 

option loads the listed search terms from a text file and searches for documents containing those 

terms.  

This type of load file supports every search expression that is valid in the search query 

box.  

    

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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Example 1:  field search like FileID = 26 OR ControlNumber = 1123  

This query will search for documents with Control Number “1123” OR a document with 

FileID 26.  It should be noted that for field searches, the Field Name must be specified otherwise the 

search term will be treated as a single term.   

Example 2: “Responsive” will search for documents with the term “responsive,” but TAGS 

(“responsive”) will search for all documents that have been tagged as “responsive”.  

• INTERNAL_FILE _ID: This loads the listed FileIDs from a text file and searches for documents 

containing those FileIDs. The field should not be included in the load file.  A search for FileID=23 

should be written only as 23 in the load file.  

NOTE:  Unlike the Term Search, this query does not support other field searches and 

should only contain FileIDs.  

• EMAIL_ENTRY_ID: This loads a text file containing a list of EntryIDs that are to be searched.  This 

query also does not support other field searches and should only contain Entry IDs.  And, like in the 

INTERNAL_FILE_ID searches, the field should not be included.  

• HASH_VALUE: This loads a text file containing a list of hash values that are to be searched.  

This query also does not support other field searches and should only contain hash 

values. And, like in INTERNAL_FILE_ID searches, the field should not be included.  

• HASH_VALUE_SECONDARY: This loads a text file containing a list of secondary hash values that are to 

be searched. This query also does not support other field searches and should only contain secondary 

hash values.  And, like in INTERNAL_FILE_ID searches, the field should not be included.  

• CONTROL_NUMBER: This loads a text file containing a list of control numbers that are to be 

searched. This query also does not support other field searches and should only contain control 

numbers.  And, like in INTERNAL_FILE_ID searches, the field should not be included.  

NOTE: Among the above types of load file searches, only Search Term requires the Lucene 

index.  

Click the Browse button and navigate to your load file.  

To validate the load file, you wish to use and ensure it is in the correct format, click on the Validate 

button.  

If the load file is valid, a message will display to confirm the validity.  

If the load file is valid, a message will display to confirm the validity.  

  

Click the Search & Save button to save the search.  
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Enter a Search Name and click the Search button.  

  

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Field Search  

VOD gives you the following Operator options when running a Field Search:  

EQUALS(=)  BETWEEN  

LESSTHAN(<)  BEGINS WITH  

LESSTHANEQUALTO(<=)  ENDS WITH  

GREATERTHAN(>)  IS NULL  

GREATERTHANEQUALSTO(>=)  IS NOT NULL  

Field validations are in place to prevent searches with incomplete queries.  

The following are the searchable fields in VOD:  

• CONTROLNUMBER: Assigned control number do a document  

• CUSTODIAN_NAME: Assigned custodian name  

• DEFAULT_FULLTEXT_PREFERENCE: Select from EXTRACTED, TIFF_OCR, or REDACTED_OCR  

• DETECTED_LANGUAGE_ALL:  Documents with all identified languages  

    

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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• DOCUMENT_NOTES: Documents with notes added  

• EDOC_AUTHOR: Document author metadata  

• EDOC_TITLE: Document title metadata  

• EMAIL_ANY_ADDRESS: Email address or name in any of the email fields  

• EMAIL_BCC: Email address or name in BCC metadata of an email  

• EMAIL_CC: Email address or name in CC metadata of an email  

• EMAIL_ENTRYID  

• EMAIL_MESSAGEID  

• EMAIL_SUBJECT:  Subject metadata in an email  

• EMAIL_TO: Email address or name in TO metadata of an email  

• EXPORT_FULLTEXT_PREFERENCE: Options are EXTRACTED, TIFF_OCR, REDACTED_OCR  

• FILE_SIZE: Document’s native file size  

• FOLDERS: Folders created within VOD  

• FULLTEXT_SIZE: FullText file size  

• FULLTEXT_TYPE: FullText file type  

• GROUP_HASH_VALUE:  Document with gGenerated family hash value  

• HAS_HIDDEN_OBJECT: Yes/No field indicating whether hidden objects are present in a file  

• HAS_SYSTEM_BATES: Yes/No field indicating whether a system bates number is present in a  

file  

• INTERNAL_FILEID: Automatically assigned unique identifier  

• IS_CENTROID_NDD: Search reference documents used for Near Deduplication  

• IS_NOT_IN_REVIEWSET: Yes/No field indicating whether a document is included in a reviewset  

• IS_PARENT: Yes/No field indicating whether a document is a Parent  

• NEAR_DUPLICATE_GROUP_INTERNAL_FILE_ID: Populated with FileID of CentroID of near duplicate 

group  

• NEAR_DUPLICATE_SIMILARITY_PERCENTAGE: Populated with near duplicate similarity percentage  

• NEAR_DUPLICATE_GROUP_CONTROL_NUMBER: Populated with control number of CentroID of near 

duplicate group  

• ORIGINAL_FILENAME: Documents with specified filename  

• ORIGINAL_FILE_PATH:  Documents with specified original file path  

• RECOGNIZED_FILE_EXTENSION: Document’s with specified file extension  

• REDACTION_REASON: Documents with indicated reason for redaction  

• REDACTION_SET: Documents within specified redaction set  

• SAMPLING_NAME: Documents within specified sample name  

• SLIP_SHEET_TEXT: Documents with specific text included in slip sheet  

• TAGS: Documents with assigned tags  

• MEDIA_PROCESSED_DATE: Populated with the date the media was processed.  
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To compose a Field Search, you must first click into the input area and then click the Add 

Control button. At that point, the Select Field drop-down will display. As you use the drop-down lists to 

select the field and then your operator and content, the query being built is displayed on the Search Bar at 

the top of the dialog.  

To add additional fields, click the AND, OR, or NOT buttons as shown in the example below. To 

delete an item from the search, use the Trash Can button.  

  

To combine a Field Search with one of the other search types, create your Field Search criteria 

and then select the Query Appending Operator from the drop-down in the bottom right. Click one of the 

other search tabs and enter the additional criteria needed.  

Below is an example of a Field Search combined with a Fuzzy Search.  

  

● Field search does not automatically generates the query after clicking on the + icon. 

User should click on the “ADD” button to generate the Query in the search box. 
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NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

 

Wildcard Search  

The Wildcard Search enables you to use the wild characters described in Section 8.4 above. You 

will be able to see the wildcard expansion results and pick and choose which of those expanded terms you 

actually want to use in the search. This helps you narrow the search to smaller hits and avoid false positives. 

At the same time, you will be able to see what variations of a term or phrase are in the data.  

Wildcard term expansion can be performed using the FULLTEXT, ATTRIBUTES or BOTH. After the 

term expansion, you can select multiple expanded terms and form the query for searching. You may also use 

the Show Term Count option to display the number of document hits for a specific term.  

Wildcard searches can also be combined with other searches using the ADD(OR) button.  

Wildcard Search Examples:  

Searching for “*ght” could return eight, caught, height, etc., if these terms exist in the scope of 

your search.  

Searching for “mat?h” could return match, matoh, mateh, etc., if these terms exist in the scope 

of your search.  

NOTE: There is no need to specify * at the end of terms while expanding terms.  By default, 

VenioOne adds * after each term in expansion if no wildcard character is specified.  

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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1.  Select Wildcard Search tab in Advance Query Builder.  

Enter the wildcard term to expand in the Wildcard Term box.  

Use the Expand Using… drop-down to expand the search term using Both, Fulltext or Attributes.  

 
  

Optional: Use the Show Term Count check box to show the document counts for each expanded 

term.  

Click the Expand button to display the terms.  

 Select the terms to search from the list using the checkboxes.  

When you select multiple expanded terms, the default Term Combining Operator is OR. You can 

change this to AND or NOT, as desired, using the drop-down list.  

Click the ADD (OR) button to add the terms to the Query 

Field. Click the Search button to execute the search.   

    

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

    

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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Fuzzy Search  

The Fuzzy Search enables you to find terms similar to the one you provide. This helps you to find 

misspelled words, such as people’s names, or when you are unsure of the exact spelling of a term. Fuzzy 

search can search in either FULLTEXT, ATTRIBUTES or BOTH. After the expansion (finding variations) of the 

terms, you can select multiple expanded terms and form the query for searching.  

Fuzzy searches can also be combined with other search types using the ADD(OR) button.  

Fuzzy Search Example:  

A search for “fat” could return dat, fax, hat, pat, etc., if these terms exist in the scope of your 

search.  

1.  Select Fuzzy Search tab in Advance Query Builder.  

Enter the fuzzy search term to expand in the Search Word field.  

Optional: Adjust the Fuzzy Factor which defines the strictness of expansion. The default fuzzy 

factor is 50%. Increasing the fuzzy factor will search for less similar terms, while decreasing the fuzzy factor 

will search for more similar terms.  

Use the Expand Using… drop-down to expand the search term using Both, Fulltext or Attributes.  

  
Optional: Use the Hide Term Count checkbox to show the document counts for each expanded 

term.  

Click the Expand button to display the terms.  

Check the boxes next to the term(s) to search from the list.  

When you select multiple expanded terms, the default Term Combining Operator is OR.  You 

can change this to AND or NOT, as desired, using the drop-down list.  

Click the ADD (OR) button to add the terms to the Query 

Field. Click the Search button to execute the search.  
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NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Synonym Search  

The Synonym Search enables you to list all the terms that are synonyms of the term you 

provide. Synonyms can be searched in either FULLTEXT, ATTRIBUTES or BOTH.  After the expansion (finding 

synonyms) of the terms, you can select multiple synonyms found and form the query for searching.  

Multiple terms can be expanded at the same time. For expanding multiple terms, separate each 

term with a space.  

If any synonym for a term exists, but that term does not exist in the system, those synonyms 

will not be listed in the expansion window as shown below.  

  

If needed, the expanded synonym list can also be exported to.csv file.  

    

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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Synonym Search Example:  

House is a synonym for “home”. However, if the term home does not exist in the scope of data 

being searched, then the synonym house will not be listed in the synonym expansion box.  

1.  Select the Synonym Search tab in the Advance Query Builder.  

Enter the term(s) to find synonyms for in the Search Word field.  

Use the Expand Using… drop-down to expand the search term using Both, Fulltext, or 

Attributes.  

  
Optional: Use the Show Term Counts checkbox to show the document counts for each 

expanded term.  

Click the Expand button to display the terms.  

The terms found (and counts for each term, if Show Terms Counts is selected) are displayed.  

Check the boxes next to the term(s) to search from the list.  

When you select multiple terms, the default Term Combining Operator is OR. You can change 

this to AND or NOT, as desired, using the drop-down list.  

Click the ADD (OR) button to add the terms to the Query Field.  

Click the Search button to execute the search.  
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NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Tag History Search  

The Tag History Search enables you to search for documents tagged/untagged with the selected 

tags. Multiple tags can be combined using a Boolean operator (AND, OR, NOT) to form complex queries. The 

Tag query can also be combined with other queries.  

1. Select the Tag History Search tab in the Advance Query Builder.  

2. Check one or more tags to search for in the Tag Name(s) list. The tag names can be checked and 

selected from different pages if available. 

NOTE: When you select multiple tags, the default Tag Combining Operator is OR.  You can 

change this to AND or NOT using the Tag Combining Operator drop-down (bottom left), as desired.  

3. Add the tag (s) to the Search Query textbox by clicking the Add (OR) button.  

NOTE: Use the drop-down arrow on the button to select the appropriate Boolean operator 

if you wish to combine the tags with an existing query in the Search Query textbox. If the Search Query 

textbox is empty, then selecting any Boolean operator has the same effect as there is nothing to 

combine with.  

4. Click the Search button.  

The files with the selected tags are displayed in the Document Table.  

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Tags Search  

“Tags Search” is removed from “Field Search” and added under “Tag Search History”  in 

Advanced Search page. 

Tags Search works as below: 

The Search By Tag section enables you to search for the documents tagged with the selected 

tags. Multiple tags can be combined using a Boolean operator (AND, OR, NOT) to form complex queries. The 

tag query can also be combined with other queries.  

 

1.       Select Search By Tag tab in the Search Options. 

  

2.       Check one or more tags you wish to search for in the Tag Name List. 

  

3.       When you select multiple tags, the default Tag Combining Operator is OR.  You can change 

this to AND or NOT, as desired. 

  

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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4.       Add the tag (or Tags) to the Search Query textbox by clicking the ADD(OR) button.  Use 

the appropriate Boolean operator if you wish to combine the tags with an existing query in the Search Query 

textbox. If the Search Query textbox is empty then selecting any Boolean operator has the same effect as 

there is nothing to combine with. 
  

 

 

 

 

8.6.10    Image QC 

User should be able to see “Image QC Search” option in the Advanced search page and the 

dropdown should have following options: 

TIFF Status – Hard Limit Imposed (Find documents with a hard limit imposed) 

Slipsheet – Has Slip sheet or Has Slipsheet on First Page (Find documents with a slipsheet or has 

a slipsheet as the first page) 

Has TIFF or Do Not Have TIFF (Find documents with or without a TIFF) 

Has blank page, All pages are blank to find document with blank pages 

Has right cutoff > Find documents with image cut off 

Is cutoff fixed - Find documents with image cut off fixed 
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NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

 

Review Set Batch Search  

The Reviewset Batch Search enables you to search for the documents in a review set batch. 

multiple review sets, batch statuses, and reviewers can be combined using a Boolean operator (AND, OR, 

NOT) to form complex queries. The Reviewset Batch Search query can also be combined with other queries.  

1.  Select the Reviewset Batch Search tab in the Advance Query Builder.  

Check one or more Review Sets you wish to search for in the Reviewset drop-down list.  

Optional: Select a status from the Batch Status drop-down list.  

Optional: Select a reviewer from the Reviewer(s) drop-down 

list. Click the Apply button.  

A list of the matching batches is displayed.  

Check one or more items to search for in the Reviewset Batches list.  

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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NOTE: When you select multiple Reviewsets or Batches, the default Term Combining 
Operator is OR.  You can change this to AND or NOT using the Term Combining Operator drop-down 

(bottom left), as desired.  

Add the Reviewset Batch(es) to the Search Query textbox by clicking the Add (OR) button.  

NOTE: Use the drop-down arrow on the button to select the appropriate Boolean 
operator if you wish to combine the reviewset batch(es) with an existing query in the Search Query 
textbox. If the Search Query textbox is empty, then selecting any Boolean operator has the same effect 

as there is nothing to combine with.  

Click the Search button.  
The files with the selected reviewset batches(s)are displayed in the Document Table.  

  

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

Tags Conflict Search 

The Tags Conflict Search allows you to search for the records having tag conflicts. Tags Conflict Search 

helps you in filtering the tags, type of the tags whether it is inclusive or exclusive, and the description of 

the unfollowed rule. 

 

    

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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You can select the tags and rules by combining using a Boolean operator (AND, OR, NOT) to form 

complex queries. 

Non-Processable Search  

Normally, in search results we do not list system, denist, or archives files.  In order to make 

those documents searchable, we have provided a search section for Non-Processable files.  VOD supports 

the following non-searchable search fields:  

  

• De-NIST Files: This searches for original denisted files.  

• Archive: This searches for original archive documents.  

0 Password Protected Archives:  This searches for archives that are password protected.  

○ Corrupted Archives:  This searches archives that are corrupted.  
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○ Processed Archives:  This searches archives that are 

processed. ○ Errored Archives:  This searches archives that are errored.  

• No-Text: This searches all the original documents whose fulltext file does not exist. This includes 

images, archive, system and De-NIST files as well.  

• System Files:  This searches for original system files.  

• Exception Files: This searches for Exception files.  

0 Password Protected: This searches for original password protected documents.  

○ Corrupted:  This searches for original documents that are corrupted.  

○ Unknown Documents: This searches for original documents that were not recognized by the 

system.  

○ Non-Processed: This searches for original documents that were identified by the system but that 

could not be processed by the system.  

Like any other field searches, non-processable field searches can be combined with Boolean 

operators.  

Example 1:   

(IsArchive = "True") AND (IsPasswordProtected = "True")  

This will search for all the documents that are password protected and are archived.  

Example 2:  

(IsDenist = "True" OR IsSystem = "True")  

This will hit all documents that are either system or are De-NIST files.  

NOTE: Tags cannot be applied in System and/or De-NIST documents. We cannot apply tags to 

archive documents either.  

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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Folder Search  

The Folder Search section enables you to search for the documents added into a folder.  

Multiple folders can be combined using Boolean operator (AND, OR, NOT) to form complex queries.  The 

folder query can also be combined with other queries.   

1. Select Folder Search tab in the Search Options.  

  

2. Check one or more folders you wish to search for in the Folder Name List.  

  

3. When you select multiple tags, the default Folder Combining Operator is OR.  You can change this to AND 

or NOT, as desired.  

  

4. Add the folder (or Folders) to the Search Query textbox by clicking the ADD(OR) button.  Use the 

appropriate Boolean operator if you wish to combine the tags with an existing query in the Search Query 

textbox. If the Search Query text box is empty then selecting any Boolean operator has the same effect 

as there is nothing to combine with.  

5. You can use the Export Folders to export the folder list to a CSV file.  

6. Click the Search button. 

  

 

NOTE: 
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• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Saved Search 

Saved Search allows the user to use the saved search and combine with other searches to create a new 

search to find the documents. On clicking Advanced Search, you can click on the Saved Search dropdown. 

This will display all your Saved searches.  

 

You can select your search and if you want to combine with other searches, click on Add button and select 

the operator you want to use. The options are AND, OR, and NOT. 

 

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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 Once you select the operator, it is displayed on the search bar on the top of the screen. 

 

 You can combine with other searches and then click on . This will display all the documents based on your 

search query in the Review page. 

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

 

Distributed Job Search 

Distributed job search will search the documents that are in the selected job either queued, 
processed or not processed depending upon the selection of option in search wizard.  

You can choose different distributed job types from the drop-down menu of the distributed job 
search.  

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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In Distributed Job Search, the drop-down menu shows different jobs associated with the project.  You 
also have the option of selecting the processing machine.  

The available Distributed Jobs that can be searched are:  

1. HTML Conversion  
2. Inclusive Email Identification   
3. Indexing  
4. Import 
5. Language Identification  
6. Native Pre-fetch  
7. Near Duplicates  
8. OCR  

9. OCR Generated Tiff 
0. OCR Redacted Tiff 

0. Predict 

0. Print 

0. Promote Data-Document Information 
0. Promote Data-File Copy 

0. Promote Data-Work Product 

0. RTF Conversion 

0. TIFF 

0. TIFF Pre-QC 

0. VAR Training 

For every distributed job selected from the drop-down list you also have the following options:  

1. Queued Files: This option when selected will give you the documents which are queued for the selected distributed 
job.  If a document is not queued, it will not be returned.  

Queued files have three different options:  
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 .Processing Pending:  This will return documents which are queued for the job but have not yet been processed.  

 .Processing Successful:  This will return documents which are queued and processed successfully.  

 .Processing failed:  This will return documents which are processed but failed.  

 .Not Queued Files:   : This option when selected will give you the documents which have not been queued for the 
selected job type.  

 

  

To specify a processing machine, select the Processing Server from the drop-down menu.  

1. HTML Conversion  

When this distributed job type is selected, jobs related to HTML/MHT will appear in the list below. If you 
select the Job ID and run a search, it will return documents which were sent for HTML/MHT Conversion.  

 
If you select the Has HTML option and add for search, the search will return all documents which have a 

HTML files associated. 

0. Inclusive Email Identification  

When this distributed job type is selected, jobs related to Inclusive Email will appear in the list 
below. If you select the Job ID and run a search, it will return documents which were sent for Inclusive Email.  
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0. Indexing  

When this distributed job type is selected, jobs related to Indexing will appear in the list below. If you 
select the Job ID and run a search, it will return documents which were set for Indexing.  

 
 

4.Import 

When this distributed job type is selected, jobs related to Import will appear in the list below. If you 
select the Job ID and run a search, it will return documents which were set for Import.  
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5. Language Identification  

When this distributed job type is selected, jobs related to Language Identification will appear in the list 
below. If you select the Job ID and run a search, it will return documents which were sent for Language Identification.  

 

 

 6. Native Pre-fetch  

When this distributed job type is selected, jobs related to Native Pre-fetch will appear in the list below. 
If you select the Job ID and run a search, it will return documents which were sent for Native Pre-fetch.  
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7. Near Duplicates  

When this distributed job type is selected, jobs related to Deduplication will appear in the list below. If 
you select the Job ID and run a search, it will return documents which were sent duplicate processing.  

When the checkbox for “Character less than THRESHOLD” is selected, it will return documents which 
have less than 512 characters.  

 

8. OCR Image/PDF Image  

When this distributed job type is selected, jobs related to OCR extracted from image files will appear in 
the list below. If you select the Job ID and run a search, it will return documents which were sent to be OCR’d.    

There are different types of Errors that could occur when processing OCR. The OCR Image/PDF Image 
job type search will also allow you to locate documents with the following:  

● File Access Fail  

● Image Conversion Failed  

● PDF Conversion Failed  

● Page(s) failed to OCR  

● Unknown Error  
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You can also choose to search for documents which either Have OCR Text or Do Not Have OCR Text in 
the OCR Text options.  

  

To run an OCR Search to locate documents which contain OCR Text:  

1. Select the OCR Search tab in the Search Options.  

2. Select one or more combinations from Job ID’s, Document with errors and OCR Machines.  

3. Add the selected combinations to the Search Query textbox with appropriate Boolean operator I fyou wish to 
combine the query with an existing query in the Search Query textbox. If the Search Query textbox is empty, 
selecting any Boolean operator has the same effect as there is nothing to combine with.  

4. Click the Search button.  

5. In the search results, you can check the Show OCR field option to list out the following columns in the Search 
results.  

 

9. OCR Generated Tiff  

When this distributed job type is selected, jobs related to OCR Generated Tiffs will appear in the list 
below. If you select the Job ID and run a search, it will return documents which were sent to OCR Generated Tiff jobs.    

There are different types of Errors that could occur when processing OCR for TIFF’d documents. The 
OCR Generated Tiff job type search will also allow you to locate documents with the following:  

● File Access Fail  

● Hung in OCR  

● OCR MODI Error  

● Error Saving in Temp  

● Unknown Error  

  
You can also choose to search for documents which either Have OCR Generated TIFF Text or Do Not 

Have OCR Generated TIFF Text in the Generated Text options.  
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10. OCR Redacted Tiff  

When this distributed job type is selected, jobs related to OCR of Redacted Tiff will appear in the list 
below. If you select the Job ID and run a search, it will return documents which were redacted and sent to be OCR’d.    

 

There are different types of Errors that could occur when processing OCR. The OCR Redacted Tiff job 
type search will also allow you to locate documents with the following:  

● Redaction Burn Failed  

● File Access Error  

● Hung in OCR  

● OCR MODI Error  

● Error saving in Temp  

● Unknown Error  

You can also choose to search for documents which Have OCR Redacted Text, Does Not Have OCR 
Redacted Text or Have Outdated Redacted Text in the Redacted Text Options. 

11. Predict  

When this distributed job type is selected, jobs related to Prediction will appear in the list below. If you 
select the JobID and run a search, it will return documents which were sent to VAR Prediction.    
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You can also select a VAR Profile to search for the documents associated with that profile.  

 

 

12. Print 

When this distributed job type is selected, jobs related to Print will appear in the list below. If you select 
the Job ID and run a search, it will return documents which were sent to Print.   

 
 

13. Promote Data-Document Information 

  When this distributed job type is selected, jobs related to Promote Data-Document Information will 
appear in the list below. If you select the Job ID and run a search, it will return documents which were sent to Promote 
Data-Document Information.  
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14. Promote Data-File Copy 

 
  When this distributed job type is selected, jobs related to Promote Data-File Copy  will appear in the list 
below. If you select the Job ID and run a search, it will return documents which were sent to be converted toPromote 
Data-File Copy.    

 
 

15. Promote Data-Work Product 

 
  When this distributed job type is selected, jobs related to Promote Data-Work Product will appear in the 
list below. If you select the Job ID and run a search, it will return documents which were sent to be converted to 
Promote Data-Work Product.    
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16. RTF Conversion  

When this distributed job type is selected, jobs related to RTF Conversion will appear in the list below. If 
you select the Job ID and run a search, it will return documents which were sent to be converted to RTF.    

 

If you select the Has RTF option and add for search, the search will return all documents which have a 
RTF files associated. 

17. TIFF  

When this distributed job type is selected, jobs related to TIFF Conversion will appear in the list below. 
If you select the JobID and run a search, it will return documents which were sent to be TIFF’d.    

There are different types of Errors that could occur when processing TIFF. The TIFF job type search will 
also allow you to locate documents with the following:  

● Timeout Error  

● File Access Error  

● Failed to Open Native File   

● Display Engine Unavailable  

● Unknown Error   

● Has Blank Page(s)  

● All Pages Are Blank  
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In addition, you can also search for the following attributes for the TIFF distributed job type:  

  

● TIFF Status – Hard Limit Imposed (Find documents with a hard limit imposed)  

● Slipsheet – Has Slip sheet or Has Slipsheet on First Page (Find documents with a slipsheet or has a slipsheet as the 
first page)  

● Redacted TIFF –  Has Redaction (Find documents with redactions)  

● Manual TIFF – TIFF or TIFF Skipped (Find documents with or without a manually created TIFF)  

● TIFF QC – Good Document, Bad Document, QC Skipped, Good TIFF, Bad TIFF (Find documents with QC attributes)  

● TIFF – Has TIFF or Do Not Have TIFF (Find documents with or without a TIFF)  

  

  

To run a TIFF Search to locate documents which contain TIFF Files:  

1. Select the Tiff Search tab in the Search Options.  

2. Select one or more combinations from Job ID’s, Document with errors and Tiff Machines.  

3. Add the selected combinations to the Search Query textbox with appropriate Boolean operator if you wish to 
combine the query with an existing query in the Search Query textbox. If the Search Query textbox is empty, 
selecting any Boolean operator has the same effect as there is nothing to combine with.  

4. Click the Search button.  

5. In the search results, check the box Show TIFF Field to list out the following columns in the result. 

18. Tiff Pre-QC  

1. Open project and click on the Search icon  

2. Click on Distributed Job Search tab in the Search window.  

3. Select Tiff Pre-QC Distributed Job type.  

4. Tiff Pre-QC block should be displayd which will have the option of Has blank page(s), All Pages are blank and 
Has right cutoff.  
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0. The search result will display documents with any blank pages blank if Has blank page(s) option is selected while 
searching and documents with all pages blank will be displayed if All Pages are blank option is selected.  

 

 19. VAR Training  

When this distributed job type is selected, jobs related to VAR Training will appear in the list below. If 
you select the JobID and run a search, it will return documents which were sent to VAR Training.    

You can also select a VAR Profile to search for the documents associated with that profile. 

 

 
 

NOTE: 

• While searching, if you use skipped characters, the result will skip such characters. For more 

information, please refer here. 

• System considers few stop words and excludes them during indexing. For detail information, please 

refer here. 

https://support.veniosystems.com/hc/en-us/articles/20492846583315-Searches-Involving-Skipped-Characters
https://support.veniosystems.com/hc/en-us/articles/20450464605331-Indexing-in-Lucene
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8.7  REGEX Searching  

A regular expression or regex is a sequence of characters that define a search pattern. For 

example, phone numbers, Social Security numbers, or dates.  

On the Search Bar, you can run regex searches as well. For regex searches, the syntax should be 

in the following format: FULLTEXT (REGEX ("reg_ex_here")) to search the text of the documents and 

ATTRIBUTES (REGEX ("reg_ex_here") to search the metadata of the documents. Any documents found will 

display. When doing a full text REGEX search, terms will be highlighted within the documents. REGEX 

searches can be combined with field searches as well.  

For example, the syntax of some REGEX searches could be:  

• FULLTEXT(REGEX("\d{1,3}"))  

• ATTRIBUTES(REGEX("\d{1,3}"))  

• (ATTRIBUTES(REGEX("\d{1,3}"))) OR CUSTODIAN_NAME = "Cust1"  

• (FULLTEXT(REGEX("\d{1,3}"))) OR CUSTODIAN_NAME = "Cust2"  
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9 Production  
 

Note: Please change the link for the Production 2. The URL is:  

…VenioWeb/OnDemand/AppPlus/#/production/production?projectId=3   
  

To access the old URL, you can use this link:  

...VenioWeb/OnDemand/AppPlus/#/production2/production?projectId=3  

For Document support for the old URL, please refer to the VenioOne OnDemand documents of 

V9.4.0.0 or earlier.   

Documents may be sent to production from the following three areas:  

• Production link in the Case launchpad (shown below)  

• Send to Production button on the Analyze page (see section above)  

• Send to Production button on the Review page  

  
Either of those options will bring you to the Create Production page.  

http://qc02.veniosystems.net/VenioWeb/OnDemand/AppPlus/?projectId=3#/production/production
http://qc02.veniosystems.net/VenioWeb/OnDemand/AppPlus/?projectId=3#/production/production
http://qc02.veniosystems.net/VenioWeb/OnDemand/AppPlus/?projectId=3#/production2/production
http://qc02.veniosystems.net/VenioWeb/OnDemand/AppPlus/?projectId=3#/production2/production
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The options available under the source are:  

• New Production:  Create a new template or select a previous template.  

• Reproduce:  Re-produce the previously produced data. Production settings can be changed. The 

scope of the production will not exceed previously produced files, but it can be subset of previous 

production based on which source is selected.   

• Create Production Template:  Create a new template.   

• Edit Production Template:  Edit existing templates.    

• Delete Production Template:  Delete existing templates  

• Delete Production:  Delete the previous production  
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9.1  Create Production  

1. Select New Production from the Source Option dropdown.  

Note:  If you want to produce using a previously created template, select an existing Template from the 

available production Templates dropdown.   

2. Enter a product name in the Name input box.  

3. Select a document source from the Select Source dropdown.  

a. By Tag – When you select Tag as the source in the Create Production page, tags will be listed 

in the Select Source tags. The number of documents that will be produced when selecting a 

tag will also be displayed. Select the desired tag(s) and the combining operator (OR or AND).  
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b. By Folder – When you select Folder as the source in the Create Production page, the folder 

name and the number of documents that will be produced when selecting a folder will also be 

displayed. Select the desired folder(s) and the combining operator (OR or AND).  

 

c. By Media – When you select Media as the default source on the Create Production page. With 

media selected as the source, all the custodian names and media will be displayed with 

document counts for each media.  

 

d. By Dynamic Folder - Select the Image set to be produced.  

    

  

    

  



© Venio Systems, Inc.   11.7.0.0  Page | 284  

 

e. By Image Set -    Select the Image set to be produced  

 

4. Include Option  

When the document is to be produced by Custodian or Media, you can use the Select 

Deduplication option.  

Duplicate Options:  

• No De-Dupe: All duplicates are produced.  

• Project Level De-Dupe:  Static Project Level original documents are produced  

• Custodian Level De-Dupe:  Static Custodian Level original documents are produced.  

5. Source Advanced Option: You have the options for the source documents that you can include in the 

export in the source advanced options.  
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De-NIST: All the De-NIST files will be included.  

• System: You will be able to produce system files as well.  

• Archive: Archive files will be produced if this option is selected.  

• Include Non-email archive as a parent: Non-email archive files will be selected as parents.  

• Include all documents in Parent-Child Family (Selected Production Criteria): Whole parent-child 

family will be exported. This is the default selection criteria for production.  

• Include all documents in Email Thread (Selected Production Criteria): Whole email thread will be 

produced. This is also the default selection of production.  

• When parent document is not produced, child document should be treated as parent document: 

Child documents will be produced as parent document during production if this option is selected.  

• Do not produce documents for selected tags: You can choose tag(s) for which you don’t want to 

produce the documents.  

Click on the Production Setting button to go to the next page.  

9.1.1  Production Setting  
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9.1.1.1  Production Folder Structure  

In Production Folder Structure, you can choose the option to produce FullText, Native, and/or 

Image files.  

  

9.1.1.2  Date Option  

In the Date Format, select any of the date format options provided from the drop-down list to 

produce. Click Production Format to continue.  

  

Blank Dates Settings: Choose from two options:  

• Replace Blank Date with Empty (“”)  

• Replace Blank Date (N/A or 00000000)  

If you select Option 1, the blank dates are replaced with empty (“”).  If you select Option 2, you 

will be asked to select from the drop-down list to replace blank date with a specific option.  
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You can also select the production time format from the options provided in drop-down from 

Production Time Format option.  

9.1.1.3  Fulltext option  

Click on the Fulltext option link to open the Fulltext - Advanced Options UI.  1. 

Fulltext – Advanced Options  

  

• Include Email Header: Add email header in a produced text file  

• If the email body is empty, produce text file with the email header-only: Export the text file with the 

email header.  

Note: If this option is not selected, a slip-sheet text file is produced.  

• Prepend selected field value at beginning of exported Fulltext file: Add selected field value from the 

drop-down at the beginning of exported text file.  

• Fulltext Encoding: Encoding options for produced text files are UTF8, UTF 16, or ANSI.  

Note: ANSI encoding does not support foreign language  

2. Exclude  
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• Produce Only Selective Fulltext: This option enables you to produce or not produce full-text for 

selected tag documents.  

• Do not produce full-text for selected tags:  Text for documents in selected tags is not produced.  

• Produce full-text for selected tags: Text for documents in selected tags is produced. Documents that 

are not in selected tags are not produced.  

3. Not Produced   

• Create a placeholder file: Create a slip sheet text file for a document that is not produced.  

• Content of placeholder file for full-text email: Verbiage for slip sheet text for email  

• Content of placeholder file for full-text edoc: Verbiage for slip sheet text for edocs  

Note: Click on Add Field link to add selected field value in slipsheet verbiage.  

• Do not create a placeholder file:  Slipsheet is not created when documents are not produced.  

4. Missing Document  
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• Create placeholder file: Create a slipsheet text file for document without text. o Content of 

placeholder file for fulltext email: Verbiage for slipsheet text for email o Content of 

placeholder file for fulltext edoc: Verbiage for slipsheet text for edocs  

Note: Click on Add Field link to add selected field value in slipsheet verbiage.  

o Do not create placeholder file:  Slipsheet is not created for documents without text.  

5. Preference  

    



© Venio Systems, Inc.   11.7.0.0  Page | 290  

  
Order priority of the document text to be exported for documents without produce 

preference:  
Sets the order in which text file is chosen for produce.  

Note: Use document level produce preference when applicable option has higher precedence than this 
setting.  

Native Option  

1. File and Extension  
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You can select the Native Option link to add more option for Native Export. In Native Filename 

and Extension Option wizard you can select between the Native File Extension Option that VOD recognizes 

and the Original Extension while exporting. You can add extensions to files with no extensions while 

exporting. You can either leave the extension empty as it is, use the recognized extension, or give an 

extension to be replaced with.  You can check the “Do not copy native, use repository native file path” 

option, to not copy native to the NATIVE export location but just put the location of the file being copied.  

After selecting these options, click on File Option.   

2. File Option  
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The File option wizard allows you to replace PST/MSG, MBOX/EML and NSF/DXL files into 

various options shown in the image above.  

If you want to produce redacted native files, click on the Produce redacted native, if available 

checkbox under Redacted Native Files section. It displays the number of native redaction entries out of the 

total documents selected. For example, If there are 0 documents with no redactive entries, a message is 

displayed as shown.  
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Note: PST/MSG can be replaced by msg, mht/html, and rtf extensions. MBOX/EML files are replaced by 
eml, mht/html, and rtf files, and NSF/DXL are replaced by html/eml, html/mht, rtf, and dxl files.  

3. HTML Production  
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File Option – The HTML Export wizard allows you to replace the native file of the exported files 

by html. You may check the option to “Replace native of this document types with html and select from 

selected document types to be replaced by html. You may also exclude PST/MSG, MBOX/EML, and NSF/DXL 

by selecting All documents (Except PST/MSG, MBOX/EML, NSF/DXL filetypes).  

Redacted Native Files – Redacted natives are exported if the checkbox to Export redacted 

native, if available is selected. Also, the count of the documents having native redaction is displayed as 

shown above.  

4. Exclude  
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Click Exclude button, select the radio button ‘Do not produce native for selected tags’ and select 

the tags you want to exclude. The natives of the documents with the selected tags will not be produced or 

select the radio button ‘Produce Native for selected tags” to include natives of the document with selected 

tags.  Click on “Do not produce native for documents with redaction and their parent documents” to exclude 

documents with redaction and parent documents.   

5. Not Produced  
Click Not Produced to add Placeholder settings when native is not produced.  
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• Select the radio button “Replace with Placeholder text file” and provide the text to replace the file. 

Click on Add Field where the placeholder text should be placed. 

• Select the radio button “Replace the multi-page image when available”. You can also view the 

documents which were not imaged in the search result from this option.  

• If the image for the document is missing, you can replace with the placeholder text by selecting the 

Replace with placeholder if image for the document is missing checkbox. 

• You can load the template from the dropdown, decide the location of the placeholder, and enter the 

placeholder text. 

• You can also browse and select the placeholder image file and preview the image. 

• Select “Do not produce anything” to not export anything at all.  

6. Missing Documents  
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Click Next to add Placeholder settings for missing Document.  

• Select the radio button Create placeholder file.  

• Enter content of the placeholder file for email fulltext. You can also enter content of the placeholder 

file for EDOC fulltext.  

Add Field where the placeholder text should be placed.  

• You may also skip this setting by selecting Do not create placeholder file.  

• You may also use the hash value option for missing documents by selecting Use hash of empty string 

for missing document or Leave hash value field blank for missing document.  

  

Image Options  

You can select the image option link to add more options for Image produce.  

1. Page Option   
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In the Image page option wizard, you have multiple options for image pages. You can select the 

single page images or the multipage images. You can select the searchable PDF or non-searchable PDF. If you 

select the single page option, you can also choose to Export color images as jpg. Also, if you select 

Searchable PDF, you have the option to choose to export Parent/Child as a single PDF file. You may also 

include the page count in the load file produced and specify Image Volume Name by specifying name in 

Image Volume Name field   

2. Include/Exclude  
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The Image Include/Exclude Option wizard has options  
o Exclude or include Image for the files with different tags and files with different 

extension.  
o Produce Native File in Native folder. This option is enabled when native option is not 

selected. o   Do not export image page(s) which are identified as blank by TIFF Pre-QC 

or manual marked as blank  
  Select any of these options and click Redaction Options.  

3. Redaction Options  
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In the Redaction options wizard page, you have different options for redacted images. You can 

choose to export the original image without redactions or export redacted images. While exporting a 

redacted image you can either export only selected redaction objects or select all the redaction objects. All 

the redaction objects will be listed when you select the option “Select redaction set(s)”. Select the options 

and click Place holder option when image not produced.  

4. Not Produced  
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The Image not produced wizard allows you to select different options when image is not 

produced. Checking the option “Produce native file in native folder” produces native files into native folder.  

You can also put placeholder text for image files. Enter the placeholder text and add fields.  

The placeholder file can be custom made, which is located in your local drive, or the ones 

created by VOD. Either of these files can be used. You also have the option to export native files for the files 

whose image is not produced, or to not produce anything at all.  

5. Not Available  
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The Image not available wizard allows you to select different options when an image is not 

produced.  Checking the option to “Produce native file in native folder” produces native files into native 

folder. You can also put placeholder text and add the fields for the image files. The placeholder file can be 

custom-made and imported from your local drive, or the ones created by VOD. Either of these files can be 

used. You can select a placeholder image file to be produced when image is missing. You can also choose to 

produce the native files in place of the image files or choose to not produce anything at all for the files 

whose images are not produced.  

Placeholder option can be added from templates created in slipsheet. Select the value to be 

loaded from drop-down value in template. The value that has been set in slipsheet will be displayed in 

produced image.  

6. Image Option  
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You can change the size of the produced image from Image Option. You can change width and 

height. You can also change DPI as well.   

Advance Option  
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• Create production folder With You can select both Custodian and Media Name or select Custodian 

Name only.  This will determine the folder structure during production. You also have the option 

to reset the number of the folder for every new folder created with custodian/media name.  

• Produce Native and Full-Text File Path in Load File As:  

• You can select how you want the file path to be produced in the load file.  

o Absolute Path  

C:\Venio\Export\Export_Folder\Full_Text\Custodain_Name\Media_Name\001\000001. 
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msg  

o Relative Path   

Full Text\Custodain_Name\Media_Name\001\000001.msg]  

• Produce Folder Name Settings: You can enter the folder names you want to use for the Full Text, 

Native Files, and Image Files to be exported to. You can also provide the number of fulltext files to 

be produced per folder. The default value for which is 1000 files per folder. You also have the 

option to choose to place all the Image pages in one folder with the option Document level and 

Page level.  

• Volume Option:  You have the option to either produce in a single volume or split the volume 

based on size, custodian, and the number of files. When the option for size is selected, you then 

have the option for CD size, DVD size, or custom Size. The production will split as per the size 

selected. The volume name can be given as per the prefix, start number, and Padding. When the 

option for the custodian is selected, the prduction will split as per the custodian selected in the 

source.  

• Produce as Single Volume: You have the option to select produce as a single volume which will 

produce all documents in a single volume.  

• Produce Password for File: You have the option to produce the list of passwords for all the 

password-protected files.  

9.1.1.4  Load Files  

.  The Production Format tab lists the available load file and image load formats.  

  

• CSV: Delimited load file with comma as field separator and double quote as field qualifier.  

• DAT: Delimited load file with Concordance default delimiters and field qualifier.  
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• Custom Delimited Format: Delimited load file with custom field separator and field qualifier.  

• EDRM: Electronic Discovery Reference Model XML load file format.  

• LAW EDRM: Electronic Discovery Reference Model XML load file format compatible with LAW.  

• Summation (EDII) Format: Load file format compatible with Summation.  

• Ringtail (MDB) Format – Load file format compatible with Ringtail.  

• Generate Cross Reference File: Generate a cross reference load file with relative file path and 

control number of exported documents.   

• Image Load File Format: This option is only available if images are part of export. The following 

image load file formats are supported:  

Concordance  

Opticon  

IPro LFP  

Summation  

DII  

NOTE: You can export without selecting any load file format. This will complete the export, but there will 
be no load files generated. Depending on what imaging options are selected, either an IMAGE or PDF folder will be 

created and the TIF or PDF image files only will be exported with no load files.  

Advanced Options  

The Advance Options link (upper right corner) displays the following options:  

  

To select any delimiter option, select from the Duplicate Options, Select Character from the 

available drop down, and click OK.   

9.1.1.5  Field  

Select fields to produce with the steps below:  
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Venio Field  

1. Select Venio fields and custom fields for production from this screen. Click Add to add the selected 

fields.  

  

2. Remove individual fields by clicking the Remove button or select multiple fields from the checkbox 

and delete them in bulk. To create new template, select New Template from drop down and select 

required fields from Add field UI and Save.  
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Note:  Select a previously created field template in the drop-down. Templates can also be updated or 

deleted.  

Add New Field  

You can add fields from the Production Settings screen as shown in the image below.  

To add a new field:  

1. Click Fields tab in the Production Settings screen.   

The available fields are displayed.  

2. Click the “+” button to add the Fields.  

  

3. Venio Fields: Select the fields to produce. Select the field name under Field Name to edit the field 

name.  
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4. New Field: Select the group from the Group drop down, Enter Field Name and Production Field 

Name. Add description in the Description field.  

  

a. Empty Field: Create a field without value in the export load file.  
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b. Merge Field: Create a multi-value field by combining values from two or more fields 

separated by a selected field separator.  

             Click the “+” button to add the Fields.  

You can add fields from the Merge Production Field Selection screen as shown in the image 

below. 

 

The field name, production field name, and its description column are shown along with its 

group and data type. The field name “Email Any Address” must be selected. 

Data type is categoried to: 
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                       Select more than one column and click on the Add button. 
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c. Priority Field: Create a field with value from one of the Selected Fields. The value is chosen 

from the first non-empty field in the priority order. Field at the top has the highest priority.    

             Click the “+” button to add the Fields.  

   You can add fields from the Priority Production Field Selection screen as shown in the image 

below. 

 

The field name, production field name, and its description column are shown along with its 

group and data type.  

Select more than one field and click on the Add button. 

Added fields are added to add fields from available fields.  
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                    d. Custom Field: Users can create their own field by using Custom Field type.   
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   [Optional] Click Save to create export field template for future reuse.   

Note: The 'Save' option comes only when we select the New Template option in the drop-down.  

  
Note:  Select a previously created field template in the drop-down. Default Templates cannot be updated 

or deleted.  
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You need to map the Relativity fields when Relativity is selected. On selecting the attachment, the system 

itself checks the validity. On hovering over  following help is provided for validity. 

 

If there are two attachments selected and there is some warning, the message is displayed accordingly. 

 

 

If all the parameters are valid, green tick mark is displayed and you can proceed ahead. 

9.1.1.6  Document Sorting  

In the Document Sort Order window, you can sort the document order by selecting field. You 

can choose fields from the dropdown and choose to sort it by ascending or descending order.  
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9.1.1.7  Tag Option  

TAG_NAMES field should be selected to enable this option.  

Produce Tag in Single Field:  All the selected tags will be produced into a single column.  

  
Produce each tag in individual field:  The selected tags will be produced into individual single 

columns. You can select individual tags or all tags for the tag fields.  

  

9.1.1.8  Saved Search Option  

SEARCH_HIT_TERMS field should be selected to enable this option. You can select save search 

to produce the search expression.  
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9.1.1.9  Control Number Settings  

In the Control Numbers Setting window, you can assign control numbers and bates numbers to 

the produce. Control Numbers will be used as the file names for produced fulltext, native, and image files. 

The name of produced files can be changed by adding a prefix.  You can adjust the starting number of the 

produced files and pad the number as you need.  This Control Number will be populated back into VenioOne 

after the produce for future reference.  Click Next to continue once you establish the numbering settings.  

  
Documents will be produced into the folders which the user specifies.  

Folder Structure: Padding Structure for Fulltext, Native and Image  

 
o Prefix o Start Number o Padding  
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With this option, the folder will be created in the following format. For example, Prefix = “Fol”, 

StartNumber = “5” and Padding = 8, then the folders will be created as “Fol00000005”. This folder will be 

created under the fulltext, native, and image folders.  

Native and Fulltext Filename Option  

a. Control Number: Selecting this option will use the control number for Native and Fulltext Filename.  

b. Bates Number of first page of image: This will use file name according to the bates number structure 

selected.  

c. Use original filename prefixed with control number/bates number: This will use original filename 

prefixed with control number and bates number.  

 Bates Number Structure: Padding Structure for Tiff file.  

1. Generate sequential number: Bates number will be used as image filename  

o Prefix o Start number o Padding  

2. Generate bates number from control number: Bates number from control number structure will be 

used as image filename.  

Example of bates number with control number option:  

o <CONTROL_NUMBER> for the first page o 

<CONTROL_NUMBER>_00000002 for the 

second page o 

<CONTROL_NUMBER>_00000003 for the 

third page and so on.  

You can click on Advance Option to add desired suffix to the bates number by default  the 

_ is the suffix added to the bates number.  

3. Use System Bates: System Bates number generated for images will be used for Bates number 

structure. If all the files do not have this number, then you will be prompted with a warning message.  

4.  You can also view the files without bates number by clicking on the link “File Without System 

Bates”. This link will redirect you to search result page and lists the files without bates number. You 

can generate the bates number and close the page which will redirect to the same page. Click Next to 

continue.  

1.  Control/Bates Number Structure  

Control Number Settings have the following options:  

a. Generate Sequential numbers:   

This option will generate sequential control/bates number depending upon on the 

provided inputs.  
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▪ Prefix  

▪ Start number  

▪ Padding   

You can provide the Prefix, Start Number and Padding in the Control Number 

Settings for the  

Folder Structure and Control Number Structure. You can also provide the Prefix, 

Start Number and adding in the Bates Number Settings for Files.  

  
The fields which are produced will bear the name and number for each document, as provided 

here. If  

Export Tiff Option is not selected and just Fulltext and/or Native Export options are selected, 

then Bates Number structure settings get disabled. Only User original filename prefixed with control 

number/bates number will be enabled.  

If Export Folder Structure Option is selected as Fulltext and/or Native Export and/or Image, you 

can update the settings for Bates Number structure.  

NOTE:  Be careful to pad the numbers to allow for subsequent documents to be produced and sorted 

properly.  For example, use a 5-digit pad if you will have more than 9999 documents.  

You can also view the history of the previous exports by clicking the Production History link.  

Select any of the previous exports to update the control number to continue numbering from the last 

export.   

NOTE:  Be very careful to select the correct export.  Otherwise, you may use the wrong starting number.  

If you use a start number that has already been used for the selected export, you will get an 

error message.  Look in the Production History and enter the next available number.  

b. Generate number from source option:   

After choosing this option, click the Assign link The Control numbers from source option 

dialog will be displayed with options to choose different sources: custodian, folder, or tag. Then, you 

need to provide prefix, start number, and padding for generating control numbers.  
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Links at the bottom of the dialog provide additional options:  

• Use start number and padding as first entry: This option will set the start number and padding 

for all entries from the first entry with confirmation.  

• Continue from previous prefix: This option will set the next start number for the provided 

prefix.  

c. Generate number based on field:   

This option will list filename and custom fields to generate control/bates number. When 

filename is selected, this will generate control numbers based on the filename. In the case of custom 

fields, control number and bates number will be dependent on the bates number option selected. 

Bates numbers can either be generated by padding the page numbers onto the control number 

generated using the selected field value or by increasing the value in the selected field for each tiff 

page generated for export. Control number will be the bates number of the first page of the image.  

  

d. Generate number based on system bates number  
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System Bates number generated for images will be used for Bates number structure. 

This option will be available only when image is selected for export. If all of the files do not have this 

number, then you will be prompted with a warning message. You can also view the files without 

bates numbers by clicking on the File Without System Bates link. This link will redirect you to a search 

results page listing the files without bates numbers. You can generate the bates number and close 

the page, which will redirect to the same page. Click Next to continue.  

  

a. Advanced Options  

After clicking the Advanced Options link, the Export control/bates number settings 

advanced options dialog will be displayed where you can choose different settings to generate 

control/bates numbers.  

• Generate control number as is even if field value has already been generated as control 

number in previous exports: This option will generate the same control number even if it has 

already been used before.  

• Suffix native filename with: This option is only available when native file is exported. User can 

select to suffix native file name with the value from the selected field.  

• Generate bates number using continuous numbering: This option will generate continuous 

bates number. Option only available for generating sequential bates number and generating 

bates number from selected field (not filename).  

• Generate bates number suffixed with page number: Bates number will be generated by 

padding the page numbers to the control numbers.  

*** Bates control separator: Character to separate control and bates number  

*** Page number suffix padding: Padding length for page number to be added in control 

number  

• Include suffix in bates number starting from first page of image: This option will suffix the 

padded page number to the control number starting from the first page of the image.  

• Include suffix in bates number starting from the second page of image: This option will 

suffix the padded page number to the control number starting from the second page of 

the image. Bates number of the first page of the image will be the control number of the 

document.  

o Start suffix for second page of image with 1: This option will start suffix 

as “1” for the second page of the image. o Start suffix for second page of image with 

2: This option will start suffix as “2” for the second page of the image.  
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• Populate control Number to a Custom Field: Choosing this option lets you populate a specified 

control number in a custom field. The added custom field is automatically made available in 

the search grid to all user groups. This can be done in two different ways.  

• Create new custom field with same name as current export name and populate it: Choosing 

this radio button will create a new custom field with the name same as the current export 

name. This custom field will be populated by the control number value depending on the 

option selected.  

• Populate existing custom field: Choosing this radio button will let you choose an existing 

custom field and populate it with the control number value. Only searchable fields with 2000 

or more length will be listed in the custom field drop-down list.  

The field created from the above process should be auto-deleted when the 

export with the custom field is deleted.  

 2.  Production History  

You can also view the history of previous exports by clicking the Production 

History link. Select any of the previous exports to update the control number to continue 

numbering from the last export. Be very careful to select the correct export. Otherwise, you 

may use the wrong starting number. If you use a starting number that has already been used 

for the selected export, you will get an error message. Look in the Production History and 

enter the next available number.  
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9.1.1.10  Image Branding  

In the Image Branding window, you can also brand the images during export if you are exporting 

images.  You can import the information to be branded or create the brand format using the tools provided.  

Import Branding Values  

Check the Import box and navigate to the file you want to use. Click on add button to add the 

imported load file.  You can see a preview of the image and branding by clicking on Preview (Search Icon). 

You can click on help (?) icon to get the information about the load file format.  
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 Create a New Brand  

1. Use the functions on the right.  Click “+” to add a new brand item.  

  

2. Choose what you want branded on the images.  You can choose an Image Field, Text, or Database 

Field. Click the radio button for the option you want to use and select the field or enter your own text 

in the text box.  

3. Choose branding scope for all documents or tagged documents.  

4. Click Font and choose the Font Format and Size for the branding  

5. Choose the location you wish to brand on the image.  You can choose from Left, Right or Center on 

the Top or Bottom of the image  

6. After brand item is added you can click on Preview icon to see the preview  

7. You can use delete icon to delete individual brand items or you can select multiple brand item and 

bulk delete.  
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9.1.2  Other Setting  

In the Other Settings window.  

• Binary Value Option:  Select export value for binary fields.  

• Yes/No  

• True/False  

• 1/0  

• Y/N  

• T/F  

• Separators:  Select the separator for all multi-value fields in the export.  

• Generate overlay load file for duplicate file path: Select the option to Generate overlay load file 

for duplicate path. Load file includes documents where DUPLICATE_FILE_PATH  and 

DUPLICATE_FILE_PATH_ALL field values have changed since it was last exported.  
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9.1.3 Summary  

The Summary will show you all the settings chosen during the template setup.  If all the 

information is correct, click Produce. To make changes, users can always go to previous UI.  

  
Click on View Details button to get more information regarding the selected export options. You 

can also save this production summary in CSV by clicking on the Export Report button on the page.  
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Once the production is completed, you will receive an email which consists of details like Native File 

Count, Image Page Count, Fulltext File Count, Data Load File Count, Image Load File Count, Native File 

Count (Relativity), Image Page Count (Relativity), and Fulltext File Count (Relativity). 

9.1.4 Status  

The Status page displays the status of the selected project. With the available drop-down 

options of status Not Started, In Progress and Completed, you can choose the status from the list and click 

the refresh icon to display the status as per selection. From the Status page, you can do the following:  

• Reproduce - Select Reproduce to choose a previous export from the available production list.  

• Download – Select Download to download the production along with the information  

• Share - Select Share to share the production information  

• Review - Select Review to go to the Review screen  

• Delete – Select Delete to delete the selected production  
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9.1.5  Reproduce   

1. Select Reproduce and choose a previous export from the available production list.  Exports made 

from the console are also available for reproduce. You can choose multiple productions to 

reproduce.  

Multiple reproduce can be achieved by selecting multiple previous production. The 

production settings of the first selected production will take effect in this case. Also, in case of 

multiple reproduction, the summary page has additional dropdown where you can select each 

production to see its summary.  

  

    



© Venio Systems, Inc.   11.7.0.0  Page | 329  

  

9.1.6  Create Production Template  

1. Select Create Production Template.   

2. Give template name  

3. Click Settings to continue creating export template (Follow steps as in create new Production)  

4. Click Save.  

9.1.7 Edit Production Template  

Select Edit Production Template and choose a previous template to be edited from the 

Available production Templates list.  
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If the selected template is a Default template, an error message is displayed.   

  
Continue and follow steps as in new Production and update the template  

9.1.8 Delete Production Template  

Select Delete Production Template and choose previously created template to be deleted from 

the Available Production Templates list.  

  
Default templates cannot be deleted, and the Delete icon for the default template is not 

available as shown below:  
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Click Delete.  

NOTE: Info icon is added next to “Delete database records only” as shown in below screenshot. 

 

9.1.1 Production Process for Relativity One 

Click  button on the home page to start the production process. 

To produce the documents: 

1. Once you navigate to your case, you can either produce directly from the launch pad by clicking 

the produce button from the case launch pad or go into the case and select the production 

option. 
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2. Select the Relativity connector. 

3. Select the Relativity One Environment. When you select the environment for the first time, you 

need to enter the Client Id and Client Secret which you added while creating the environment. 

Click on Do not ask again checkbox to avoid this every time you login. Click on Sign In. The Base 

API URL will be auto populated. 

 

4. Select the workspace where you want the data to be uploaded. 

5. Select the fileshare path for the workspace in Workspace File Share field.  

6. At the bottom, you can click on Click here if you intend to change the login credentials. 

7. For the Production process, please refer 9.1  Create Production section. In this section, under Control 

Number Settings, remember the Prefix detail you wish to add as you will need to search the same term in 

Relativity portal. Also, under Settings tab →Produce Native and FullText file path in load file as, you must 
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select Relativity path radio button. You also need to map the fields with Relativity fields in Field Mapping 

section. 

8. Now, moving on to Relativity portal, click on Workspace and select your case. 

 

9. On clicking the case name, you can search for control number prefix which you added in Control 

Number column. 
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10. Relativity One creates folders for every import you do. 
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You will see all the details have been imported to Relativity. You can also view the status in the 

notifications bar. 

 

After the production process is completed, you can download the relativity log where every information 

right from the start of the production process to the end of the production process is recorded. 

 

You will also receive an email with a link to download the Relativity log report from where you can 

download the zip file, extract the file, and look for the log report excel file.  

 
 

9.2  Delete Production  

Production can be deleted from Status page and from production dropdown.  

From Production Dropdown:   

To delete production,   

1. Click on production dropdown and click on Delete Production.  
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Delete Production UI is displayed.  

  
2. You can delete individual production by clicking on the Delete icon in the Action column of respective 

production.  

3. To delete multiple exports, you can select by using the checkbox and clicking on Delete button at 

button right corner.  

There are four delete option available as below  

• Delete All: It deletes all Database records Preserved Images and Exported Files.   

• Delete Files Only: This option deletes Preserved Images and Exported Files  
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• Delete Produced Volume: This option deletes Exported files only  

• Delete Database Records Only: This option deletes only database records  

For more information you can click Help icon.  

Delete Files Only  

1. From the Delete Production page, select the production you wish to delete. Select Delete Files Only. 

Click Delete.  A message prompts you if you would like to delete the selected production. Click Yes to 

continue.  

  

2. Message confirming the deletion is completed appears. When the delete process is triggered by the 

application, the workflow starts the delete process. The workflow continuously monitors the 

application and in a defined interval it triggers the delete operation. During this process the files 

selected by the user will get deleted.  
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There is a defined duration between the time the user requests for the deletion process and the 

actual deletion by the application. Between the duration that the delete production schedule has not yet 

started, the user can change the deletion selection. The document will be under the Deletion is scheduled 

status until the complete deletion of the production is completed. Even if the user navigates away from the 

delete page once delete has been requested, the Deletion is scheduled status is displayed until the file is 

picked up and the actual deletion starts.  

Usually, there is a small duration between the time the user requests for the deletion process 

and the actual deletion by the application. Between the duration that the delete production schedule has 

not yet started, the user can change the deletion selection.   

If the file has not been picked up by the delete workflow, and it is not in progress, we can still 

cancel the deletion by clicking the "X mark" next to Delete is scheduled.   

The refresh option helps you to refresh all the production scheduled for deletion and checks 

whether the deletion is completed or not.  

From Status Page  

1. From the Production Status dialog, click the Delete button.  
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2. Choose a deletion type from the Delete Production dialog.  

  

3. Click Delete to delete the selected option or click Cancel.  

The production will also be removed from the Production Status list.  

NOTE: To delete files from physical location user to use workflow rule  

9.3 Production Status 

You can view the Production Status dashboard by clicking on Production icon → Status for the case. 
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The Production Status screen displays the entire folder structure which includes Fulltext Count, Native Count, 
Image Count, Relativity Fulltext Count (if applicable), Relativity Native Count (if applicable), Relativity Image 
Count (if applicable), start time, completed time, and the creator of the Production. 

You can also see the Production based on various statuses like Not Started, Inprogress, and Completed. 

 

You can perform various actions for the Production like Reproduce, Download, Share, Review, Error Log, and 
Delete. 

 

For any production, if you want to perform Reproduction, click on first button. 

If you want to download the Production detail, click on second button and the file is downloaded. Once 
downloaded, the download file count will increase for the production. 

If you want to share the Production with internal or external users, click on third button. Search for the 
internal users or select the external users and click on Share button. 



© Venio Systems, Inc.   11.7.0.0  Page | 341  

 

If you want to redirect to Review page for the production, click on fourth button. 

If there are any error logs and you want to download the error log, click on fifth button. 

If you want to delete the production, click on sixth button. 

 

You can either delete everything, delete files, produced files, or database records only. Once selected, click 

on  to confirm the deletion. 
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10 VOD Reporting  
 

The purpose of a report is to communicate information, usually to set targets or to show a 

general overview of results or status within a project. VOD’s Reports module provides functionality for 

generating reports in two broad categories – User Reports and Admin Reports.  

To generate reports:  

1. Select any of the working areas within a project (Upload / Analyze / Review / Produce) to display the blue 

tab area.  

2. Hover over the Reports tab.  

3. Select either User Reports or Admin Reports and then select the report or reporting category.  

  

10.1 Levels of Report Generation  

The different levels in which reports can be generated are:  

• Project Level: Generates a report on the whole Project in the respective report type.  

• Custodian Level: Generates a report according to the Custodian in the respective report type.  

• Media Level: Generate a report according to the Media in the respective report type.  

10.1.1  Generating Custodian Level Reports  

To start, select the Custodian(s) you want to report from and click the Generate button.  
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NOTE: To select all the custodians, check the Select All option at the bottom.  

  

10.1.2  Generating Media Level Reports  

To start, select the Media you want to report from and click the Generate button.  

NOTE: To select all media, check the Select All option at the bottom.  

  

10.2 Report View / Export  

After a report is generated (Project, Custodian or Media Level), the following options are 

available:  
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• View: Opens a new window to view  the 

report.  

• Export: Exports the report in the selected file 

type.   

The available file types for exporting reports are:  

  

10.3 Report Toolbar  

The report toolbar is enabled after a report is generated and has the options listed below:  

  

1. Display the Search dialog.  

2. Print report to your local printer.  

3. Print current page to your local printer.  

4. Navigate to different report pages. You can either use the arrows or the page number list.  

5. Export a report and Save it to disk.  

6. Export a report and Open it in a new window.  

7. Export Format  

    

    

  

    



© Venio Systems, Inc.   11.7.0.0  Page | 345  

  

10.4 User Reports  

In VOD, you can create User Reports that will give you information pertaining to the data in 

your project. All our reports are updated with the new logo. 

User Reports fall into the following main categories. For detailed information, refer to the 

respective report sections below.  

• Custodian Media Info  

• Pre-Ingestion Reports  

• Ingestion/Processing Reports  

• Analytics Reports  

• Sampling Report  

• Search Reports  

• Tag Reports  

• Detailed Document Notes Report  

• Field Coding Log Report  

• Doc Viewer Log Report  

  

10.4.1  Custodian Media Info Report  

The Custodian Media Info Report gives you general information about the data that you have 

loaded.   

To generate a Custodian Media Info report for the project, navigate to Reports > User Reports > 

Custodian Media Info.  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Custodian Media Info report, the following details will be included:  
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• The Custodian Name in the project.  

• The Media Names associated with each Custodian.  

• Notes about the associated custodian will be displayed.  

• The Drill Level (either All, 1 or 2, as specified during project creation).  

• Base Path showing the path or link to the Folder where the Media is indexed.  

• Scanned Status:  

🌕 Scanned: If the media in the particular custodian is scanned.  

🌕 Not Scanned: If the media in the particular custodian is not scanned.  

• Ingested Status:  

🌕 Processed: If the media in the particular custodian is processed.  

🌕 Not processed: If the media in the particular custodian is not processed.  

🌕 Processing: If the media in the particular custodian is not fully processed.  

• Scanned Size:  

🌕 If the media is scanned, it will show the scanned size.  

🌕 If the media is not scanned, it will show as 0.00MB  

• Scanned Count:  

🌕 If the Media is scanned, it will show the scanned count.  

🌕 If the Media is not scanned, it will not show any count and will appear blank.  

  

10.4.2  Pre-Ingestion Reports  

The Pre-Ingestion Info Reports give you information pertaining to files you have scanned but 

not processed.   

10.4.2.1  Scan File Summary  
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To generate a Scan File Summary report, go to Report > User Reports > Pre-Ingestion Reports > 

Scan File Summary. You will then need to choose whether you want a Project Level or Custodian Level 

report.  

10.4.2.1.1 Project Level  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Scan File Summary report, the following details will be included:  

• Total # of Custodians  

• Total # of Media  

• Total # of Files • Total File Size  

The following details will be displayed in Pie Chart format.  Use the toolbar at the top to 

navigate:  

• Top 10 File Extensions  

🌕 File Counts: Shows the count of the Top 10 file extensions in the media  

🌕 File Size: Shows the total file sizes for the Top 10 file extensions  

• Top 10 File Sizes  

🌕 o   File Counts: Shows the count of the Top 10 files with the largest file sizes  

🌕 o   File Size: Shows the total file sizes for the Top 10 files with maximum size  
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10.4.2.1.2 Custodian Level   

Report is generated on a Custodian Level.  You will need to Select the Custodian(s) you wish to 

view in your report.  Check the desired Custodians and then click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By, 

and Custodian Selected.  

In the Scan File Summary report, the following details will be included for each Custodian 

selected:  

• Total # of Media  

• Total # of Files • Total File Size  

The following details will be displayed in Bar Chart format for each custodian selected.  Use the 

toolbar at the top to navigate:  

• Top 10 File Extensions  

🌕 File Counts: Shows the count of the Top 10 file extensions in the media  

🌕 File Size: Shows the total file sizes for the Top 10 file extensions  
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• Top 10 File Sizes  

🌕 File Counts: Shows the count of the Top 10 files with the largest file sizes  

🌕 File Size: Shows the total file sizes for the Top 10 files with maximum size  

    

  

10.4.2.2  Scan File Extension Summary Report  

To generate a Scan File Extension Summary report, go to Report > User Reports > Pre-

Ingestion Reports > Scan File Extension Summary. You will then need to choose whether you want a 

Project Level or Custodian Level report. 10.4.2.2.1 Project Level  
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The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Scan File Extension Summary report, the following details will be included:   

• File Extension: Lists the extensions of all the files in the media  

• Cumulative Size: Shows the size of the files corresponding to the file extensions  

• Cumulative # of Files: Shows the number of files corresponding to the file extensions  

  

10.4.2.2.2 Custodian Level  

Report is generated on a Custodian Level. You will need to select the Custodians you wish to 

view in your report. Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Scan File Extension Summary report, the following details will be included for each 

Custodian selected:  

• File Extension: Lists the extensions of all the files in the media  

• Cumulative Size: Shows the size of the files corresponding to the file extensions  

• Cumulative # of Files: Shows the number of files corresponding to the file extensions  
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10.4.2.3  Scan File Inventory Report  

To generate a Scan File Inventory report, go to Report > User Reports > Pre-Ingestion Reports > 

Scan File Inventory. You will then need to select whether you want a Project Level or Custodian Level report.  

10.4.2.3.1 Project Level  

The report header will include the Project Name, Report Generated Date, Report Created By, 

Total File Size and Total File Count.  

NOTE: This report could contain many pages as it reports on all files in your project.  Be aware 

of this if you plan on exporting the report.  

In the Scan File Inventory report, the following details will be included:   

• File Name: Name of each file scanned, in alphabetical order  

• File Extension: File extension corresponding to each file listed  

• File Size: File size corresponding to each file listed  

• File Path: Path to where each file listed is stored  

    



© Venio Systems, Inc.   11.7.0.0  Page | 352  

  

10.4.2.3.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to select the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By, 

Total File Size, Total File Count and Custodian Selected.  

In the Scan File Inventory report, the following details will be included for each Custodian 

selected:  

• File Name: Name of each file scanned, in alphabetical order  

• File Extension: File extension corresponding to each file listed  

• File Size: File size corresponding to each file listed  

• File Path: Path to where each file listed is stored  
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10.4.3  Ingestion/Processing Reports  

Ingestion/Processing Reports give you information pertaining to the files imported into the 

system for each custodian/media.  They are broken down further into Ingestion Reports on Scanned Files 

and Ingestion Reports on Expanded Files.   

10.4.3.1  Ingestion Project Summary Report on Scanned Files  

To generate a Summary report, go to Report  > User Reports  > Ingestion/Processing Reports  > 

Ingestion Reports on Scanned Files  > Ingestion Project Summary on Scanned Files. You will then need to 

choose whether you want a Project Level, Custodian Level or Media Level report.  

10.4.3.1.1 Project Level  

Report is generated on the Project Level. The report header will include the Project Name, 

Report Generated Date, and Report Created By.  

In the Ingestion Summary report, the following details will be included:  

• Total # of Custodians  

• Total # of Medias Added to Project  

• Number of Media Completely Ingested  

• Number of Media Being Ingested  
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• Number of Media Not Ingested  

  
Ingestion Project Summary on Scanned Files – Detail 

Diagrams In a funnel chart, you will see an overview of the Scanned 

Files:  

  

• Scanned Files (Filtered, Exception, Archives, Duplicate, Processed)  
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• Total Scanned Files (Without Duplicates)  

• Duplicates of Processed & Exception Files  

• Total Scanned Files (Including Duplicates)  

In the pie charts that follow, you will see detailed information about your Scanned Files: 

Scanned Filtered Files  

•   
• Total # System Files  

• Total # De-Nist Files  

• Total # Date Filter  

• Total # Extension Filter  

• Total # File Type Filter  

• Total Filtered Files  

  

•   
  

Scanned Exception Files  

•   
• Total Corrupted Files   

• Total Password Protected Files  

• Total Unknown Files  

• Total Processing Error Files  

• Total Zero Byte Files  

• Total Unsupported Files  

• Total Exception Files  

• Total Duplicate of Exception Files  

  

  

  

Scanned Archive Files  
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•   
• Total Processed Archives  

• Total Corrupt Archives  

• Total Password   

• Total Error Archives  

• Protected Archives   

• Total Archived Files  

• Scanned Duplicates Files  

• Total Duplicates of Processed Files  

• Total Duplicates of Exception Files  

  

Top 10 Scanned File Types  

  
On the last page is the List of Media(s).  

•   
• Custodian Name   

• Media Name   

• Base Path  

• File Size (GB) per Media  

• File Count per Media   

• Total Size and Count of Files  

  

10.4.3.1.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to select the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  
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The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Ingestion Project Summary on Scanned Files (Custodian Level) report, the following 

details will be included for each Custodian selected:  

• Custodian Name  • Number of Media Being Ingested  

• Number of Media Added to Custodian   • Number of Media Not Ingested  

• Number of Media Completely Ingested  

  

The diagrams that follow provide specific information regarding your scanned files.  Refer to the 

Project Level diagrams for reference.  If you have more than one custodian, you will need to page through 

each custodian using the page arrows or by selecting a specific report page at the top.  
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10.4.3.1.3 Media Level  

Report is generated on a Media Level.  You will need to select the Custodians and the Media 

you wish to view in your report.  Check the desired Medias and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By, 

and Custodian and Media Selected.  

The generated diagrams provide specific information regarding your scanned files.  Refer to the 

Project Level diagrams for reference.  If you have more than one media, you will need to page through each 

media using the page arrows or by selecting a specific report page at the top.  

10.4.3.2  Filtered Files Detail Reports  

To generate a Filtered Files Detail report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Scanned Files  > Filtered Files Detail Reports. You will then need to choose 

whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Filter File you want to report on.  You can choose from De-Nist Files, System 

Files, Date Filtered Files, Extension Filtered Files and/or File Type Filtered Files.  Click Generate to continue.  

NOTE: If there are no filtered files, you will receive the following message.  Click OK to continue.  

  
If any file type is filtered the following details will be included:   

• Project Name  

• Report Generated Date  

• Report Created By  

• File Type Filter (De-Nist Files, System Files, Date 

Filtered Files, Extension Filtered Files and/or File 

Type Filtered Files)  

• File ID  

• File Name  

• File Extension  

• FilePath  

• File Size  
•   
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10.4.3.2.1 Custodian Level  

Report is generated on a Custodian Level.  You will need to select the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

  
The following details will be included:   

• Project Name  

• Report Generated Date  

• Report Created By  

• Custodian Name  

• File Type Filter (De-Nist Files, System Files, Date Filtered 

Files, Extension Filtered Files and/or File Type Filtered 

Files)  

• File ID  

• File Name   

• File Extension   

• File Size  

• FilePath  

  

  

10.4.3.2.2 Media Level  

Report is generated on a Media Level.  You will need to select the Custodians and the Medias 

you wish to view in your report.  Check the desired Medias and click Generate. 

The following details will be 

included:  

• Project Name  

• Report Generated Date  

• Report Created By  
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• Custodian Name  

• Media Name  

• File Name  

• File Extension  

• FilePath  

• File Type Filter (De-Nist 

Files, System Files, Date 

Filtered Files,  

Extension Filtered Files 

and/or File  

Type Filtered 

Files)  

• File ID  

• File Size  

 

  

10.4.3.3  Exception Scan Files Detail Reports  

To generate an Exception Files Detail report, go to Report  > User Reports  > 

Ingestion/Processing Reports  > Ingestion Reports on Scanned Files  > Exception Scan Files Detail Reports. 

You will then need to choose whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Exception File you want to report on.  Choose from Corrupted Files, Password 

Protected Files, Unknown Files and/or Processing Error Files.  Click Generate to continue.  

NOTE: If there are no exception files, you will receive the following message.  Click OK to 

continue.  

  
If any file type is filtered the following details will be included in the report:  
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• Project Name  • FileID  

• Report Generated Date  • File Name  

• Report Created BY  • File Extension  

• Exception File type (Corrupted Files,  • File Path Password Protected Files, Unknown 

Files  • File Size and/or Processing Error Files)  •   
•   

  

  
For custodian level the report will be generated based on the custodians selected, and for 

media level, the report will be generated as per the media selected under the custodian.  

10.4.3.4  Archive Files Detail Reports  

To generate an Archive Files Detail report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Scanned Files  > Archive Files Detail Reports. You will then need to choose 

whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Archive File you want to report on.  You can choose from Processed Archive 

Files, Corrupted Archive Files, Password Protected Archive Files and/or Errored Archive Files.  Click Generate 

to continue.  

NOTE: If there are no archive files, you will receive the following message.  Click OK to continue.  

  
If any file type is filtered, the following details will be included:   

• Project Name  •  
• Report Generated Date  •  

FileID  

File Name  

• Report Created BY  • File Extension  
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• Exception File type (Processed Archive  • File Path Files, Corrupted Archive Files, 

Password  • File Size  

 Protected Archive Files and/or Errored    

Archive Files)  

  

  
For custodian level, the report will be generated based on the custodians selected, and for 

media level, the report will be generated as per the media selected under the custodian.  

10.4.3.5  Duplicate Files Detail Reports  

To generate a Duplicate Files Detail report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Scanned Files  > Duplicate Files Detail Reports. You will then need to choose 

whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Duplicate File you want to report on.  You can choose from Processed 

Duplicate Files and/or Exception Duplicate Files.  Click Generate to continue.  

NOTE: If there are no duplicate files, you will receive the following message.  Click OK to 

continue.  

I   

If any file type is filtered the following details will be included:   
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• Project Name  

• Report Generated Date  

• FileID  

• File Name  

• Report Created BY  • File Extension  

• Exception File type (Processed Duplicate  • File Path Files and/or Exception Duplicate 

Files)  • File Size  

  
For custodian level, the report will be generated based on the custodians selected, and for 

media level, the report will be generated as per the media selected under the custodian.  

10.4.3.6  Ingestion Reports on Expanded Files  

10.4.3.6.1 Ingestion Project Summary Report on Expanded Files  

To generate a Summary report, go to Report ðUser Reports  > Ingestion/Processing Reports  > 

Ingestion Reports on Expanded Files  > Ingestion ProjectSummary on Expanded Files. You will then need to 

choose whether you want a Project Level, Custodian Level or Media Level report.  

Project Level – Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date, and Report Created 

By.  
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In the Ingestion Summary report, the following details will be included:  

• Total # of Custodians  

• Total # of Medias Added to Project  

• Number of Media Completely Ingested  

• Number of Media Being Ingested  

• Number of Media Not Ingested  

Ingestion Project Summary on Expanded Files – Detail 

Diagrams In a funnel chart, you will see an overview of the Expanded 

Files:  
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• Expanded Files (Filtered, Exception, Archive, Processed)  

• Total Expanded Files (Without Duplicates)  

• Duplicates of Processed & Exception Files  

• Total Expanded Files (Including Duplicates)  

In the pie charts that follow, you will see detailed information about your Expanded 

Files: Expanded Filtered Files  
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•   
• Total # System Files   

• Total # De-Nits Files   

• Total # Date Filter  

• Total # Extension Filter  

• Total # File Type Filter  

• Total Filtered Files  

  

  

  

Expanded Exception Files  

•   
• Total Corrupted Files  

• Total Password Protected Files  

• Total Unknown Files  

• Total Processing Error Files  

• Total Zero Byte Files  

• Total Unsupported Files  

• Total Exception Files  

• Total Duplicate of Exception Files  

  

  

  

  

Expanded Archive Files  
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•   
• Total Processed Archives  

• Total Corrupt Archives  

• Total Password Protected Archives  

• Total Error Archives  

• Total Archived Files  

  

  

  

Expanded Duplicates Files  

• Total Duplicates of Processed Files  

• Total Duplicates of Exception Files  

• Total Duplicates Files  

Email/Edocs/OCR Files  
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• Electronic Mail 

Documents (Emails / 

Attachments)  

• Total Electronic Mail 

Documents  

• Duplicate of Emails 

and Attachments  

• Electronic Documents 

(Parent / Embedded 

Edocs)  

• Duplicate of Edocs 

and Embedded Files  

• Total Electronic 

Documents  

• Total OCRable 

Documents • 
Duplicate of OCRable  

Documents 

•   
  

Top 10 Expanded File Types  

  
On the last page is the List of Media.  

  

• Custodian Name  

• Media Name  
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• Base Path  

• File Size (GB) per Media  

• File Count per Media  

• Total Size and Count of Files  

Custodian Level  

Report is generated on a Custodian Level.  You will need to select the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

  
The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Ingestion Project Summary on Expanded Files (Custodian Level) report, the following 

details will be included for each Custodian selected:  

• Custodian Name  

• Number of Media Added to Custodian  

• Number of Media Completely Ingested  

• Number of Media Being Ingested  

• Number of Media Not Ingested  

The generated diagrams provide specific information regarding your expanded files.  Refer to 

the Project Level diagrams for reference.  If you have more than one custodian, you will need to page 

through each custodian using the page arrows or by selecting a specific report page at the top.  

Media Level  

Report is generated on a Media Level.  You will need to select the Custodians and the Media 

you wish to view in your report.  Check the desired Medias and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian and Media Selected.  
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The generated diagrams provide specific information regarding your expanded files. Refer to 

the Project Level diagrams for reference.  If you have more than one media, you will need to page through 

each media using the page arrows or by selecting a specific report page at the top.  

10.4.3.7  Filtered Files Detail Reports  

To generate a Filtered Files Detail report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Expanded Files  > Filtered Files Detail Reports. You will then need to choose 

whether you want a Summary (Extension Restriction or File Type Restriction), Project Level, Custodian Level 

or Media Level report.  

Select the type of Filter File you want to report on.  You can choose from De-Nist Files, System 

Files,  

Date Filtered Files, Extension Filtered Files and/or File Type Filtered Files.  Click Generate to 

continue.  

NOTE: If there are no filtered files, you will receive a message letting you know. Click OK to 

continue.  

10.4.3.8  Exception Files Detail Reports  

To generate an Exception Files Detail report, go to Report  > User Reports  > 

Ingestion/Processing Reports  > Ingestion Reports on Expanded Files  > Exception Files Detail Reports. You 

will then need to choose whether you want a Summary (Corrupted File Summary or Password Protected File 

Summary), Project Level, Custodian Level or Media Level report.  

Select the type of Exception File you want to report on.  You can choose from 

Corrupted Files,  

Password Protected Files, Unknown Files and/or Processing Error Files.  Click Generate to 

continue.  

10.4.3.9  Archive Files Detail Reports   

To generate an Archive Files Detail report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Expanded Files  > Archive Files Detail Reports. You will then need to choose 

whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Archive File you want to report on.  You can choose from Processed Archive 

Files, Corrupted Archive Files, Password Protected Archive Files and/or Errored Archive Files.  Click Generate 

to continue.  

NOTE: If there are no archive files, you will receive a message letting you know.  Click OK to 

continue.  

10.4.3.10 Duplicate Files Detail Reports  
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To generate a Duplicate Files Detail report, go to Report  > User Reports ðIngestion/Processing 

Reports  > Ingestion Reports on Expanded Files  > Duplicate Files Detail Reports. You will then need to 

choose whether you want a Project Level, Custodian Level or Media Level report.  

Select the type of Duplicate File you want to report on.  You can choose from Processed 

Duplicate Files and/or Exception Duplicate Files.  Click Generate to continue.  

NOTE: If there are no archive files, you will receive a message letting you know.  Click OK to 

continue.  

10.4.3.11 Email Reports  

To generate an Email report, go to Report  > User Reports  > Ingestion/Processing Reports  > 

Ingestion Reports on Expanded Files  > Email Reports. You will then need to choose whether you want a 

Project Level, Custodian Level or Media Level report.  

NOTE: If there are no archive files, you will receive a message letting you know.  Click OK to 

continue.  

10.4.3.12 Edocs Reports  

To generate anEdocs report, go to Report  > User Reports  > Ingestion/Processing Reports  > 

Ingestion Reports on Expanded Files  > Edocs Reports. You will then need to choose whether you want a 

Project Level, Custodian Level or Media Level report.  

NOTE: If there are no archive files, you will receive a message letting you know.  Click OK to 

continue.  

10.4.3.13 File Directory Reports  

To generate a Directory Listing report, go to Report  > User Reports  > Ingestion/Processing 

Reports  > Ingestion Reports on Expanded Files  > File Directory Reports. You will then need to choose 

whether you want a Project Level or Custodian Level.  

10.4.3.13.1  Project Level  

Report is generated on the Project Level  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Ingestion Project File Directory report, the following details will be included:  

• File ID  

• File Extension  

• File Size  

• File Path  
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10.4.3.13.2  Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Ingestion Custodian File Directory report, the following details will be included 

for each Custodian selected:  

• File Name  

• File Extension  

• File Size  

• File Path  

10.4.4  Analytics Reports  

Analytics reports give you information pertaining to various document properties for files that 

have been imported into the system.   

10.4.4.1  Email Time Gap Report  

To generate an Email Time Gap report, go to Report  > User Reports  > Analytics  > Email Time 

Gap Reports. You will then need to select either Archive Level or Custodian Level.  

NOTE: This report is only available for Email Archive Files (e.g. PST or NSF).  

10.4.4.1.1 Archive Level  

After you select Archive Level, a message prompts whether you would like to generate a report 

using Select Weekends or a Date Range.  Check the days that apply or enter the Date Range and click Apply 

to continue.  

  
The report header will include the Project Name, Report Generated Date, Report Created By, 

Selected Weekends or Date Range and Custodian.  
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In the Email Time Gap report, the following details will be included:  

• Start Gap Date  

• End Gap Date  

• Gap Days #  

  

10.4.4.1.2 Custodian Level  

Report is generated on a Custodian Level. After you select Custodian Level, a message prompts 

whether you would like to generate a report using Select Weekends or a Date Range.  Check the days that 

apply or enter the Date Range and click Apply to continue.  

You will need to choose the Custodians you wish to view in your report.  Check the 

desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Email Time Gap report, the following details will be included for each Custodian selected:  

• Start Gap Date  

• End Gap Date  

• Gap Days #  
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NOTE: The default date format for Email Time Gap reports is mm/dd/yyyy. It can be changed by 

setting the date format in the column DATE_FORMAT_FOR_REPORT in tbl_pj_ProjectSetting.  

Examples: dd.mm.yyyy, MMMM DD, YYYY, etc.  

10.4.4.2  Domain Report  

To generate a Domain report, go to Report  > User Reports  > Analytics > Domain. You will have 

to then select either Project Level or Custodian Level.  

10.4.4.2.1 Project Level  

Report is generated on the Project Level  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Domain Project Summary report, the following details will be included:  

• Domain Name  

• Count  

    



© Venio Systems, Inc.   11.7.0.0  Page | 375  

   

10.4.4.2.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Domain Custodian Summary report, the following details will be included for each 

Custodian selected:  

• Domain Name  

• Count  
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10.4.4.3  Language Report  

To generate a Language report, go to Report  > User Reports  > Analytics  > Language. You will 

then have to select Project Level, Custodian Level or Details Report.  

10.4.4.3.1 Project Level  

Report is generated on the Project Level  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Language report, the following details will be included:  

• Language  

• Total Count  

  

10.4.4.3.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Language report, the following details will be included for each Custodian 

selected:  

• Language  
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• Total Count  

  

10.4.4.3.3 Detail Report  

This generates the detailed report of the language of the emails in the project.  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Language report, the following details will be included for each Custodian 

selected:  

• File ID  

• File Name  

• File Path  

• Language  

• Language Details  
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10.4.4.4  Email Summary Report  

To generate an Email Summary report, go to Report  > User Reports  > Analytics  > Email 

Summary. You will then have to select Project Level or Custodian Level.  

10.4.4.4.1 Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Email Summary report, the following details will be included:  

•  Total # of Custodians   •  Total # of Medias   •  Total # of Files  

•  Total File Sizes (Expanded)  
  

•  Total Unique Files   •  Total Files Date Restricted  

•  Total Files Excluded by 

Extension  

 •  Total Files Excluded by File 

Type    

•  Total Nist Files  

•  Total System Files   •  Total Archive Files   •  Total Non-Process Files  

•  
  

Total Corrupted Files   •  Total Password Protected 

files    

•  Total Duplicates  

In the Email Date Range report, you will see the Custodian Name and the Date Range in which 

the emails were sent/received (upper and lower limit).  

In the Pie Charts, the following details will be displayed:  

• Email Address: Shows the names from which the Emails were sent or received, with counts.  

• Email and Attachment: Shows the count of files that are Emails and Attachments.  
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• Email Domain: Shows the count of the email domains, the names of domain and their 

counts.  

• Email Timeline: Shows the year and the email count sent/received in that year.  

• Email Senders: Shows the Email Senders with their counts.  

• Email Recipients: Shows the Email Recipients with their counts.  
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10.4.4.4.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Email Summary report, the following details will be included for each Custodian selected: 

• Total # of Custodians  

• Total # of Medias  

• Total File Sizes (Expanded)  

• Total # of Files  

• Total Unique Files  

• Total Files Date Restricted  

• Total Archive Files  

• Total Non-Process Files  

• Total Files Excluded by 

Extension   

• Total Files Excluded by File 

Type  

• Total Nist Files  

• Total System Files   

• Total Corrupted Files  

• Total Password Protected 

files  

• Total Duplicates 

  

In the Email Date Range report, you will see the Custodian Name and the Date Range in which 

the emails were sent/received (upper and lower limit).  

In the Pie Charts, the following details will be displayed:  

• Email Address: Shows the names from which the Emails were sent or received, with counts.  

• Email and Attachment: Shows the count of files that are Emails and Attachments.  

• Email Domain: Shows the count of the email domains, the names of domain and their 

counts.  

• Email Timeline: Shows the year and the email counts sent/received in that year.  
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• Email Senders: Shows the Email Senders with their counts.  

• Email Recipients: Shows the Email Recipients with their counts.  

 

NOTE: For examples of the Pie Charts, please refer to the Project Level diagrams.  

10.4.4.5  Electronic File Summary Report  

To generate an Electronic File Summary report, go to Report <<User Reports <<Analytics 

<<Electronic File Summary. You will then have to select Project Level or Custodian Level.  

10.4.4.5.1 Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report Created 

By.  

In the Electronic File Summary report, the following details will be included: 

• Total # of 

Custodians  
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• Total # of Medias • 
Total File Sizes 

(Expanded)  

• Total # of Files  

• Total Nist Files  

• Total System Files  

• Total Archive Files  

• Total Non-Process 

Files  

• Total Corrupted 

Files 

• Total Unique Files  • Total Password • Total Files Date  Protected files  

 Restricted  • Total Duplicates  

• Total Files Excluded by  •   
Extension  

• Total Files Excluded by File Type   

In the Edoc Last Modified Date Range report, you will see the Custodian Name and the Date Range in 

which the documents were modified (upper and lower limit).  

In the Pie Charts that follow, you will see the following information:  

Top 10 File Types  

• File Counts: Shows the count of the Top 10 file types in the media  

• File Size: Shows the total file sizes for the Top 10 file types  

Top 10 File Sizes  

• File Counts: Shows the count of the Top 10 files with the largest file sizes  

• File Size: Shows the total file sizes for the Top 10 files with maximum size  
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10.4.4.5.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Electronic File Summary report, the following details will be included for each 

Custodian selected:  

• Total # of Custodians  • Total Nist Files  

• Total # of Medias  • Total System Files  

• Total # of Files  • Total Archive Files   

• Total Unique Files  • Total Non-Process Files  

• Total Files Date Restricted  • Total Corrupted Files  
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• Total Files Excluded By Extension  • Total Password Protected files  

• Total Files Excluded by File Type  • Total Duplicates  

In the Edoc Last Modified Date Range report, you will see the Custodian Name and the Date Range in 

which the documents were modified (upper and lower limit).  

In the Pie Charts that follow, you will see the following information, per custodian:  

Top 10 File Types  

• File Counts: Shows the count of the Top 10 file types in the media  

• File Size: Shows the total file sizes for the Top 10 file types  

Top 10 File Sizes  

• File Counts: Shows the count of the Top 10 files with the largest file sizes  

• File Size: Shows the total file sizes for the Top 10 files with maximum size  
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10.4.4.6  File Type Summary Report  

To generate a File Type Summary report, go to Report ðUser Reports  > Analytics  > File Type 

Summary. You will then have to select Project Level or Custodian Level.  

10.4.4.6.1 Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the File Type Summary report, the following details will be included:  

• File Type  

• File Type Description  

• File Extension  

• Original File Counts  

• Duplicate File Counts  

• Total File Counts  

• Original File Sizes  

• Duplicate File Sizes  

• Total File Sizes  

  

10.4.4.6.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  
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In the File Type Summary report, the following details will be included for each Custodian 

selected:  

• File Type  

• File Type Description  

• File Extension  

• Original File Counts  

• Duplicate File Counts  

• Total File Counts  

• Original File Sizes  

• Duplicate File Sizes  

• Total File Sizes  

  

10.4.5  Sampling Report  

The Sampling report gives you information pertaining to a Sample you’ve created.   

To generate a Sampling report, go to Report  > User Reports  > Sampling.  You will then need to 

select the Sample Set you want to generate the report for.  

NOTE: Sampling reports can only be generated after you’ve created and saved a Sample Set.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Sampling report, the following details will be included:  

• Sample Name  

• Population Name  

• Population Size  

• Confidence Level  

• Confidence Interval  
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• Sample Percentage  

• # of Document Sampled  

• Sampling Purpose  

• Sampling Results  

• Before Sampling  

• After Sampling  

  

10.4.6  Search Term Audit Report  

The Search Term Audit report gives you information pertaining to searches you have executed in the 

system.   

NOTE: Search Reports can only be viewed after you have performed searches.  

To generate a Search Term Audit report, go to Report > User Reports  > Search  > Search Term Audit.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Search Term Audit report, the following details will be included:  

• Search ID: System generated identifier.  

• Search Name: Lists the saved Search Names, if available.  

• Search Expression: Lists the search expressions used in the search.  
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• Is Load File Search: This has the value 'YES' or 'NO'. If any search was conducted using a load file, 

'Yes'.  Otherwise, it displays 'No'.  

• Searched Date: Displays the date / time when the search was performed.  

• Total Hit #: Displays the total number of search result returned for each search performed.  

• Searched By: Username that conducted the search.  

• Duplicate Search Option: Option chosen at time of search to Show/Hide Duplicates.  

  

10.4.7  Tag Reports  

The Tag reports give you information pertaining to the tags applied during your search or 

review.   

To generate a Tag report, go to Report > User Reports > Tag.  

10.4.7.1  Tag Summary Report  

To generate a Tag Summary report, go to Report > User Reports > Tag > Tag Summary. You will then 

have to select the specific report you wish to view.  

10.4.7.1.1 Tag Report (No De-Dupe)  

All tagged documents will be listed.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag Report (No De-Dupe), the following details will be included:  

• Tag Name  

• Total Count  

• Total File Size  
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10.4.7.1.2 Tag Report (Project Level De-Dupe)  

Tagged documents will be de-duped globally and only appear once in the project.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag Report (Project Level De-Dupe), the following details will be included:  

• Tag Name  

• Total Count  

• Total File Size  

  

10.4.7.1.3 Tag Report (Custodian Level De-Dupe)  

Tagged documents will be de-duped within each Custodian and can appear more than once 

in the project.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag Report (Custodian Level De-Dupe), the following details will be included:  

• Tag Name  

• Total Count  

• Total File Size  
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10.4.7.1.4 Tag Report Summary  

Information will be listed for the selected Tag.  

When you select Tag Report Summary, a dialog will prompt you to Select Tag Name to View.  Use the 

drop-down list to select a Tag and click Generate to continue.  

The report header will include the Project Name, Report Generated Date, Selected Tag 

Name and Report Created By.  

  
In the Tag Report Summary, the following details will be included:  

• Total # of Custodians  

• Total # of Medias  

• Total File Sizes (Expanded)  

• Total # of Files  

• Total Unique Files  

• Total # Supported Files   

• Total # Corrupted Files  

• Total # Attachments Files  

• Total # Password Protected Files  

• Total # Unsupported Files  

• Total # Duplicates  

• Total # Email  

• Total # Electronics Files  

• Total # Non-Process Files  
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10.4.7.1.5 Tag Report Email Summary  

When you select Tag Report Email Summary, a window will prompt you to Select Tag Name to 

View.  Use the drop-down list to select a Tag and click Generate to continue.  The report header will include 

the Project Name, Report Generated Date, Selected Tag Name and Report Created By.  

In the Tag Report Email Summary, the following details will be included:  

• Total # of Custodians  • Total # Corrupted Files  

• Total # of Medias  • Total # Password Protected Files  

• Total # of Files Total File Sizes (Expanded)  • Total # Duplicates  

• Total Unique Files  • Email Date Range  

• Total # Non-Processable Files  
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10.4.7.2  Tag History Report  

To generate a Tag History report, go to Report  > User Reports  > Tag  > Tag History.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag History report, the following details will be included:  

• Tag Batch ID: System generated identifier.  

• Tag Name: Name of Tag.  

• Is Tag Operation: Verifies operation was a tag and not a foldering action.  

• Tagged Or Untagged On: Date and Time the tag was applied.  

• Duplicate Tag Propagation: Tag propagation used in each of the tag applied  

• Message Thread Tag Propagation: Tag propagation on the email/attachment in each tag applied.  

• Parent Child Propagation: Tag propagation in the parent/child thread.  

• Selected #: Number of document in which the tags have been applied.  
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• Duplicate Propagation #: Total duplicate documents tagged.  

• Email Thread Propagation # : Total email/attachment tagged.  

• Parent Child Propagation #: Total parent documents tagged.  

• Total Tagged Or Untagged Count: Total documents tagged or untagged.  

• Tagged or Untagged By: User who has applied/removed the tags.  

  

10.4.7.3  Tag Comment Report  

To generate a Tag Comment report, go to Report  > User Reports  > Tag  > Tag Comment.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag Comment report, the following details will be included:  

• Batch ID: System generated identifier.  

• Tag Name: Name of Tag.  

• Operation (Tag/Untag): Indicates whether the tag was applied or removed.  

• Tag/Untag Date: Date and Time the tag operation was applied.  

• Tag/Untag By: Shows user that performed the tag operation.  

• Tag Comment: Comment made during tagging operation.  
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10.4.7.4  Tag Conflict Qc Report  

To generate a Tag Conflict Qc report, go to Report > User Reports > Tag > Tag Conflict.  

Select the tag for which the report is to be generated.  

  
The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Tag Conflict report, the following details will be included:  

• Tag Name: The name of the tag for which the report has been generated • FileID:  File ID of the 

document for which these tag conflicts occur  

• Tagged/Not Tagged: Whether the tag has been applied or not.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 397  

  

10.4.8  Detail Document Notes Report  

To generate a Detail Document Notes report, go to Report  > User Reports  > Detail Document 

Notes. You will then have to select Project Level or Custodian Level.  

10.4.8.1  Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Detail Document Note report, the following details will be included:  

• FileID: Assigned File ID for the document containing a note.  

• Relative File Path: Complete path to the location of the file containing a note.  

• Note Added By: User that applied the document note.  

• Notes Added On: Date and time document note was applied.  

• Accessibility: Permissions for who can view the document note.  

• Document Note: Contents of the document note.  
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10.4.8.2  Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Detail Document Notes report, the following details will be included for each 

Custodian selected:  

• FileID: Assigned File ID for the document containing a note.  

• Relative File Path: Complete path to the location of the file containing a note.  

• Note Added By: User that applied the document note.  

• Notes Added On: Date and time document note was applied.  

• Accessibility: Permissions for who can view the document note.  

• Document Note: Contents of the document note.  

  

10.4.9  Field Coding Log Report  

To generate a Field Coding Log report, go to Report  > User Reports  > Field Coding Log 

Report.  
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The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Field Coding Log report, the following details will be included:  

• Batch ID: Assigned Batch ID that applied code for documents.  

• Field Name: Name of field on which code was applied.  

• File Count: Total number of documents on which code was applied.  

• Value: Value inserted in the coding field.  

• Coding Action: Action performed on coding the documents.  

• Coding From: Code can be applied either from Search or Review, so that is indicated here.  

• Applied By: User who applied the code to the documents.  

• Applied Date: Date the code was applied to the documents. •   

•   

10.4.10  Doc Viewer Log Report  

To generate a Doc Viewer Log report, go to Report  > User Reports  > Doc Viewer Log 

Report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Doc Viewer Log report, the following details will be included:  

• File ID: Assigned File ID for the document that was viewed.  

• Field Name: The name of document on which was viewed in the viewer.  

• Viewed From: The module from where the documents were viewed.  

• Viewed On: The date on when the documents were viewer.  
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10.5 Admin Reports  

In VOD, you can create Admin Reports that will give you information pertaining to the settings in 

your project.  You can generate reports for Project Settings, Ingestion / Processing Settings, Security Settings, 

Export Settings, other Miscellaneous details, and Review.  

Admin Reports fall into the following main categories. For detailed information, refer to the 

respective report sections below.  

• Project Settings Report  

• OnDemand Upload Report  

• Ingestion/Processing Reports  

• Project Storage Report  

• Security Reports  

• Import Reports  

• Export Reports  

• Misc. Reports  

• Review Reports  

• No-Text Report  

• Audit Log Reports  

• Privilege Logs Reports  

• Inclusive Email Report  
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10.5.1  Project Settings Report  

The Project Settings report gives you information pertaining to the settings you selected at the 

start of your project.  

To generate a Project Settings report, go to Report  > Admin Reports  > Project Settings.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Project Settings report, the following details will be included:  

• Project Name: Name of the project provided by the user.  

• Project Created By: User who created the project.  

• Date/Time Project Created: Date and time the project was created.  

• Project Location: Location where the project was created.  

• Project Matter: Optional user field.  

• De-Duplication: Hash Algorithm selected to filter the duplicate files.  

• System File Folder: If the File Type Restriction option was checked, this will show ‘TRUE’ and the 

File Filter Type will be populated with ‘Denist and System’.  Otherwise, it will be ‘FALSE’ and the 

File Filter Type will be left blank.  

• File Extension Restriction: If the File Extension Restriction option was checked, this will show  

‘YES’ and the Filtered Extensions will be listed. Otherwise, it will be ‘NO’ and the Filtered 

Extensions will be left blank.  

• File Type Restriction: If the File Type Restriction option was checked, this will show ‘YES’ and the 

Restricted File Types will be listed.  Otherwise, it will be ‘NO’ and the File Type Restrictions will be 

left blank.  

• Date Restriction: If the Date Restriction option was checked, this will show ‘YES’ and the date 
ranges will be listed.  Otherwise, it will be ‘NO’ and the Date Restrictions will be left blank.  

• Embedded File Filter: Indicates whether you elected to exclude embedded files from Email, EDOC, 

and/or PPT files.  

• Indexing: Indicates whether the project was created as a searchable database.  If so, it will display 

‘YES’ and the type of index will be listed as FullText Index and/or Metadata Index.  Otherwise, it 

will be ‘NO’ and the Indexing will be left blank.  

• Language Identification: If the Language Identification option was checked, this will show ‘TRUE’.  

Otherwise, it will be ‘FALSE’.  

• Email Analytics: If the Email Analytics option was checked, this will show ‘TRUE’.  Otherwise, it will 

be ‘FALSE’.  

• OCR: If the OCR option was checked, this will show ‘TRUE’, the selected File Types will be listed 

and the OCR Queuing will be ‘FALSE’.  Otherwise, it will be ‘FALSE’, the File Types will be left blank 

and the OCR Queuing will be ‘TRUE’.  

• Processing Time per File: Maximum processing time allotted for each file.  
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• Tiffing Settings: In the pages that follow, you will see the TIFF settings.  

• Hash Field: Comma separated hash fields selected during project creation.  

 
10.5.2  OnDemand Upload Report  

1. To generate an Upload report, go to Report > Admin Reports > OnDemand Upload 

Report.  

The Report Options will be displayed.  

  

1. Select the name of the person who did the upload from the Uploaded By drop-down list.  

2. Select the starting and ending dates from the From and To drop-down lists.  

3. Click Generate.  

The upload report will be generated.  

10.5.3  Ingestion /Processing Reports  

The Ingestion/Processing reports give you information pertaining to the ingestion and processing of 

your data.   

10.5.3.1  Crash Log Report  

To generate a Crash Log report, go to Report  > Admin Reports  > Ingestion/Processing 

Reports  > Crash Log Report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  
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In the Crash Log report, the following details will be included:  

• Media Name: Media where the crashed file is located.  

• File Name: Name of file that crashed.  

• Group ID: Parent ID of crashed file.  

• Absolute File Path: Path to file causing crash.  

• Export Location: Path to where crashed file is exported.  

  

10.5.3.2  Ingestion Exception Log Detail Report  

To generate an Ingestion Exception Log report, go to Report  > Admin Reports  > 

Ingestion/Processing Reports  > Ingestion Exception Log Detail Report.  

The report header will include the Project Name, Report Generated Date, Report Created 

By, Custodian Name and Media Name.  

In the Ingestion Exception Log Detail report, the following details will be included:  

• Time Stamp: Date and time when exception occurred.  

• Type: Type of exception.  

• Message: Error message for exception file.  

• Target Site: System field.  

• Stack Trace: System field.  
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10.5.3.3  Ingestion Log Report  

To generate an Ingestion Log report, go to Report  >  Admin Reports  >  Ingestion/Processing 

Reports  >  Ingestion Log Report.  

The report header will include the Project Name, Report Generated Date, Report Created By, 

Custodian Name, and Media Name.  

In the Ingestion Log report, the following details will be included:  

• Source File Size: Size of original source file.  

• Processed Doc Count: Number of documents ingested/processed.  

• Total Time Taken: Total time taken to ingest/process the data.  

• Batch ID: System assigned identifier.  
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10.5.3.4  State Error Report  

To generate an State Error report, go to Report  >  Admin Reports  >  Ingestion/Processing 

Reports  >  State Error Report.  

The report header will include the Project Name, Report Generated Date, and Report Created 

By.  

In the State Error Log report, the following details will be included:  

• Media ID: Associated Media ID.  

• Host Name: Machine name by which ingestion performed.  

• State Error Type: Type of error.  

• Error Message: Details of state error type.  

• Error Remarks: Remarks of state error type.  

• Error Details: Details of state error type.  

• Logged Date Time: Time when state error occurred.  
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• Resolved Type: Any action performed that resolved the error.  

• Resolved Date Time: Date and time the error was resolved.  

  

10.5.3.5  Reprocess Attempt Log Report  

To generate an Ingestion Log report, go to Report  > Admin Reports  > Ingestion/Processing 

Reports  > Reprocess Attempt Log Report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Reprocess Attempt Log report, the following details will be included:  

• File ID: Associated File ID of document that was reprocessed.  

• Original File Path: The original file path of respective document of File ID.  

• Replacement Type: The action performed to reprocess respective document of File ID.  

• Last Reprocessed By: Latest user by whom performed to reprocess documents.  

• Attempt Count: Number of reprocess count of documents.  

• Is Success: Status of reprocess documents.  
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10.5.4  Security Reports  

The Security reports give you information pertaining to the logins and security settings for the 

users in the system.   

10.5.4.1  Login/Logout Report  

To generate a Login/Logout report, go to Report  > Admin Reports  > Security  > Login/Logout Report.   

The Login/Logout Options dialog displays options to filter your report.   

Select the User, Date Range and System Module filter you with to apply and click Generate.  

  
The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Login/Logout report, the following details will be included:  

• Username: Login used to access the system.  
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• IP Address: IP Address of computer used to access the system.  

• Login Date Time: Date and time user logged into the system.  

• Logout Date Time: Date and time user logged out of the system.  

  

10.5.4.2  Associated Users Report  

To generate an Associated Users report, go to Report  > Admin Reports  > Security  > 

Associated Users.   

The report header will include the Project Name, Report Generated Date and Report 

Created By.  
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In the Associated Users report, the following details will be included for all Active and Locked users:  

• Full Name: Full name of user.  

• User Name: Assigned login name of user.  

• Global User Role: Role of the user: System Admin, User Admin or User and Client.  

• Project User Group: Name of the project user group.  

• Desktop Access: Whether the user has access to VenioOne Desktop or not  

• Web TOA Access: Whether the user has access to VenioOne Web or not  

• Review Access: Whether the user has access to the review section in VenioOne Web or not  

• Touch Access: Whether the user has access to VenioOne Touch or not.  

• Total # Users: Total number of users with access to the selected project • Total # Desktop Users: 

Total number of users with access to VenioOne Desktop.  

• Total # Review Users: Total number of users with access to VenioOne Web.  

• Total # Review Users: Total number of users with access to the review section in VenioOne Web.  

• Total # Touch Users: Total number of users with access to VenioOne Touch.  

  

10.5.5  Import Reports  

The Import reports give you information pertaining to the data you have imported into your 

project.   

10.5.5.1  Import Settings Report  

To generate an Import Settings report, go to Report  > Admin Reports  > Import  > Import 

Settings.  
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You will need to select the Import you wish to report on from the list and click Generate to continue.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Import Settings report, the settings you selected during import will be included.  

  

10.5.6  Export Reports  

The Export reports give you information pertaining to the data you have exported from your project.   

10.5.6.1  Export Summary Report  

To generate an Export Summary report, go to Report  > Admin Reports  > Export  > Summary. You 

will then have to select Project Level or Custodian Level.  

10.5.6.1.1 Project Level  

Report is generated on the Project Level.  You will need to select the Export you wish to generate the 

report for.  Click Generate to continue.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  
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In the Export Summary report, the following details will be included:  

• Total Export Native File Sizes: Size of all the native files that have been exported, given in Bytes. If 

Native files were not included, this will display 0 Bytes.  

• Total Export Native File Count: Total number of native files that have been exported. If Native 

files were not included, it will display 0.  

• Total # Duplicate Files Exported: Count of all the duplicate documents, if included while 

exporting.  Otherwise, it will display 0.  

• Total # NIST Files Exported: Count of all the NIST files, if included while exporting.  Otherwise, it 

will display 0.  

• Total # System Files Exported: Count of all the system files, if included while exporting.  If this is 

not selected while exporting or no system files exist, it will display 0.  

• Total # Non-Processable Files Exported: Count of all the non-processable files, if included while 

exporting.  If this is not selected while exporting or no non-processable files exist, it will display 0.  

• Total # Archive/Password Protected Files Exported: Count of all the archive/password protected 

files, if included while exporting.  If this is not selected while exporting or no archive/password 

protected files exist, it will display 0.  

• Total # Parent Emails Exported: Count of all the emails present in the project.  

• Total # Attachments Exported: Count of all attachments present in the emails.  

• Total # Edocs Exported: Count of all EDOCS present in the project.  

• Total # Custodians Exported: Count of all custodians present in the selected export. If an export 

has not been performed, it will display 0.  

• Export Path: Path where the project was exported. Blank if no export was done.  

• Date/Time: Date and time when the export was performed. Blank, if no export was done.  

• Export Control Number Range: Range of control numbers for which export is done.  

NOTE: If no documents were exported, No documents to report. message will be displayed.  
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10.5.6.1.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodian and Export 

you wish to view in your report.  Check the desired Custodian and Export, then click Generate to continue.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Export Custodian Summary report, the following details will be included for each 

Custodian selected:  

• Total Export Native File Sizes  

• Totals Export Native File Count  

• Total # Duplicate Files Exported  

• Total # NIST Files Exported  

• Total # System Files Exported  

• Total # Non-Process Files Exported  

• Total # Archive Files Exported  

• Total # Password Protected Files Exported  

• Total # Parent Emails Exported  

• Total # Attachments  

• Total # EDOCS Exported  
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10.5.6.2  Export Tag Summary Report  

To generate a Tag Summary report, go to Report  > Admin Reports  > Export  > Tag 

Summary.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Export Tag Summary report, the following details will be included:  

• Export ID: Individual ID of each export.  

• Export Name: Name of the export.  

• Tag Name: Name of the tag used for the export.  

• Total Files Count: Total number of documents that have been exported.  

• Total File Size: Total size of all the documents that have been exported.  

NOTE: If no documents were exported, a No documents to report. message will appear.  
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10.5.6.3  Export File Detail Report  

To generate a File Detail report, go to Report  > Admin Reports  > Export  > File Detail.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Export File Detail report, the following details will be included:  

• File ID: The ID for each file that has been exported.  

• Export ID: The ID for each export performed. The set of documents that are exported together 

will have the same Export ID.  

• File Name: The name of each exported document.  

• Hash Value: The hash value for each exported file.  

• Custodian Name: The name of the custodian in which each of the exported files belong.  

• Original File Path: The path where the exported documents originally reside.  

• Export File Path: The path where the exported documents are stored.  

NOTE: If no documents are exported, a No documents to report. message will appear.  
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10.5.7  Misc Reports  

The Misc reports give you information pertaining to various exceptions in your project.  

10.5.7.1  Remaining File Type Summary Report  

To generate a Remaining File Type Summary report, go to Report  > Admin Reports  > Misc  

> Remaining File Type Summary.  

10.5.7.1.1 Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Remaining File Type Summary report, the following details will be included:  

• File Type  

• File Type Description  

• File Extension  

• Total File Count  

• Total File Size  
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You will also get a Pie Chart that illustrates the Top 20 File Types for the whole project 

  

10.5.7.1.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Remaining File Type Summary report, the following details will be included for each Custodian 

selected:  

• File Type  

• File Type Description  

• File Extension  

• Total File Count  

• Total File Size  

You will also get a Pie Chart that illustrates the Top 20 File Types for each Custodian.  
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10.5.7.2  Exception File Directory Report  

To generate an Exception File Directory report, go to Report  > Admin Reports  > Misc  > 

Exception File Directory.  

10.5.7.2.1 Project Level  

Report is generated on the Project Level.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Exception File Directory report, the following details will be included:  

• FileID: The File ID of the exception file.  

• File Name: The File Name of the exception file.  

• Error Log: The reason for the exception.  
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• File Path: The location of the exception file.  

  

10.5.7.2.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the Custodian Exception File Directory report, the following details will be included for 

each Custodian selected:  

• FileID: The File ID of the exception file.  

• File Name: The File Name of the exception file.  

• Error Log: The reason for the exception.  

• File Path: The location of the exception file.  
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10.5.7.3  Not Indexed File Type Summary Report  

To generate a Not Indexed File Type Summary report, go to Report  > Admin Reports  > Misc  

> Not Indexed File Type Summary.  This report covers non-processable and password protected files.  

10.5.7.3.1 Project Level  

Report is generated on the Project Level  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Not Indexed File Type Summary report, the following details will be included:  

• File Type  

• File Type Description  

• Original File Counts  

• Duplicate File Counts  

• Total File Counts  

• Original File Sizes  

• Duplicate File Sizes  

• Total File Sizes  

The Pie Charts show the Total File Types in the Non-Processable and Password Protected 

Files.  
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10.5.7.3.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  
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In the Not Indexed File Type Summary report, the following details will be included for each 

Custodian selected:  

• File Type  

• File Type Description  

• Original File Counts  

• Duplicate File Counts  

• Total File Counts  

• Original File Sizes  

• Duplicate File Sizes  

• Total File Sizes  

The Pie Charts show the Total File Types in the Non-Processable and Password Protected 

Files.  
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10.5.7.4  FullText Replacement Reports  

To generate a FullText Replacement report, go to Report  > Admin Reports  > Misc  > FullText 

Replacement Report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.   

In the FullText Replacement report, the following details will be included:  

• FileID: File ID whose fulltext has been replaced.  

• File Name: File Name whose fulltext has been replaced.  

• Source FullText File: Original location of the Fulltext source file.  

• Replaced FullText Location: Replaced location of the Fulltext source file.  

• Replaced By: User who replaced the Fulltext.  

• Replaced Date: Date and time when the Fulltext was replaced.  

NOTE: If no FullText was replaced, a No documents to report message will be displayed.  
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10.5.8  Review Reports  

The Review reports give you information pertaining to the document reviews in your 

project.   

10.5.8.1  Review Set Report  

To generate a Review Set report, go to Report  > Admin Reports  > Review  > Review Set 

Report.  

Select the Review Set you wish to generate the report for and click Generate.  

  
The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Review Settings report, the following details will be included:  
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• Prefix and Numbering: Format to be used for naming review documents.  

• Source Documents: Files to be included from parent/child documents and email threads.  

• Duplicate Options: Settings for handling duplicate documents.  

• Tag Propagation Options: Settings for propagating tags in duplicate, parent/child and email 

thread documents.  

• Review Tag Name: Tag to be used for tracking the review set.  

• Review Group: Users that will have access to the review set.  

• Auto Collection Settings: Settings for auto-collection of new documents.  

• Selected Fields to Display: Fields that will be displayed during the review.  

  

10.5.8.2  Tag History Detail Report  

To generate a Tag History Detail report, go to Report  > Admin Reports  > Review  > Tag History Detail 

Report.  

Select the Review Set, Reviewer, Batch and Tag you wish to generate the report for.  

If no batches are checked out or reviewed in the project, you will see No data to display in 

the dropdown menu.  

    



© Venio Systems, Inc.   11.7.0.0  Page | 426  

  
After you select the Review Set, information for the subsequent fields will be populated.  This will 

only happen if there are batches checked out and documents have been tagged in the review.  Use the drop-

down menu to choose a different option.  Click Generate to create the report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Review Settings report, the following details will be included:  

• File ID: System generated file identifier.  

• Relative File Path: Relative path to original file.  

• Tag Name: Tag used.  

• Action: Action taken for tag.  The available options are Tagged or Untagged.  

• Username: User that tagged/untagged the document.  

• Action Date Time: Date and time document was tagged/untagged.  

• Direct/Indirect Hit: Identifies whether the document tagged was a direct or indirect hit.  

• Tagged/Untagged From:Module where tag/untag took place.  Could be Search or Review.  
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NOTE: If no tags were applied in the review, a message will appear to let you know when you click 

the Generate button.  

10.5.8.3  Document Notes Report  

To generate a Document Notes report, go to Report  > Admin Reports  > Review  > Document Notes 

Report.  

Select the Review Set, Reviewer, and Reviewer you wish to generate the report for.  If no 

document notes are in the project, you will see No data to display in the drop-down menu.  

  
After you select the Review Set, information for the Reviewers will be populated.  Use the drop-

down menu to choose a different option.  Click Generate to create the report.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the Document Notes report, the following details will be included:  

• File ID: System generated file identifier.  

• Relative File Path: Relative path to original file.  

• Notes Added By: User that applied the document note.  

• Notes Added On: Date and time the document note was applied.  

• Accessibility:  Indicates whether the document note is public or private.  

• Document Note: Document note applied to the document.  
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NOTE: If no document notes were applied in the review, a message will appear to let you know 

when you click the Generate button.  

10.5.8.4  Tag/Tag Comment Detail Report  

To generate a Tag/Tag Comment Detail report, go to Report  > Admin Reports  > Review  > Tag/Tag 

Comment Detail Report.  

Select the Review Set, Reviewer(s) and Tag(s) you wish to generate the report for.  If no batches are 

checked out or reviewed in the project, you will see No data to display in the drop-down menu.  

  
After you select the Review Set, information for the subsequent fields will be populated.  This will 

only happen if there are batches checked out and documents have been reviewed.  Use the drop-down menu 

to choose a different option.  Click Generate to create the report.  

NOTE: By default, all the tags that have a document associated will be selected.  Use the drop-down 

menu to check/uncheck the tagged documents you want to report as Privileged.  

NOTE: If no document tags were applied in the review, a message will appear to let you 

know when you click the Generate button.  
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10.5.8.5  Review QC Report  

To generate a Review QC Report, navigate to Report > Admin Reports > Review > Review QC report 

Select the Sampling Name to load. Review Set will be listed for selected Sampling.  

Select QC Failed Tag.  

NOTE:  You will not be able to select a Sampling Name If there is not a sampling with a QC 

Fail Tag available in the project.  

  

10.5.9  No-Text Reports  

The No-Text reports give you information about the documents without text in your project.   

10.5.9.1  No-Text Summary Report  

To generate a No-Text Summary Report report go to Report > Admin Reports > No-Text Report > 

NoText Summary.  

You can select between File Type Group and File Extension Group to view the report.  

10.5.9.1.1 Project Level  

Report is generated on the Project Level  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the No-Text File Summary report, the following details will be included:  

• File Type/File Extension (Depending on the selection the user makes)  

• Project Level Original Count  

• Project Level Original FileSize  

• Project Level Duplicate Count  

• Project Level Duplicate FileSize  

• Custodian Level Original Count  

• Custodian Level Original FileSize  
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• Custodian Level Duplicate Count  

• Custodian Level Duplicate FileSize  

• Total File Count  

• Total File Size  

  
10.5.9.1.2 Custodian Level  

Report is generated on a Custodian Level.  You will need to choose the Custodians you wish to 

view in your report.  Check the desired Custodians and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the No-Text File Summary report, the following details will be included for each Custodian 

selected:  

• File Type/File Extension (Depending on the selection the user makes)  

• Project Level Original Count  

• Project Level Original FileSize  

• Project Level Duplicate Count  

• Project Level Duplicate FileSize  

• Custodian Level Original Count  

• Custodian Level Original FileSize  

• Custodian Level Duplicate Count  

• Custodian Level Duplicate FileSize  

• Total File Count  
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• Total File Size  

  

10.5.9.1.3 Media Level  

Report is generated on a Media Level.  You will need to choose the Media you wish to view 

in your report.  Check the desired Media and click Generate.  

The report header will include the Project Name, Report Generated Date, Report Created 

By, Custodian and Media Selected.  
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10.5.9.1.4 Project Level Detail Report  

To generate a No-Text Report, go to Report > Admin Reports > No-Text Report > Project 

Level.  

The report header will include the Project Name, Report Generated Date and Report 

Created By.  

In the No-Text File Detail report, the following details will be included:  

• File ID  

• File Name  

• File Extension  

• File Path  

• File Size  
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10.5.9.2  Custodian Level Detail Report  

To generate a No-Text Report, go to Report > Admin Reports > No-Text Report > Custodian 

Level.  

The report header will include the Project Name, Report Generated Date, Report Created By 

and Custodian Selected.  

In the No-Text File Detail report, the following details will be included:  

• File ID  

• File Name  

• File Extension  

• File Path  

• File Size  
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10.5.9.3  Media Level Detail Report  

To generate a No-Text Report, go to Report  > Admin Reports  > No-Text Report  > Media 

Level.  

The report header will include the Project Name, Report Generated Date, Report Created 

By, Custodian and Media Selected.  

In the No-Text File Detail report, the following details will be included:  

• File ID  

• File Name  

• File Extension  

• File Path  

• File Size  
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10.5.10  Audit Log Report 

The available Audit Log reports are;  

• Deleted Documents Report  

• Tag Audit Report  

• Tiff Processing Report  

• User Activity Report 

 

  
10.5.11  Privilege Logs  

10.5.11.1 Privilege Log Report  

To generate a Privilege Report, go to Report > Admin Reports > Privilege Logs > Privilege Report and 

select the options for your report.  
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The privilege report can be generated from three sources.  

• Whole Project  

• Selected Review Set • Selected Export  

First, select a Source. Then, choose the source Tag(s) and Tag(s) to Display from the drop-down lists. 

Click Generate to generate the report.  

  

10.5.11.2 Redaction Report  

To generate a Redaction Report, go to Report > Admin Reports > Privilege Logs > Redaction 

Report and select the options for your report.  

Select a Review Set. After you select the Review Set, information for the subsequent fields will 

be populated. This will only happen if there are batches checked out and documents have been reviewed. 

Use the drop-down menus to select the Reviewer(s) and Batch(es). Click Generate to create the report.  

  
The report header will include the Project Name, Report Generated Date and Report 

Created By.  
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NOTE: If no redactions were applied in the review, the message No documents to report will appear 

when you click the Generate button.  

10.5.12  Inclusive Email Report  

To generate a Redaction Report, go to Report > Admin Reports > Inclusive Email Report.  

Select the media on which you want to report.  

The report header will include the Project Name, Selected Media Name, Report Generated Date and 

Report Created By.  

In the Inclusive Email report, the following details will be included:  

• File ID: Assigned File ID of the document which is inclusive email.  

• File Name: File name of the inclusive email.  

• Inclusive Reason: Reason email was recognized as an inclusive email.  
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10.6 Project Storage Report 

In the Project Storage report, the following details will be included:  

 

Generated RSMF files are also included in Project Storage Report.  
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11 Reprocessing  
 

11.1 Reprocess in Same Media  

To select exception types, follow the steps given below:    

1. Login to VOD.  

2. For the case, click on Reprocess Icon.   

The Media selection dialog will be displayed. For legacy projects you can select only 

one media at a time, but for fallback projects you can select multiple media.  

  

3. Select the files by checking the respective checkbox. The available options are Crashed files, 

Corrupted files, Non-processed, Password Protected, Item Missing, Timed out files, and Partial 

Meta Extracted files. The list of respective exception files will be listed.  

 
You can either reprocess single file or select multiple files using the checkbox 

provided.  

The Bulk Settings option allows you to update various fields like Fulltext, Hashvalue, child, password 

bank, repair PST, and Set Timeout. On checking repair PST and reprocessing, system will repair it and 

create a log file. For repair PST, Outlook must be installed in your system. 
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You can find the status of the Repair PST job in Admin Settings → System Admin → Job → Status. On 

clicking the detail file level progress, the status of the Repair PST job is displayed. 

 

4. Click on Reprocess. This will start queuing files for reprocessing.  

If there are documents required to be pre-fetched before reprocessing, it will 

prefetch the documents.   

After prefetching, reprocessing replacement job will be queued.  

Files may be still corrupted after reprocessing. File ID will be preserved for files that 

will be identified as non-processed and corrupted.  

11.2 Reprocess in New Media  

To reprocess exception files in new media, follow the below steps:  

1. For the case, click on Reprocess icon.   

2. Select Media.  
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3. Click on Reprocess in New media checkbox  

4. Enter the New Media Name. By default, new media name will be populated as:  

<OriginalMediaName>_Reprocess_dd-mm-yyyy.   

New media will be created in the same custodian as in the original media for which 

exception files will be reprocessed.  

Note: Password Protected items will not be checked by default. All other file types will be checked.  

 

5. Select the files to reprocess by selecting the corresponding checkbox.  

6. The Bulk Settings option allows you to update various fields like Fulltext, Hashvalue, child, 

password bank, repair PST, and Set Timeout. On checking repair PST and reprocessing, system will 

repair it and create a log file. 
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5. Click on Reprocess button.  

NOTE: change_setting Option is not available when files are reprocessed in new media  

11.3 Reprocessing Password Protected Document   

1. Go to your Case, and click Reprocessing button.   

2. Click Password Bank option to add and import passwords.  
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3. Click the Password Protected checkbox. All the related documents are displayed on the right side.     

4. If you want to do a bulk check, select the Bulk Settings option and update the fields by clicking on 

the Bulk Settings tab. You can apply filters to various columns like Media Name, File Name, Original 

File Type, File Type.  

5. If you want to change Password and file, select the change_setting option, it displays the Reprocess 

Settings popup.  
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You can replace the file and select the password.   

6. Click on the Reprocess button to initiate the reprocess job. Once the job has been completed, 

documents will not be shown on the right side of the table indicating that the Reprocess is 

completed successfully.   

Add Password 

To add a password to the Password Bank, follow the steps below:  

1. Click on Password Bank. 
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You may add numerous passwords to the Password Bank at one time by using the Import option and 

a load file containing passwords. You can also add password in the New Password textbox and click 

ADD button. 

 

You can also delete the password. If there are multiple password lists, you can select multiple values 

as well and click on Delete button. 
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Files containing passwords must be:  

• Either.txt or.csv format  

• Less than 5 MB size  

• Less than 50,000 lines  

Import Password 

To add passwords to the Password Bank using a load file, follow the steps below:  

Click the Import Password List link.  

Click the Browse button  

Select the load file with the list of passwords and click the Open button.  

NOTE: The load file must be in.txt or.csv extension format with each password on a separate 

line/row.  

The list of passwords from the load file will be displayed after uploading the file. 

  

If there is an error in the file, the error message is displayed and on trying to import, the error files 

are not imported. The tick is unmarked for the error files. 
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The  icon displays the format supported. 

 

 Lotus Note User Id, Password  

The password to a Lotus Notes NSF file can be provided in two ways, either via the.id file or manually 

entered. The available options are:  
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• NSF User ID file has associated password  

• NSF User File does not have associated password  

Click the Lotus Notes User Id, Password tab.  

  
Click the Browse button.  

Navigate to the NSF Userid File and click the Open button. Select the 

radio button for either:  

• NSF User Id File does not have associated Password  

• NSF User Id File has associated Password  

If the file does not have associated Password option is selected, enter the password in the Password 

field.  

Click the Add button.  

You can also delete the password. If there are multiple password lists, you can select multiple values 

as well and click on Delete button. 

 

 Import Lotus Notes User Id and Password List  

You may add numerous Lotus Notes User Ids and passwords at one time by using the Import option 

and a load file containing the User Ids and passwords.  
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Files containing Lotus Notes Ids and passwords must be:  

• Either.txt or.csv format  

• Less than 5 MB size  

• Less than 50,000 lines  

Click the Lotus Notes User Id, Password tab.  

Click the Import User Id File, Password List link.    

Click the Browse button.  

Select the file containing the NSF User id and Password information and click the Open button.  

The Password Bank is updated with the new User Ids and passwords from the load file, and they are displayed in 

the Password List.  

 

If there is an error in the file, the error message is displayed and on trying to import, the error files 

are not imported. The tick is unmarked for the error files. 

 

NOTE: You may click the Help button for the format load file format information.  
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12.17.6.1 Export User Id file, Password  

User Id files and associated passwords contained in the Password Bank can be exported using the 

Export button on the Lotus Notes User Id, Password tab in the Password Bank.  

Simply navigate to the Lotus Notes User Id, Password tab in the Password Bank and click the Export 

link. The files are exported in either.csv or Excel format. You will be notified after the export is 

completed.  

12.17.6.2 Delete Passwords  

To delete a password from the Password Bank, follow the steps given below.  

 Click the drop-down arrow  next to your name in the top right corner.   Click 

Admin Settings > Case Admin >Password Bank.  

The Password Bank displays the Password dialog.  

Click the Lotus Notes User Id, Password tab.  

Click the Delete button beside the password to delete an individual password OR  

Place a check next to each password to be deleted and then click the Delete button that displays at 

the top of the list.  
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A confirmation of the deletion appears.  

Click the Yes button.  

  
The password(s) is deleted.  

 

11.4 Tags Handling   

Tags Handling is applicable for Fall back project.  

  
To handle tags, follow the below steps:  

1. Click on Reprocessing button in case launch pad screen. It navigates to Reprocessing screen.   

2. Select Search Tags radio button. It displays all the System tags & User tags.  

3. Click any tag and tagged documents will be displayed on the right side of the table.  
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7. If you want to do a bulk check, select the bulk_settings option and update the fields by clicking on the 

bulk_settings tab.   

8. If you want to change Password and file, select the change_setting option, it displays the Reprocess 

Settings popup.  

You can replace the file and select the password in this popup screen.   

9. Click on the Reprocess button to initiate the reprocess job. Once the job has been completed, 

documents will not be shown on the right side of the table indicating that the Reprocess is completed 

successfully.  

11.5 File Replacement   

To replace files, follow the below steps:  

1. Select All files option check box to display all the documents.  

  

2. Use only.csv &.txt formats for replacement by using the Use Load File option.  
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3. Use the Help icon to replace a load file format.  

  

4. After the Validate & Save respective file id will be selected.   

5. Click on the Reprocess button to initiate the reprocess job. Once the job has been completed, 

documents will not be shown on the right side of the table indicating that the Reprocess is 

completed successfully.  

Note: For Legacy project bulk settings option is not applicable.  
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11.6 Save Load File  

  
Select some of the documents and click on Save as load file in that user can change the  

Originalfilepath to Replacefilelocation & provide the location of the file user want to replace with 

and use it as a load file for replacement.  

11.7 Reprocessing Through E-mail  

For External users, the reprocessing is done through emails. A link is sent to the external user 

through which they can upload the documents for a particular case with an option called Invite to Upload.  

Note: Invite external users to upload is not available for limited service license.  

To send the invite to upload:  

1. Go to the Case launchpad and click on the down arrow on the upload button for the cases for 

which documents must be uploaded.  

2. Click on the Invite to Upload button to invite the user(s) to upload files for the case.  

    

    



© Venio Systems, Inc.   11.7.0.0  Page | 455  

 

Only the internal users who are associated with the Group and the same Case are displayed in the 

list.  

To add external users, you can select Invite external users to upload checkbox enter email 

ID.  

3. Select the user(s) to upload files for the case. You can also enter any special instructions. Select 

the number of days after which the link will expire in the field provided. Enter external users if 

any and click Send Invitation.  

  
6. An e-mail “VenioOne OnDemand upload invitation” is sent to the users with the link to upload 

the files.  
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7. Click on the button to upload the data. The user receives a login code to login to VenioOne 

OnDemand.   

8. If during the process of uploading, the data could not be uploaded for some reason, an email is 

sent to the user informing that the processing failed for the case ticket.  

9. If the upload is successful, an email is sent to the user.  

    


